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Introduction

This manual describes the procedure for setting up ProSafe-RS.

When you integrate ProSafe-RS with FAST/TOOLS, replace "Vnet/IP" in the descriptions in
this manual with "Vnet/IP-Upstream."

This manual consists of the following parts:

* Part A: Overview
This part provides an overview of ProSafe-RS setup.

* Part B: New Setup
This part describes the procedure for a new setup of ProSafe-RS.

» Part C: Maintenance
This part describes the tasks to be done while a ProSafe-RS system is used.

+ Part D: Connection with Other Products
This part describes how to connect ProSafe-RS to other YOKOGAWA products and pro-
vides cautionary notes.

*  Appendix
This section describes hardware settings, compatibility of ProSafe-RS software revisions,
and cautionary notes.

Media No. IM 32Q01C50-31E (CD) 4th Edition : Jan. 2015 (YK) IM 32Q01C50-31E 4th Edition : Jan.30,2015-00
All Rights Reserved Copyright © 2011 , Yokogawa Electric Corporation



Safety Precautions for Use

B Safety, Protection, and Modification of the Product

To protect the system controlled by the Product and the Product itself and to ensure safe
operation, please observe the safety precautions described in this Manual. Yokogawa
Electric Corporation ("YOKOGAWA") assumes no liability for safety if users fail to observe
the safety precautions and instructions when operating the Product.

If the Product is used in a manner not specified in the User's Manuals, the protection pro-
vided by the Product may be impaired.

If any protection or safety circuit is required for the system controlled by the Product or for
the Product itself, please install it externally.

Use only spare parts that are approved by YOKOGAWA when replacing parts or consum-
ables of the Product.

Do not use the Product and its accessories such as power cords on devices that are not
approved by YOKOGAWA. Do not use the Product and its accessories for any purpose
other than those intended by YOKOGAWA.

Modification of the Product is strictly prohibited.
The following symbols are used in the Product and User's Manuals to indicate the accom-
panying safety precautions:

A Indicates that caution is required for operation. This symbol is labeled on the Prod-

uct to refer the user to the User's Manuals for necessary actions or behaviors in
order to protect the operator and the equipment against dangers such as electric
shock. In the User's Manuals, you will find the precautions necessary to prevent
physical injury or death, which may be caused by accidents, such as electric
shock resulting from operational mistakes.

@ Identifies a protective conductor terminal. Before using the Product, you must
ground the protective conductor terminal to avoid electric shock.

L Identifies a functional grounding terminal. A terminal marked "FG" also has the
same function. This terminal is used for grounding other than protective grounding.
Before using the Product, you must ground this terminal.

~ Indicates an AC supply.
== Indicates a DC supply.
| Indicates the ON position of a power on/off switch.

QO Indicates the OFF position of a power on/off switch.

B Notes on Handling User's Manuals

Hand over the User's Manuals to your end users so that they can keep the User's Man-
uals on hand for convenient reference.

Thoroughly read and understand the information in the User's Manuals before using the
Product.

For the avoidance of doubt, the purpose of the User's Manuals is not to warrant that the
Product is suitable for any particular purpose but to describe the functional details of the
Product.

Contents of the User's Manuals are subject to change without notice.
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Every effort has been made to ensure the accuracy of contents in the User's Manuals.
However, should you have any questions or find any errors, contact us or your local dis-
tributor. The User's Manuals with unordered or missing pages will be replaced.

B Warning and Disclaimer

Except as specified in the warranty terms, YOKOGAWA shall not provide any warranty for
the Product.

YOKOGAWA shall not be liable for any indirect or consequential loss incurred by either
using or not being able to use the Product.

B Notes on Software

YOKOGAWA makes no warranties, either expressed or implied, with respect to the Soft-
ware Product's merchantability or suitability for any particular purpose, except as speci-
fied in the warranty terms.

Purchase the appropriate number of licenses of the Software Product according to the
number of computers to be used.

No copy of the Software Product may be made for any purpose other than backup; other-
wise, it is deemed as an infringement of YOKOGAWA's Intellectual Property rights.

Keep the software medium of the Software Product in a safe place.

No reverse engineering, reverse compiling, reverse assembling, or converting the Soft-
ware Product to human-readable format may be performed for the Software Product.

No part of the Software Product may be transferred, converted, or sublet for use by any
third-party, without prior written consent from YOKOGAWA.
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Documentation Conventions

B Symbols

The following symbols are used in the User's Manuals.

Identifies instructions that must be observed to avoid physical
A injury, electric shock, or death.
CAUTION

Identifies instructions that must be observed to prevent damage

A WARNING to the software or hardware, or system failures of the Product.

Identifies important information required to understand opera-

ﬂ IMPORTANT tions or functions.

TIP

SEE Identifies referenced content.

Identifies additional information.

ALSO In online manuals, you can view the referenced content by click-

ing the links that are in green text. However, this action does not
apply to the links that are in black text.

B Typographical Conventions

The following typographical conventions are used throughout the User's Manuals.

® Commonly Used Conventions throughout the User's Manuals

A Mark
Indicates that a space must be entered between character strings.
Example:

.ALAPICO010A-SC

Character string enclosed by braces { }
Indicates character strings that may be omitted.

Example:
.PRATAG{A.sheet name}

® Conventions Used to Show Key or Button Operations

Characters enclosed by brackets [ ]

When characters are enclosed by brackets in the description of a key or button operation,
it indicates a key on the keyboard, a button name in a window, or an item in a list box
displayed in a window.

Example:
To alter the function, press the [ESC] key.

® Conventions of a User-defined Folder

User-defined folder name enclosed by parenthesis ()
User definable path is written in a pair of parentheses.

Example:
(RS Project Folder)\SCS0101
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If the RS Project Folder is C: \MYRSPJT, the above path becomes C:
\MYRSPJTSCS0101.

B Drawing Conventions

Drawings used in the User's Manuals may be partially emphasized, simplified, or omitted for
the convenience of description.

Drawings of windows may be slightly different from the actual screenshots with different set-
tings or fonts. The difference does not hamper the understanding of basic functionalities and
operation and monitoring tasks.

B Integration with CENTUM

SEE
ALSO

The Product can be integrated with CENTUM VP or CENTUM CS 3000. In the User's Man-
uals, the integration with CENTUM VP or CENTUM CS 3000 is referred to as "Integration with
CENTUM."

In the User's Manuals, the explanations for integrating the Product with CENTUM VP or
CENTUM CS 3000, the glossary for various features of CENTUM VP is used instead of the
glossary for CENTUM CS 3000. For example, the term "CENTUM VP System Alarm View" is
used instead of "CENTUM CS 3000 System Alarm window." Nevertheless, if the features for
integrating the Product with CENTUM VP and CENTUM CS 3000 are different, both features
will be explained separately.

For more information about the functions and usage of CENTUM VP components for integrating the Product
with CENTUM VP, refer to:

User's Manuals (IM), Technical Information (Tl), and General Specifications (GS) of CENTUM VP

For more information about the features and usage of CENTUM CS 3000 components for integrating the
Product with CENTUM CS 3000, refer to:

User's Manuals (IM), Technical Information (T1), and General Specifications (GS) of CENTUM CS 3000

B Explanation of Hardware and Software Behaviors in the User's
Manuals

In the User's Manuals, system behaviors are explained assuming that the latest versions of
YOKOGAWA software and hardware at the time of publication of the User's Manuals are in-
stalled.

If additional precise information about the safety of legacy versions of software or hardware is
required, a link to the corresponding explanation is provided. Please refer to the information
according to your system.

B Station Types

A safety control station (hereafter referred to as SCS) is named according to the type of the
safety control unit used in it.

Table Info-1 Names of SCS and Safety Control Unit Used

Name of SCS Model of the safety control unit
SCSV1-S SSC10S/SSC10D
SCSP1-S SSC50S/SSC50D
SCSP2-S SSC60S/SSC60D
SCSU1-S SSC57S/SSC57D

In the User's Manuals, the following abbreviations may be used to describe functions of these
SCS as a whole.
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SCSV1: Abbreviation of SCSV1-S
SCSP1: Abbreviation of SCSP1-S
SCSP2: Abbreviation of SCSP2-S
SCSU1: Abbreviation of SCSU1-S
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Copyright and Trademark Notices

B All Rights Reserved

The copyright of the programs and online manuals contained in the software medium of the
Software Product shall remain with YOKOGAWA.

You are allowed to print the required pages of the online manuals for the purposes of using or
operating the Product; however, reprinting or reproducing the entire document is strictly pro-
hibited by the Copyright Law.

Except as stated above, no part of the online manuals may be reproduced, transferred, sold,
or distributed to a third party in any manner (either in electronic or written form including, with-
out limitation, in the forms of paper documents, electronic media, and transmission via the
network). Nor it may be registered or recorded in the media such as films without permission.

B Trademark Acknowledgments

CENTUM, ProSafe, Vnet/IP, and STARDOM are registered trademarks of YOKOGAWA.

Microsoft, Windows, Windows Vista, Windows Server, Visual Basic, Visual C++, and Vis-
ual Studio are either registered trademarks or trademarks of Microsoft Corporation in the
United States and other countries.

Adobe, Acrobat, and Adobe Reader are registered trademarks of Adobe Systems Incor-
porated.

Ethernet is a registered trademark of Xerox Corporation.
HART is a registered trademark of the HART Communication Foundation.
Modicon and Modbus are registered trademarks of Schneider Electric SA.

All other company and product names mentioned in the User's Manuals are trademarks
or registered trademarks of their respective companies.

TM or ® mark are not used to indicate trademarks or registered trademarks in the User's
Manuals.

Logos and logo marks are not used in the User's Manuals.
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A. Overview

This section explains how to read this document, types of ProSafe-RS setup tasks and their
workflows, and system requirements.
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A1.

SEE
ALSO

How to Read This Document

This document explains the setup procedures for the ProSafe-RS software. This document
does not touch upon installation procedures of Windows OS, related service packs, and Mi-
crosoft security patches.

To use the software packages installed on an SENG, licenses must be distributed to and acti-
vated on the SENG using a program called License Manager. Procedures for the tasks per-
formed using License Manager is described in the License Management IM. You are guided
to refer to the License Management IM as necessary in the explanation of setup procedures.

You are also guided to refer to the Security Guide IM for information about functions that rein-
force security of the system.

For more information about the procedure for installing the Windows operating systems, related service packs
and the Microsoft security patches, refer to:

the information provided by Microsoft

For more information about Microsoft security patches, refer to:
Microsoft Security Update Policy (Tl 33Y01B30-02E)

For more information about the procedure for distributing and activating the licenses on the stations, refer to:
1., “Overview of license management” in License Management (IM 32Q01C60-31E)

For more information about system security, refer to:

1., “Overview” in ProSafe-RS Security Guide (IM 32Q01C70-31E)

B Structure of This Document

This document consists of the following parts:
« Part A: Overview

This part describes how to read this document, various types of ProSafe-RS setup tasks
along with their workflows, and hardware and software requirements.

* Part B: New Setup
This part explains the procedures for setting up each station.
» Part C: Maintenance

This part describes maintenance tasks that are required after the stations have been set
up and went into operation.

e Part D: Connection with Other Products

This part describes the required settings when connecting ProSafe-RS with other YOKO-
GAWA products, such as CENTUM VP, PRM, and Exaquantum.

B Regarding Explanation of Setup Procedures

The procedure for setting up Windows and device drivers vary with the Windows operating
systems. For the procedure that are common to all the operating systems that are supported,
the explanation will mainly use the user interfaces of Windows 7. However, for the procedures
typical for each operating system, the explanation will use the user interfaces of each system
and describe the procedure separately.
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A2. Overview of Setup Tasks

This section describes the workflows of setup tasks and provides the information you should
understand before you set up individual stations.
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A2.1 Before You Set Up

This section describes the relationship between installation of ProSafe-RS software and li-
censing for it.

B Installation and Licensing of Software Packages

TIP

SEE

ALSO

In order to use ProSafe-RS software packages, it is necessary to install the ProSafe-RS soft-
ware on a computer and then grant licenses to the computer to enable the use of the software
packages.

The tasks of installing the software packages on each computer are performed using a pro-
gram called an installer. The tasks of giving licenses are executed using software called Li-
cense Manager. License Manager is automatically installed when the ProSafe-RS software is
installed on a computer.

Among computers installed with License Manager, the computer that is given the role of man-
aging licenses of each computer in the system is called the license management station. The
license management station distributes licenses to each computer on which the software
packages are installed. On a computer to which licenses have been distributed, the software
packages can be made available for use by accepting the distributed licenses.

It is possible to install only License Manager on a computer and use it as the computer dedicated to license
management.

ProSafe-RS
Software Medium

©)

License Medium

Install

Distribute licenses
: —

| T =
S
License Management Station SENG

=

Figure A2.1-1 License Distribution

For more information about the details of licenses, refer to:

1., “Overview of license management” in License Management (IM 32Q01C60-31E)
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A2.2 Procedures for New Setup

This section describes the overall procedures for setting up a ProSafe-RS system and for set-
ting up each type of station or computer using flowcharts.

The procedures for the following types of stations and computers are described.
+ Safety engineering PC (SENG)
* File server

Computer dedicated to license management
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A2.21 Setup Procedure for a ProSafe-RS System

The following figure shows the overall procedure for setting up a ProSafe-RS system.

Prepare for setup

Build the system in a domain._ Yes
environment? (*1)

]
Set up Windows domain environment

No [

Set up SENG

Set up stations (*2) I Set up a file server

Set up the computer dedicated
to license management

Set up hardware
(SCS and devices for connection
between domains)

Yes

The system is built in
a domain environment?

|
Synchronize the time of stations

No [

End

*1:  You may set up the domain environment at a later stage.
*2:  Start by setting up the station that is to be used as the license management station.

Figure A2.2.1-1 Setup Procedure for a ProSafe-RS System

You can jump to the explanation of each task that appears in the flowchart from the reference
link that is provided in the following subsections.

B Prepare for Setup
Determine the required items for setting up a ProSafe-RS system.

EE . . . . .
§LSO For more information about the items that must be determined before setting up a ProSafe-RS system, refer

B1., “Preparing for the Setup” on page B1-1

B Set Up the Windows Domain Environment

When using ProSafe-RS in a Windows domain environment, set up the Windows domain en-
vironment. You may also set up the Windows domain environment at a later stage.

EE . . . , . .
§LSO For more information about setting up a Windows domain environment, refer to:

B2., “Setting Up the Windows Domain Environment” on page B2-1
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B Set Up Each Station

Set up SENG, file server, and other stations to be used in the ProSafe-RS system.
SEE

ALso For more information about the procedure for setting up an SENG, refer to:

A2.2.2, “Setup Procedure for SENG” on page A2-6
For more information about the procedure for setting up a file server, refer to:
A2.2.3, “Setup Procedure for a File Server” on page A2-9

For more information about the procedure for setting up a computer dedicated to license management, refer
to:

A2.2.4, “Setup Procedure for a Computer Dedicated to License Management” on page A2-10

® The Station You Must Set Up First

In a ProSafe-RS system, you must first set up the license management station, which is used
to grant licenses for software packages.

Software packages installed on other stations become available for use once the stations ac-
cept the licenses distributed from the license management station.

B Set Up the Hardware of SCS and Devices Used for Connection
between Domains

Set up the hardware of SCS and devices used for connection between domains.
SEE

ALso For more information about setting up the hardware of SCS and devices for connection between domains,
refer to:

B7., “Configuring the Hardware of SCS and Devices for Connection between Domains” on page B7-1

B Set Up Time Synchronization in Windows Domain Environment

When using ProSafe-RS in a Windows domain environment, synchronize the time on the do-
main controller with the time on computers used in the ProSafe-RS system.

SEE
ALso For more information about setting up time synchronization in a Windows domain environment, refer to:

B2.7, “Setting Up Time Synchronization in Windows Domain Environment” on page B2-19
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A2.2.2 Setup Procedure for SENG

The following figure shows the setup procedure for SENG.

Set up the hardware

Set up Windows

Set up the network

Install ProSafe-RS software

Install other YOKOGAWA ~_ Yes
products?
Install software of other

No YOKOGAWA products (*1)
I

Configure IT security settings

Distribute and accept licenses

Create user accounts

Set up Windows environment
for each user

Set up the UPS

Configure function-specific
settings

Set up for connection with
other systems

End

*1:  You may install other products later. If you install later, you need to configure IT security settings again.

Figure A2.2.2-1 Setup Procedure for SENG

You can jump to the explanation of each task that appears in the flowchart from the reference
link that is provided in the following subsections.

B Set Up the Hardware
Set up the hardware for the SENG.
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SEE

ALso For more information about setting up the hardware of SENG, refer to:

B3.1, “Setting Up the Hardware” on page B3-2

B Set Up Windows

Configure Windows settings on the computer.

EE . . . ,
ALso For more information about setting up Windows, refer to:

B3.2, “Setting Up Windows” on page B3-7

B Set Up the Network

Configure the network settings.

EE . . - ,
ALso For more information about configuring network settings, refer to:

B3.3, “Configuring Network Settings” on page B3-32

B Install the ProSafe-RS Software

Install the ProSafe-RS software.
SEE

ALso For more information about installing the ProSafe-RS software, refer to:

B3.4, “Installing the ProSafe-RS Software” on page B3-54

B Configure IT Security Settings

Configure IT security settings.
SEE

ALso For more information about configuring IT security settings, refer to:

B3.5, “Configuring IT Security Settings” on page B3-58

B Distribute and Accept Licenses

Distribute licenses to the SENG from the license management station, and accept the licen-
ses on the SENG.

SEE

ALso For more information about distributing and accepting licenses, refer to:

B3.6, “Distributing and Accepting Licenses” on page B3-67

B Create User Accounts

Create user accounts.
SEE

ALso For more information about creating user accounts, refer to:

B3.7, “Creating User Accounts” on page B3-68

B Configure Windows Environment Settings for Each User

Configure Windows environment settings for each user.
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SEE

ALso For more information about configuring Windows environment settings for each user, refer to:

B3.8, “Configuring Windows Environment Settings for Each User” on page B3-72

B Set Up the Uninterruptible Power Source (UPS) Service

If necessary, set up the uninterruptible power source (UPS) service.

A,_ES(E) For more information about configuring the UPS service, refer to:

B3.9, “Configuring the Uninterruptible Power Supply (UPS) Service” on page B3-83

B Configure Function-Specific Settings

Configure the settings specific to certain functions of the SENG.

A,_ESE For more information about configuring the settings specific to each function of SENG, refer to:

B4., “Configuring Function-Specific Settings on SENG” on page B4-1

B Set Up for Connection with Other Systems

As necessary, set up for connection with other YOKOGAWA products.
SEE

ALso For more information about the settings required to connect with other YOKOGAWA products, refer to:
D1., “Connecting YOKOGAWA products” on page D1-1
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A2.2.3 Setup Procedure for a File Server

You can provide a file server in the system if centralized management is required for project
databases. The following figure shows the setup procedure for a file server.

TIP

This flowchart illustrates the procedure for setting up a computer that serves only as a file server.

Prepare to configure IT security
settings on the file server

Create and set up shared folders

Save the IT security settings
on the file server

Configure the IT security settings
on the file server

Create accounts on the file server
for users who access project data

Create the project folder
on the file server

End

Figure A2.2.3-1 Setup Procedure for a File Server

SEE

ALso For more information about setting up a computer that serves only as a file server, refer to:
B5.1, “Setting Up a Computer that Serves Only as a File Server” on page B5-2

For more information about the procedure to set up a computer as both a file server and a license manage-
ment station, refer to:

B5.3, “Setting Up the Computer that Serves as Both File Server and License Management Station” on
page B5-9

For more information about setting up the file server function on SENG, refer to:

B5.2, “Setting Up the File Server Function on SENG” on page B5-8
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A2.2.4 Setup Procedure for a Computer Dedicated to
License Management

You can provide a computer dedicated to license management according to the scale and op-
eration policy of the system. The following figure shows the setup procedure for a computer
dedicated to license management.

Install the license
management software

Configure IT security settings

End

Figure A2.2.4-1 Setup Procedure for a Computer Dedicated to License Management

SEE

ALso For more information about setting up a computer dedicated to license management, refer to:

B6., “Setting Up the Computer Dedicated to License Management” on page B6-1
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A2.3 Explanation for Maintenance

When you perform the following maintenance tasks, refer to Part C.
* Add licenses and change license assignments

+  Set up the domain environment later

* Back up the system

* Upgrade the ProSafe-RS software

» Find out cautionary notes for upgrading and compatibility with the previous revision
* Uninstall the ProSafe-RS software

* Reinstall the ProSafe-RS software

+ Change, save, and restore the IT security settings

*  Troubleshooting
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A3. Requirements for Operation

This section explains the hardware and software requirements. It also explains the software
that can collaborate with ProSafe-RS and software that can co-exist on the same computer.
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A3.1

Hardware Requirements

This section describes the hardware requirements for SENG and the file server that are used
in a ProSafe-RS system.

B Hardware Requirements for SENG

You must ensure that the computer that is used as SENG meets the hardware requirements
as shown in the following table.

If CENTUM software is also installed on the same computer, the computer must also meet the
requirements for CENTUM.

Table A3.1-1 Hardware Requirements for SENG

Component oS
. . . Windows Server Windows Server
Windows 7 Windows Vista 2008 R2 2008
CPU * Intel Core 2 Duo Processor 2.13 GHz | Intel Xeon Dual- * Intel Core 2 Duo
or higher Core 2.93 GHz or Processor 2.13
¢ Intel Xeon Dual-Core 2.0 GHz or high- | higher GHz or higher
er * Intel Xeon Dual-

Core 2.0 GHz or
higher

Main memory

4 GB or more

2 GB or more 4 GB or more 2 GB or more

Hard disk space

20 GB or more free space (mandatory)

40 GB or more free space (recommended)

However, if you store an operation history database, 100 GB or more is recommen-
ded

Display » SXGA (1280 x 1024) or higher resolution, True color (mandatory)
* WXGA+ (1440x900) or higher resolution for wide monitoring
Graphics DirectX 9 graphic processing unit or equivalent, and supports N/A

the following:

Windows Driver Display Model (WDDM)
Pixel Shader 2.0

32 bits per pixel

128 MB graphic memory

Peripheral unit

DVD-ROM drive

A PCI slot or PCI Express slot for the control bus interface card or Vnet/IP interface
card

A DAT drive or hard disk unit for backing up engineering data, which encompasses
project databases and various databases used during operation

B Hardware Requirements for a File Server

The hardware requirements for the computer used as a file server are as follows:

Table A3.1-2 Hardware Requirements for a File Server

Component

Windows Server 2008 R2/Windows Server 2008

CPU

2 GHz or higher

Main memory

2 GB or more

Hard disk space

» 20 GB or more free space (mandatory)

* 50 GB or more free space (recommended)
However, if you store an operation history database, 100 GB or
more is recommended

Display

SuperVGA (800 x 600) or higher (mandatory)

Peripheral unit

* DVD-ROM drive (mandatory)
» Network adapter (mandatory)
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A3.2 Software Requirements

This section describes the software requirements for SENG. It also explains the software that
can collaborate with ProSafe-RS and software that can co-exist on the same computer.

B Software Requirements for SENG

This section describes the software requirements for SENG.

® Supported OS

The following table shows the correspondence between Windows OS versions/service packs
and ProSafe-RS release numbers.

Table A3.2-1 Correspondence between ProSafe-RS Software Release Numbers and Windows OS Ver-

sions
ProSafe-RS | Windows 7 [Windows Vis-| Windows Windows Windows Windows
release num- | Professional | ta Business | Server 2008 | Server 2008 | Server 2003 | Server 2003
ber Edition R2 Standard |Standard Edi-| R2 Standard |Standard Edi-
Edition R2 tion Edition tion
64 bits 32 bits 64 bits 32 bits 32 bits 32 bits
SP1 SP2 SP1 SP2 SP2 SP2
R3.01/ Yes Yes Yes Yes No (*1) No (*1)
R3.02.00/
R3.02.10
R3.02.20 Yes Yes Yes Yes No No

*1:

Only allowed for use as a file server.

Before installing ProSafe-RS, make sure that a Windows OS version and service pack appro-
priate for the ProSafe-RS software release number are installed on the computer.

ﬂ IMPORTANT

On a Windows pre-installed computer, various Windows utilities and other software may
have been installed in addition to the Windows OS. These additional functions are not on-
ly unnecessary for SENG but also can disturb its operations. To avoid disturbance to op-
erations, reinstall the Windows OS.

This document describes the procedure for setting up a computer from the initial state
where the OS has been installed. Do not change the OS settings or add any functions
other than the OS, unless so described in the document.

It is assumed that security patches are applied according to the customer's security poli-
cy. YOKOGAWA recommends to apply security patches to ProSafe-RS systems. It is rec-
ommended to apply all required security patches before the system goes into operation
and also apply security patches that are released after the system went into operation as
promptly as possible. YOKOGAWA offers security patch application services. Contact
YOKOGAWA Service for more information.

® About .NET Framework and MDAC

.NET Framework (Version 3.5 SP1)
ProSafe-RS supports version 3.5 SP1.

When the ProSafe-RS software is installed, .NET Framework is automatically installed.
However, .NET Framework (Version 3.5 SP1) included in the ProSafe-RS software medi-
um will not be installed automatically if a newer version has already been installed in the
computer, to avoid downgrading of .NET Framework.
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MDAC/Windows DAC
ProSafe-RS supports MDAC version 2.8 SP1 or later and Windows DAC 6.0 or later.

It is not installed when the ProSafe-RS software is installed because Windows DAC 6.0
or later version with advanced MDAC is provided in Windows Vista and later OS.

MSXML
ProSafe-RS supports version 4.0 SP3.

MSXML is automatically installed during installation of the ProSafe-RS software.

However, MSXML (Version 4.0 SP3) included in the ProSafe-RS software medium will not
be installed automatically if a newer version has already been installed in the computer,
to avoid downgrading of MSXML.

® Software that can Coexist with ProSafe-RS

The ProSafe-RS software can coexist with the following software programs.

The following table lists the software that has been confirmed to function without problems to-
gether with ProSafe-RS.

Table A3.2-2 List of Software that can Coexist with ProSafe-RS

Classification

Software name

Version (*1) (*2) (*3)

Remarks

Spread sheet (*4)

Microsoft Excel

2013 SP1, 2010 SP2,
2007 SP3

Word processor (*4)

Microsoft Word

2013 SP1, 2010 SP2,
2007 SP3

Software development Microsoft Visual C++ 2008 SP1
Microsoft Visual Basic 2008 SP1
WWW browser Microsoft Internet Explor- | 9.0, 8.0
er
UPS software APC PowerChute Busi- [9.0.1
ness Edition
Security Anti-virus Software for - Model: AV11000
Endpoint Security Serv-
ice (*5)
Document viewer Adobe Acrobat 11.0, 10.1, 9.5 (*6) Used for the Instruction

Manual Package

Adobe Reader 11.0, 10.1, 9.5 (*6)

*1:
*2:
*3:
*4;
*5:

*6:

Please confirm the required operation environment of each software for OS on which each software operates.

SP is an abbreviation of Service Pack.

The software version has been confirmed at the time of the release of this document. For more information about the latest
supported version, contact YOKOGAWA.

If CENTUM software is installed on the same computer, make sure that installed software also meets the software require-
ments for CENTUM.

Dedicated for YOKOGAWA's control systems. Includes misdetection prevention of YOKOGAWA software products and cus-
tomized support in conjunction with McAfee Inc.

Version 11.0 does not support Windows Vista Business Edition SP2.

B CENTUM Integration System

When ProSafe-RS is integrated with CENTUM, available ProSafe-RS functions are limited de-
pending on the software release number of CENTUM. This section explains such limitations
and precautions to be taken when installing the ProSafe-RS and CENTUM software on the
same computer.
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SEE

ALso For more information about precautions on each revision of ProSafe-RS, refer to:
ProSafe-RS Release Information (IM 32Q01A50-31E)
For more information about precautions on each revision of CENTUM, refer to:

«  CENTUM VP Release Information (IM 33K01A50-50E) and CENTUM VP Installation (IM
33K01C10-50E)

«  CENTUM VP Electronic Document Addendum (IM 33M01A50-40E) and CENTUM VP Installation
(IM 33M01A20-40E)

« CS 3000 Electronic Document Addendum (IM 33Q01A50-01E) and CS 3000 Installation
(IM33Q01C10- 01E)

® Combination of Release Numbers that can be Integrated

The following table shows the release numbers of ProSafe-RS and CENTUM that can be inte-
grated into a single system.

Table A3.2-3 Release Numbers of ProSafe-RS and CENTUM that can be Integrated
ProSafe-RS CS 3000 (*1) CENTUM VP

R3.01 /R3.02.00 /R3.02.10 / R3.06 or later R4.01 or later
R3.02.20

*1:  You cannot install ProSafe-RS R3.01 or later and CS 3000 software on the same computer.

® Functions of ProSafe-RS and CENTUM Release Numbers

When using ProSafe-RS R3.02.20, CENTUM of release number R5.04.00 or later is recom-
mended.

The following table shows the CENTUM software release numbers that are required to use
new functions added in each release of ProSafe-RS.

Table A3.2-4 CENTUM VP Release Numbers Required to Use Each Function of ProSafe-RS

Function of ProSafe-RS Release number of CENTUM
Display of SMB icon and system alarm messages related to li- | R5.01 or later
cense management (when installed on the same computer as
HIS)
» Operation and monitoring of SCSP2 R4.02 or later

» Display of annunciator message corresponding to ANN_FUP
function blocks

» Display of system alarm messages added in ProSafe-RS
R2.03 (*1)

*1:  In CENTUM VP of earlier than R4.02, system alarm messages added in R2.03 are not displayed. The same messages dis-
played as when manually executing IOM download are displayed at execution of automatic IOM download.

Table A3.2-5 CS 3000 Release Numbers Required to Use Each Function of ProSafe-RS
Function of ProSafe-RS Release number of CS 3000

» Operation and monitoring of SCSP2 R3.09 or later

» Display of annunciator message corresponding to ANN_FUP
function blocks

» Display of system alarm messages added in ProSafe-RS
R2.03 (*1)

Continues on the next page
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Table A3.2-5 CS 3000 Release Numbers Required to Use Each Function of ProSafe-RS (Table contin-
ued)

Function of ProSafe-RS Release number of CS 3000

SCS simulation test R3.08.50 or later
Interface functions for plant training

SCS link transmission

Override function blocks with group function

Functional changes of password function blocks
Specification changes to ANLG_S function blocks in Pro-
Safe-RS R1.03 (process alarms etc.) R3.08.50 or later

* Manual operation function blocks (MOB_11, MOB_21, R3.08 or later
MOB_RS, MOA)

* Vnet/IP network connection of SCS

» Sub-system communication function (Modbus communica- R3.07 or later
tion)

« SYS_SEC_CTL (security level protection) function blocks

*1:  In CS 3000 of earlier than R3.09, system alarm messages added in R2.03 are not displayed. The same messages displayed
as when manually executing IOM download are displayed at execution of automatic IOM download.

SEE

ALso For more information about system alarm messages of R2.03 that cannot be displayed on CS 3000 earlier
than R3.09 and CENTUM VP of earlier than R4.02, refer to:

Appendix 1., “Differences in limitations and specifications among software release numbers of
CENTUM” in Integration with CENTUM VP/CS 3000 (IM 32Q01E10-31E)

® |T Security Setting
* Integration with CENTUM VP

* You can fortify computer security. To fortify the security, select "Standard model" with
the IT Security Tool at installation of both ProSafe-RS and CENTUM VP.

+ If you integrate ProSafe-RS with CENTUM VP earlier than R5.01, manually relax
some security items according to the IT security setting of CENTUM VP.

* Integration with CS 3000
You cannot fortify computer security. Select "Legacy model" with the IT Security Tool at
installation of ProSafe-RS.

® Co-existence with ProSafe-RS on a Computer

Observe the following precautions when installing the ProSafe-RS and CENTUM software on
the same computer.

* Unless specially instructed, install the control bus driver from the ProSafe-RS software
medium.
If one of the systems has been upgraded, follow the instruction provided for each revi-
sion.

* ProSafe-RS R3.01 or later and CS 3000 cannot be installed on the same computer.

*  On a computer installed with both the ProSafe-RS and CENTUM software, configure Win-
dows settings according to the instructions in the installation manual of CENTUM.

B FAST/TOOLS Integration System
® Coexistence of ProSafe-RS and FAST/TOOLS on the Same Computer

FAST/TOOLS and ProSafe-RS software cannot run on the same computer.
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® Version

When using ProSafe-RS R3.02.20, the recommended version of FAST/TOOLS is R10.01,
which is identical with R9.05 SP2. If the version is earlier than R10.01, ProSafe-RS functions
are restricted as follows:

* The new station type SSC57 is not supported.

*  The Narrowband mode of Vnet/IP-Upstream is not supported.

» The function to set gas flow rate calculation related parameters is not available.
* The function to read buffered data from SCS is not available.

* |OM models supported from ProSafe-RS R3.02.00 are not displayed.

In addition, the following restrictions apply if the revision of FAST/TOOLS is earlier than
R9.03.

*  The number of I/0 nodes in SCS displayed on FAST/TOOLS is up to 9.

*  The number of inter-SCS safety communication locks is not displayed in the SCS Status
Display window of FAST/TOOLS.

B Use of PRM

® Coexistence of ProSafe-RS and PRM on the Same Computer

Whether or not the PRM and ProSafe-RS software can run on the same computer is as fol-
lows:

A PRM server and ProSafe-RS software cannot run on the same computer.

A PRM client and ProSafe-RS software can run on the same computer. Note, however,
that a PRM client cannot run on the same computer if the computer has a license of SOE
OPC Interface Package of ProSafe-RS.

* If you install the PRM client on SENG that is connected to the narrowband Vnet/IP-Up-
stream network, you need additional Ethernet wiring for PRM client communications.

® Version

When using ProSafe-RS R3.02.10 or later, the recommended version of PRM is R3.12 or lat-
er. Because the earlier than R3.12 of versions of PRM cannot connect to the narrowband
mode.

Because PRM R3.01 does not support IT security function, be sure to use ProSafe-RS with

the Legacy model of IT security settings. PRM R3.04 or earlier version does not support the
SCSP2 station.

B Use of Exaopc

® Coexistence of ProSafe-RS and Exaopc on the Same Computer
Exaopc and ProSafe-RS software cannot run on the same computer.
® Version

ProSafe-RS can be connected to Exaopc R3.21.00 or later.

When using ProSafe-RS R3.02.20 or later, the recommended version of Exaopc is R3.72.00
or later.
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B Use of Exaquantum

® Coexistence of ProSafe-RS and Exaquantum on the Same Computer

Exaquantum and ProSafe-RS software cannot run on the same computer.

® Version

ProSafe-RS R3.01 or later can be connected to Exaquantum R2.20 or later.

When using ProSafe-RS R3.02.20 or later, the recommended version of Exaquantum is
R2.60 or later. Because the version of Exaquantum that is earlier than R2.60 does not support
IT security function, you must select Legacy model for ProSafe-RS.
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B. New Setup

This section explains the procedures for setting up stations.
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B1.

Preparing for the Setup

This section explains the items that must be determined before you start setting up a station
and precautions for the setup.

B Items to be Determined Before the Setup

This section lists the items that need to be determined before you start the setup tasks.

® Domain Number/Station Number

SEE

ALSO

A domain number is a number assigned to a group of stations connected on a control bus
network. Domain numbers should be set within a range from 1 to 31 (when integrating with
CENTUM, 1to 16).

A station number is a number assigned to each station. In each domain, station numbers
should be set within a range from 1 to 64.

Computer Name/Station Name

A computer name is a name used to identify each computer on the Windows network. You
can set the computer name from Windows Control Panel.

A station name is a unique name that is assigned based on the control bus address in the
ProSafe-RS system.

Examples: SENGddss (SENG)
STNddss (computers other than SENG)

(ddss: “dd” is the domain number and “ss” is the station number.)
It is recommended to match the computer name and the station name of a station.

IP Address

Determine the IP addresses of stations for control bus and Ethernet.
When using Vnet/IP without installing Ethernet, also determine the IP addresses for Vnet/IP
open communication.

Subnet Mask

Determine the subnet masks of stations for control bus and Ethernet.

When using Vnet/IP without installing Ethernet, also determine the subnet masks for Vnet/IP
open communication.

For more information about IP addresses and subnet mask for control bus, refer to:
“@® Setting IP Address for Vnet” on page B3-46

For more information about IP addresses and subnet mask for VnetlPOpen, refer to:
“®@ |P Address for VnetlPOpen” on page B3-47

For more information about IP addresses and subnet mask for Ethernet, refer to:

“® Setting IP Address for Ethernet” on page B3-48

Administrative User's Account and Password

Determine the name and password for the administrative user account of the computer.

If the system is used in a domain environment, determine the name and password for the ad-
ministrative user of the domain.
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® Security Model and User Management Type

Determine the security model and user management type, which are set by running the IT se-
curity tool, to be set on the computer you are going to set up.

ﬂ IMPORTANT

Some of the setup procedures vary depending on the “security model” and “user manage-
ment type,” which are set using the IT Security Tool. Be sure to determine the policies for se-
curity settings of the entire system before you start the setup tasks.

SEE

ALso For more information about IT security, refer to:
1., “Overview” in ProSafe-RS Security Guide (IM 32Q01C70-31E)

® License Assignment

Determine the license assignments for the computers you are going to set up.

ﬂ IMPORTANT

In a ProSafe-RS system, you need to decide on one computer for use as the license manage-
ment station. The license management station can be set up on a computer where SENG
runs.

Among stations of the system, you must set up the license management station first. Then,
set up the computers that will be used as license-assigned stations. The software packages
installed on the license-assigned stations become available for use after the licenses are dis-
tributed from the license management station and accepted on the license-assigned stations.

If an independent license management station is desired, you can also set it up as the com-
puter dedicated to license management.

SEE

ALso For more information about licenses, refer to:

1., “Overview of license management” in License Management (IM 32Q01C60-31E)

B Precautions for Setup

Take note of the following precautions before you start the setup.

® Changes in Windows Settings

Installing the ProSafe-RS Software changes the following Windows settings.

Table B1-1 Changes in Windows Settings

Items Setting Purpose

Account name display in logon screen | Disable | To protect logon account names from unauthorized use.

Fast user switching Disable | Simultaneous logon of multiple users is not supported.

® When the System Contains Different Revisions

+ SENGs in the same RS project should have the software of the same release number.
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SEE

ALSO

SEE
ALSO

* The SCS system program release number of SCSs in a system should basically be the
same, but mixture of different release numbers is allowed. However, release numbers of
SCSs communicating with each other by Inter-SCS safety communication must be in ac-
cordance with the explanation in this manual.

For more information about compatibility in inter-SCS safety communication between different revisions, refer
to:

* Appendix 4.9, “Upgrading to Version R3.02.00” on page App.4-36

* Appendix 4., “Compatibility between Revisions and Cautionary Notes for Upgrading” on page
App.4-1

When a User Account Control Dialog Box Appears

During installation, a user account control dialog box may be displayed on certain circumstan-
ces.

If displayed, click [Yes] or [Continue] (for uninstallation, [Yes] or [Allow]) to continue.

Display Style of Control Panel
Some setup procedures may include instructions to display Windows Control Panel.
In this manual, instructions to select a menu item on Control Panel of Windows 7 are written
assuming that the display style of Control Panel is set to "Categories."

When Connecting with Other Products

When connecting ProSafe-RS to other YOKOGAWA products, configuration of IT security set-
tings or other tasks may be required.

For more information about the tasks when connecting CENTUM VP with other products, refer to:

D., “Connection with Other Products” on page D-1
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B2. Setting Up the Windows Domain
Environment

This section describes the required settings when ProSafe-RS is used in a Windows domain
environment. You may also set up the Windows domain environment at a later stage.

EE . . . , , ,
ALso For more information about setting up the Windows domain environment at a later stage, refer to:

C2., “Setting Up the Windows Domain Environment Later” on page C2-1
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B2.1 Overview of Setting Up the Domain
Environment

This section explains the overview of setting up the Windows domain environment.

It is recommended to provide dual-redundant domain controllers because the entire system
will have troubles if the only domain controller fails.

B Workflow

The following figure shows the procedure for setting up the Windows domain environment.

Set up the domain controller

Configure IT security settings
for the domain controller

Create domain users

Add client computers
to the domain

End

Figure B2.1-1 Flow of setting up the Windows domain environment

H Items to be Determined in Advance
¢ Domain name

* |P Address of the domain controller

® Items to be Prepared
*  Computer for the domain controller

* ProSafe-RS software medium (Model: CHSKM30)
This is required for IT security configuration.
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B2.2 Configuring the Domain Controller

(Windows Server 2008/Windows Server
2008 R2)

This section describes the procedure for configuring the domain controller on Windows Server
2008 or Windows Server 2008 R2.

B Setup Procedure

TIP

TIP

1.

From the Start menu, select [All Programs] > [Administrative Tools], and then select
[Server Manager].
The Server Manager appears.

Open [Server Manager] > [Roles], and then select [Add Roles].
The Add Roles wizard appears.

Click [Next].
The Select Server Roles page appears.

For Server Roles, select the [Active Directory Domain Services] check box and then click
[Next].
An overview of the selected settings is displayed.

If you are using Windows Server 2008 R2, a dialog box for adding features appears before an overview of the
selected settings is displayed. Click [Add Required Features]. An overview of the selected settings is dis-
played.

Review the content and click [Next].
The Confirm Installation Selections page appears.

Click [Install] .
The installation starts, and the results of installation is displayed when completed.

Click [Close this wizard and launch the Active Directory Domain Services Installation Wiz-
ard (dcpromo.exe)].
Active Directory Domain Services Installation Wizard appears.

If you are using Windows Server 2008 R2, .NET Framework 3.5.1 is enabled in addition to Active Directory
Domain Services.

10.

11.

12.

13.

Click [Next].
The information regarding Operating System Compatibility is displayed.

Confirm the information and then click [Next].
The Choose a Deployment Configuration page appears.

Select [Create a new domain in a new forest], and then click [Next].
The Name the Forest Root Domain page appears.

In the FQDN of the forest root domain text box, type the predetermined domain name in
the format "Domain name + .local"and then click [Next].
The Set Forest Functional Level page appears.

In the Forest functional level drop-down list, select [Windows Server 2003] and then click
[Next].
The Set Domain Functional Level page appears.

In the Domain functional level drop-down list box, select [Windows Server 2008] and then
click [Next].
The Additional Domain Controller Options page appears.
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14

15.

16.

17.

18.

19.

Confirm that the [DNS server] check box is selected and click [Next].
The Location for Database, Log Files, and SYSVOL page appears.

Specify the locations of the database folder, log files folder, and SYSVOL folder, and then
click [Next].

The Directory Services Restore Mode Administrator Password (DSRM) dialog box ap-
pears.

Enter the password of the Administrator account used when starting in the Directory
Services Restore Mode and click [Next].
The Summary page appears.

Confirm your selections displayed in the summary, and then click [Next].
The setups for Active Directory Domain Services starts. The Completing the Active Direc-
tory Domain Services Installation Wizard page appears.

Click [Finish].
A message box for restarting the computer to validate the active directory domain serv-
ices is displayed.

Click [Restart Now].
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B2.3 Configuring Security Settings for the
Domain Controller

In a system that uses the Standard model of security settings, you need to run the IT Security
Tool on the domain controller as well to apply the Standard model of security settings.

B Preparing for Running the IT Security Tool
1. Log on to the domain controller as an administrative user.

2. Perform the following operations regarding .NET Framework.
*  On Windows Server 2008 R2, enable .NET Framework 3.5.1.

*  On Windows Server 2008, enable .NET Framework 3.0.

3. From the Start menu, select [All programs] > [Administrative Tools] > [Active Directory

Users and Computers].
The Active Directory Users and Computers window appears.

4. In the left pane, right-click the [Users] folder and then select [New] > [Group].
The New Object - Group dialog box appears.

[ actrve Drectory Users amd Computers T = £

Fie  Action View (Melp

T o+ HOITRTTOR
. Actve Grectory Users o Comput [Tipe [ Deserpion i
| Saved Quares ' hetest local Domar
=] g heasatlecal Saved QuETES Fobder o siore your faver, .
# [ Bultin
+ Compuiters
¥ 4| Domsn Controlers
+ Farmgrienuntybrnopaly
Delegabe Corvirol...
Frd...
EEE
e E—
e | metorgPerson
i S (e s
[Printer
=
Srawed Folder
£ I— |
Crmabe & rerm shject... :

Figure B2.3-1 Active Directory Users and Computers

5. Enter PSF MAINTENANCE in the Group name box, select the Group scope and Group
type options, and then click [OK].
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Hew Object - Group i ﬂ

& Createin:  histest.ocal/Users

Group name:

| PSF_MAINTENANCE

Group name (pre-Windows 2000):

| PSF_MAINTENANCE

Group scope
" Domain local
 Global

" Universal

Group type
& seasity
" Distribution

]

Figure B2.3-2 New Object - Group

6. Check the right pane to confirm that the PSF_MAINTENANCE group has been created in
Users.

'-Eile' Action: View Help

| B Active Directory Users and Computers

PN R G o

[ Active Directory Users and Comput || Name | Typs | Description |
[] saved Queries mﬂsh’amr User Buit-n account for admini...
B & histest.local 82, Mllowed RODC Password Replication Group Security Group ... Members in this group can. ..
'U Builtin 82, Cert Publishers Security Group ...  Members of this group are...
[:J Computers “¥psE MATNTENANCE Sac P
":'j g;_“;:: Conb:olerls 82, Denied RODC Password Replication Group  Security Group ... Members in this group can...
- Senmt\ermals 82, Dnsadmins Security Group ...  DNS Administrators Group
E :j S:::m RETYIcE Accuits 2, DnsUpdateProxy Security Group ...  DNS dlients wha are permi, .,
82, Domain Admins Security Group ...  Designated administrators. .,
82 Domain Computers Security Group ... Al workstations and serve. .,
-@,Dumain Controllers Security Group ...  All domain controllers in th, ..
42, Domain Guests Security Group ... Al domain guests
sé,Dumain Users Security Group ...  All domain users
%Eniﬁpn’se Admins Security Group ... Designated administrators... |
S&Emﬁ'prisa Read-only Domain Controllers  Security Group ... Members of this group are... =
%Q\wp Policy Creator Owners Security Group ...  Members in this group can. ..
s Guest User Built-in acoount for guest ...
il s ,Ll %Rﬁandms Servers Security Group ...  Servers in this group can ...
e : G < T gt i -

I

I

Figure B2.3-3 Activate Directory Users and Computers (after creating a new group)

7. Add the logged on user to the PSF_MAINTENANCE and Domain Admins groups.

SEE

ALso For more information about how to enable .NET Framework 3.5.1 and 3.0, refer to:

“@ Enabling .NET Framework 3.5.1” on page B3-25

For more information about how to add uses to user groups, refer to:

‘@ Adding Domain Users to Domain Groups” on page B2-10
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B Saving the Initial IT Security Settings

ﬂ IMPORTANT

When you use the IT Security Tool to configure IT security settings for the first time after the
Windows domain has been set up, be sure to save the security settings on the computer be-
fore you use the tool. Keep the saved data in a safe place because the data will be required
when you initialize the configured security settings.

Follow these steps to save the security settings before your run the IT Security Tool:

1. Log on to the computer as the user who belongs to the Domain Admins and PSF_MAIN-
TENANCE groups.

2. Insert the ProSafe-RS software medium into the drive.
+ If the AutoPlay dialog box appears, click [Run Launcher.exe].

« If the AutoPlay dialog box does not appear, use Explorer and double-click Launch-
er.exe in the top folder of the software medium.

The installation menu appears.

3. Click [Setting IT Security (File server/domain controller use)].
The IT Security Tool starts.

IT Security Tool =l ® =

IT Security Tool

Setup

Save

Restore

Change Password
{Encryption Key)

Figure B2.3-4 IT Security Tool menu

4. Click [Save] to save the security settings.
SEE

ALso For more information about the subsequent steps to save the IT security settings, refer to:

C8.2.1, “Procedure for SENG PC” on page C8-9
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B Configuring IT Security Settings

1. From the IT Security Tool menu, click [Setup].
A confirmation dialog box appears.

2. If you have saved the aforementioned security setting data for initialization, click [OK].
The Select Security Model page appears.

TIP If you have not saved the initial security setting data, click [Cancel] to go back to the main menu and save the
current security settings.
IT Security Tool - Setup
Select Security Model
Setting Model -
Description of Setting File
Setting tem Description
Figure B2.3-5 Select Security Model
3. From the Setting Model drop-down list, select [Domain Controller Standard Model Do-
main/Combination Management].
4. Click [Next].
The Confirm Setting Information page appears.
TIP If you click [Details], the Select Setting ltems page appears.
5. For the rest of steps, perform the same operations as when the IT Security Tool is run
immediately after installing the ProSafe-RS software.
SEE

ALso For more information about the IT security setting operations that are performed following the ProSafe-RS
software installation, refer to:

B3.5.2, “Running the IT Security Tool” on page B3-62
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B2.4 Creating Domain Users

This section explains how to create domain users and add them to the domain groups.

ﬂ IMPORTANT

When you change the rights of domain users, the changes may not be applied immediately. If
this happens, log on and log off twice on each computer after you have changed users' rights.

Do the same thing when you have deleted rights from domain users.

B Creating a Domain User

TIP

1.

e w0/ o+ BMBRSTYIS

Users and Computers].
The Activate Directory Users and Computers window appears.

File Action View Help

B Active Directory Users and Compubters

™7 Active Directory Users and Comput | Mame [ Type | Description =
# ] Saved Quenes Administrator User Built-n sccount for admini. .,
= EWLW B2, Aloweed RODC Passwo... Security Group ... Members in this group can...
i B2 Cert Publshers Security Group ...  Members of this group are...
a &2 cv_encinesm Security Group ...
= 8 CTM_ENGINEER_ADM  Security Group ...
- 81CTM_MAINTENANCE ~ Security Group ...
CTM_OPC Seourity Group ...
CTM_CIPERATOR Seaurity Group ...
Security Group ... Members in this group can....
Computer Security Group ... DNS Administrators Group
Al Tarses #  Contact Security Group ... DNS dients who are permi...
e )| e Segurity Group ...  Designated administraters...
TnetOrgPerson Sequrity Group ... Al workstations and serve, ..
Refresh MSMQ Queve Mas | o ity Group ... Alldomain controllers in th...
Export List. Printer Sequrity Group ... Al domain guests
T B - coo.. A doman e -
Shared Folder Sequrity Group ...  Designated administrators...
Help Enterprise Read-only ...  Security Group ... Members of this group are...
83, Group Policy Creator ... Security Group ...  Members in this group can....
¢f | | 2 et User Built-n account for ouest ., =l
fCreste a new sbiect... |

Figure B2.4-1 Activate Directory Users and Computers

From the Start menu, select [All programs] > [Administrative Tools] > [Active Directory

In the left pane, right-click the [Users] folder and then select [New] > [User].

3. The New Object-User dialog box is displayed. Input the necessary information.

Full name and User logon name have to be input in this dialog box. Additionally, if the User logon name is
input, another logon name which is located under the above-mentioned User logon name is automatically in-
put. However, the name is changeable.
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new Obect -user |

& Create in:  histest local/Users

First name: I\"oltngawa Initials: I

Last name: IMaim.enanne

Full name: I\"okugawa Maintenance

User logon name:

I maintenance I@I‘lslﬁl]ncal :’
User logon name {pre-Windows 2000):

'WSTEST\ Imaintcnan::c

Figure B2.4-2 New Object-User

4. Click [Next].

A dialog box appears, prompting you to enter the password.

5. Enter the password, select the check boxes of the required items, and click [Next].

A confirmation dialog box appears.
6. Click [Finish].

7. Open the Users folder and check the right pane to confirm that the new domain user has

been added.
|8 ActveDirectory usersand Computers ] a1
He Acton Vew tep
e @ 40X =BT 3R5TIS
] Active Directory Users and Comput | Name | Type | Description -
[ saved Queries £, administrator User Built-n account fi,
o= histest.local 2, Allowed RODC Password Replication Gr... Security Group ... Members in this g
B [ Builtin va Maintenance
@ | -J Computers 83, Cert Publishers Security Group ... Members of this ¢
& (& Domlain Conhfdlerls . 82 CTM_MAINTENANCE Security Group ...
EI j :::;i:?xx:ﬁu #2 Denied RODC Password Replication Group  Security Group ... Members in this g
' ._] Viade ngam Security Group ...  DNS Administrato
82, DnsUpdateProxy Security Group ...  DNS clients who &
82 Domain Admins Security Group ... Designated admir
82, Domain Computers Security Group ...  All workstations 2
82, pomain Controllers Security Group ...  All demain contro
82, Domain Guests Security Group ...  All domain guests™
E,Dﬂ'l‘lﬂ"l Users Security Group ...  All domain users
82 Enterprice Admins Security Group ... Designated admir
@,Enierprise Read-only Domain Controllers  Security Group ...  Members of this ¢
%&u.chicyO‘aatnrmers Security Group ... Members in this g
R A R
K — 21| -

Figure B2.4-3 Activate Directory Users and Computers (confirmation of newly created user)

B Adding Domain Users to Domain Groups

When applying the Standard model of security settings, you must add the domain users to ap-

propriate domain groups.
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After you run the IT Security Tool on the domain controller, the following ProSafe-RS domain
groups have been created.

PSF_OPERATOR
PSF_ENGINEER
PSF_OPC
PSF_MAINTENANCE

® Adding a Domain User to a Domain Group

This section describes an example of adding a domain user (the user "yokogawa") to the
PSF_MAINTENANCE group.

TIP

For domain users who belong to a domain group which requires administrative rights, you also need to per-

form the procedure in the next section "eSetting Administrative Rights."

In the Active Directory Users and Computers window, double click the user that you want
to grant the group's rights.
The properties dialog box for the selected user appears.

2. Select the [Member Of] tab and click [Add].
The Select Groups dialog box appears.

3. Click [Advanced].

The advanced settings are displayed in the Select Groups dialog box.
4. Click [Find Now] to display the list of available groups. Select the PSF_MAINTENANCE

group and click [OK].
2]

Select this object type:
I(iumwﬂi—ilmﬂym
From this location:

l?ii.ﬂhcd

Name: |Starts wih ¥ |

[l

7
oK | cance |

Search results:

Mame (RDMN) | Description | In Folder | -
2, CTM_MAINTENANCE histest Jocal/Users e
82,CTM_OPC histest Jocal/Users

“&PSF_MAINTENAMNCE histest local 'Users

82, Denied RODC Pass.. Membersinthis .. histest local/Users -l

Figure B2.4-4 Select Groups dialog box - Search results

5. In the Select Groups dialog box, ensure that PSF_MAINTENANCE appears and click

[OK].

6. Inthe user's properties dialog box, ensure that PSF_MAINTENANCE appears in the

Member of list.
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® Setting Administrative Rights

Follow these steps to assign administrative rights to a domain user who belongs to a domain
group which requires administrative rights:

1.
2.

Add the domain user to the Domain Admins group.

Open the properties dialog box for the user. Click the [Member Of] tab, select [Domain
Admins], and click [Set Primary Group].
The primary group of the user changes to Domain Admins.

Select [Domain Users] and click [Remove].

Confirm that Domain User has been removed from the Member of list and click [OK].
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B2.5

Adding Client Computers to the Domain

To add client computers to a domain, computer accounts of the client computers need to exist
on the domain controller. Computer accounts can be created in two ways: creating on the do-
main controller computer or on client computers.

When creating a computer account on the domain controller, the client computer can be add-
ed to the domain by configuring on the client computer after the computer account is created.
When creating a computer account on the client computer, the client computer is added to the
domain at the same time the computer account is created.

This section explains the procedure for the case where computer accounts are created on the
domain controller. In the procedure, you are required to enter the user name and password of
the administrative user of the domain when you configure on a client computer.

B Precautions When Setting Up Client Computers

When ProSafe-RS is used in a domain environment, add the client computer to the do-
main before you install the ProSafe-RS software. In the IT security setting configuration
that is performed following the ProSafe-RS software installation, select the Standard
model applying either the Domain management or Combination management.

If you are unable to add the client computer to the domain in advance, set the Legacy
model or the Standard model applying Standalone management temporarily in the IT se-
curity setting configuration that is performed following the ProSafe-RS software installa-
tion. Then, add the computer to the domain and change to the Standard model applying
Domain management or Combination management.

When you install the ProSafe-RS software on a client computer that is a domain member,
you need to log on as the administrative user of the domain. So, in advance, create on
the domain controller computer an administrative user who installs the ProSafe-RS soft-
ware and add the user to the Domain Admins and PSF_MAINTENANCE groups.

After installing the ProSafe-RS software, add the administrative user of the client comput-
er to the PSF_MAINTENANCE_LCL group.

SEE

ALso For more information about changing the security model, refer to:

C8.1, “Changing the IT Security Settings” on page C8-2

B Configuration on the Domain Controller

1.

From the Windows Start menu, select [All programs] > [Administrative Tools] > [Active Di-
rectory Users and Computers].
The Active Directory Users and Computers window is displayed.

Right-click the Computers folder, and select [New] > [Computers].
The New Object - Computer dialog box appears.
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Figure B2.5-1 Active Directory Users and Computers (Create new-Computers)

3. Enter the [Computer Name], and click [OK].

Figure B2.5-2 New Object-Computer (Input of Computer Name)

4. Confirm that the new computer has been added in the Computers folder.

IM 32Q01C50-31E 4th Edition : Jan.30,2015-00



<B2.5 Adding Client Computers to the Domain> B2-15

B Actve Directory Users and Computers

fle Acton View Help

M 0RO = BR TS TPIR |
. Active Directory Users and Comput | Name T
® [ saved Queries w
= 3 histest local
@ [ Buitin
] Computers
# 5] Domain Controlers
[# || ForeignSecurityPrincipals
| Users
1 |

Figure B2.5-3 Active Directory Users and Computers (confirmation of newly added computers)

Configuration on the domain controller is now finished. Go on to the procedure for config-
uration on the client computer.

B Configuration on a Client Computer (Windows 7)

Follow these steps to add a Windows 7 computer to the domain:

1. From the Start menu, select [Computer].
The Computer window appears.

2. In the Computer window, click [System Properties].
The System window appears.

3. Inthe System window, click [Change settings].
The System Properties dialog box appears.

4. In the System Properties dialog box, select the [Computer Name] tab and click [Change].
The Computer Name/Domain Changes dialog box appears.

5. On the Computer Name/Domain Changes dialog box, select [Domain], enter the domain
name, and click [OK].
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=)

-
Computer Name/Domain Changes.

il —

You can change the name and the membership of this
computer. Changes might affect access to network resources.
More information

Computer name:
DOCHIS0162

Full computer name:
DOCHISD162

Member of
@ Domain:
pldom |

() Workgroup:
WORKGROUP

[ ok || cancel |

Figure B2.5-4 Computer Name/Domain Changes Dialog Box

6. Inthe dialog box that is displayed, enter the user name and password of the administra-
tive user of the domain and click [OK].

TIP

An error message dialog box may appear, indicating that the domain name cannot be changed. However, you
can click [OK] to proceed because the computer has been added to the domain successfully.

7. On the Computer Name/Domain Changes dialog box, click [OK].

8. On the dialog box for confirmation of restarting, click [Restart Now] to restart the comput-
er.

B Configuration on a Client Computer (Windows Vista)

Follow these steps to add a Windows Vista computer to the domain:

1. From the Start menu, select [Computer].
The Computer window appears.

2. In the Computer window, click [System Properties].
The System window appears.

3. Inthe System window, click [Advanced system settings].
The System Properties dialog box appears.

4. In the System Properties dialog box, select the [Computer Name] tab and click [Change].
The Computer Name/Domain Changes dialog box appears.

5. On the Computer Name/Domain Changes dialog box, select [Domain], enter the domain
name, and click [OK].
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You can change the name and the membership of this
computer. Changes might affect access to netwonk resources.
More information

Computer name;

HIS0164

Full computer name:

HIS0164

Member of
@ Domain:
CENTUMVP

) Workgroup:
|WORKGROUP

Figure B2.5-5 Computer Name/Domain Changes Dialog Box

6. Inthe dialog box that is displayed, enter the user name and password of the administra-
tive user of the domain and click [OK].

On the Computer Name/Domain Changes dialog box, click [OK].

8. On the dialog box for confirmation of restarting, click [Restart Now] to restart the comput-
er.
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B2.6 Setting Up Redundant Domain Controllers

It is recommended to provide another domain controller for redundancy because the entire
system will have troubles if the only domain controller fails.

B Setup Procedure
1. Add the second domain controller computer to the existing domain.

2. Configure IT security settings.
SEE

ALso For more information about configuring the IT security settings, refer to:

B2.3, “Configuring Security Settings for the Domain Controller” on page B2-5
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B2.7 Setting Up Time Synchronization in
Windows Domain Environment

When using ProSafe-RS in a Windows domain environment, the time on computers used in
the ProSafe-RS system and the time on the domain controller must be synchronized.

Because the time synchronization service of a ProSafe-RS system uses the time on the con-
trol bus as the time master, the time of the domain controller should be synchronized to the
time of client computers if the system is used in a domain environment.

This section describes how to set up time synchronization in a system that consists of only
ProSafe-RS.

B Cautionary Note on Time Synchronization
A computer installed with the ProSafe-RS software is automatically configured so as not to

use the domain controller as the time master for time synchronization, even if the computer is
added to the Windows domain.
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B2.7.1 Implementing Time Synchronization in a System
Consisting of Only ProSafe-RS

This section describes how to implement time synchronization in a system consisting of only
ProSafe-RS for the following cases:

* V net — Not synchronize to the Coordinated Universal Time (UTC)
*  Vnet/IP — Synchronize to the Coordinated Universal Time (UTC)
* Vnet/IP — Not synchronize to the Coordinated Universal Time (UTC)

B For V net — Not Synchronize to the Coordinated Universal Time
(UTC)

Configure a station connected to the V net domain as the SNTP server. Times on the comput-
ers within the V net domain are synchronized using the V net time synchronization function.
Time synchronization of the entire system is achieved by synchronizing the time on the do-
main controller to the SNTP server.

TIP

When a station is used as the SNTP server, the system time is not synchronized to UTC but to the time on
the hardware of the SNTP server.

*  On the computers connected on V net, do not use the Windows W32Time service to per-
form time synchronization. If used, times on the computers are synchronized to the time
on the domain controller and synchronization with the SNTP server is prevented.

*  On the domain controller, use the Windows W32Time service to synchronize its time with
the SNTP server.

Domain
Controller

I

| Ethernet
Synchronize
V net
SSNTP Time Master Computer
EIVer | (SENG etc.)
[
| V net time synchronization
—— V net

SCS

Figure B2.7.1-1 Implementing Time Synchronization (V net — Not Synchronize to UTC)

SEE

ALso For more information about how to configure a station as the SNTP server, refer to:

“@ Setting a Station as the SNTP Server” on page B2-22

B For Vnet/IP — Synchronize to the Coordinated Universal Time (UTC)

* Introduce an SNTP server and make it synchronize with UTC. Configure the domain con-
troller and the Vnet/IP system so that they will reference the time of the same SNTP serv-
er.
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*  On the computers connected on Vnel/IP, do not use the Windows W32Time service to
perform time synchronization. If used, times on the computers are synchronized to the
time on the domain controller and synchronization with the SNTP server is prevented.

Domain
Controller
Synchronize T
Ethernet
Vnet/IP
SNTP Time Master Computer
Server (SENG etc.)
oo Synchronize"'?' ceo00cccceces,,,
°® ®e
e : — s Vnet/IP
° Vnet/IP time synchronization ot®
..'°Ooo. 00.°..
®e0cccccccc00000000°°®
SCS SCS

Figure B2.7.1-2 Implementing Time Synchronization (Vnet/IP — Synchronize to UTC)

B For Vnet/IP — Not Synchronize to the Coordinated Universal Time
(UTC)

Configure a station connected to the Vnet/IP domain as the SNTP server. Times on the com-
puters within the Vnet/IP domain are synchronized using the Vnet/IP time synchronization
function. Time synchronization of the entire system is achieved by synchronizing the time on
the domain controller to the SNTP server.

TIP When a station is used as the SNTP server, the system time is not synchronized to UTC but to the time on
the hardware of the SNTP server.

*  On the computers connected on Vnet/IP, do not use the Windows W32Time service to
perform time synchronization. If used, times on the computers are synchronized to the
time on the domain controller and synchronization with the SNTP server is prevented.

* On the domain controller, use the Windows W32Time service to synchronize its time with
the SNTP server.

Domain
Controller

Synchronize |

Vnet/IP
SNTP Time Master Computer Computer
eIVeT | (SENG etc.)

Ethernet

L]
a & Vnet/IP
®ol, Vnet/IP time synchronization 40°

[ ]

°
oo °®
®e eo®
®%00c0c00c000000°®

SCS SCS

Figure B2.7.1-3 Implementing Time Synchronization (Vnet/IP — Not Synchronize to UTC)
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B Setting a Station as the SNTP Server

1. Use an administrative user account to log on to the station you want to set as the SNTP
server, and run the following command as the administrator.
(ProSafe-RS software medium drive) :\ProSafe-RS\TOOLS\BeNtpServer.cmd
The Command Prompt window appears and displays "Enable NTP Server? (y/n/quit)."

TIP

If the IT security settings have been configured to apply software restriction policies, run the command
prompt (cmd.exe) as the administrator and then run the command from the command prompt window.

2. Enter"y," and then press the [Enter] key.
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B2.7.2 Implementing Time Synchronization When
Integrated with CENTUM

When the system is integrated with CENTUM, set up time synchronization by following the ex-
planation provided in the manual of CENTUM. If the system consists of multiple V net do-

mains or a mixture of Vnet/IP domain and V net domain, also follow the explanation in the
manual of CENTUM.

EE . . . N, . .
§LSO For more information about how to set up time synchronization in Windows domain environment for a system
integrated with CENTUM, refer to:

B2.8, "Setting Up Time Synchronization in Windows Domain Environment" in CENTUM VP Installation
(IM 33K01C10-50E)
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B3. Setting Up the SENG

This section describes the tasks required for the new setup of SENG.

ﬂ IMPORTANT

In a ProSafe-RS system, you need to decide on one computer for use as the license manage-
ment station. The license management station can be set up on a computer where SENG
runs.

Among stations of the system, you must set up the license management station first. Then,
set up the computers that will be used as license-assigned stations. The software packages
installed on the license-assigned stations become available for use after the licenses are dis-
tributed from the license management station and accepted on the license-assigned stations.

If an independent license management station is desired, you can also set it up as the com-
puter dedicated to license management.

EE , . , .
ALso For more information about how to set up the computer dedicated to license management, refer to:

B6., “Setting Up the Computer Dedicated to License Management” on page B6-1

H [tems to be Prepared
Have the following items at hand before new installation of the ProSafe-RS software.
* ProSafe-RS software medium (Model: CHSKM30)

Also have the following items at hand if the SENG is to be used as a license management
station. These are required when distributing licenses.

* ProSafe-RS license medium (Model: CHSCM30)
* ProSafe-RS license sheet (with project ID)
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B3.1 Setting Up the Hardware

This section describes the hardware setups required for an SENG.

A WARNING

When removing and installing the cards to set DIP switches, take measure to prevent the
damages caused by static electricity.

EE . , -
ALso For more information about antistatic measures, refer to:

Appendix 3., “Antistatic Precautions When Handling Hardware” on page App.3-1

B Setting Up the Control Bus Interface Card

The following two types of control bus interface cards are available. These cards have the
same functionality.

*  VF702 (for PCI Express)
*  VF701 (for PCI bus)

The Control Bus interface card has DIP switches for setting the domain number and the sta-
tion number. The combination of domain number and station number determines the station
address.

You must set the DIP switches before you configure network settings.

This section describes how to set the DIP switches. The DIP switch locations are the same on
VF702 and VF701 cards.

—
O
DIP switches
DOMAIN .
Swi L — Domain number
DOM
[ E'""]: STATION i
- g‘#@l:-l————— Station number
m

Figure B3.1-1 Location of DIP Switches

® Setting the Domain Number

A domain is a collection of stations that are connected on one control bus network. Set a do-
main number from 1 to 31 (1 to 16 when integrating with CENTUM).
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SEE

ALSO

SEE

ALSO

SEE
ALSO

DOMAIN NO.
P 0 0 |(MSB)(LSB)
1112345678
o [WEWEEWEH
L|J I_'_I Domain number (5 bits)
Fixed to 0 (2 bits)

Parity of the domain number (1 bit) (odd parity)

MSB : Most Significant Bit
LSB : Least Significant Bit

Figure B3.1-2 Domain Number Setting DIP Switches

For more information about domain numbers and corresponding DIP switch positions, refer to:

“@ Domain Numbers and DIP Switch Positions” on page App.1-1

Setting the Station Number

Station numbers should be set in the range of 1 to 64; it is recommended to set starting from
64 in the descending order.

STATION NO.
23456 78
oI
I—'l— Station number (7 bits)

Parity of the station number (1 bits) (odd parity)

o
m-| T

MSB : Most Significant Bit
LSB : Least Significant Bit

Figure B3.1-3 Station Number Setting DIP Switches

For more information about station numbers and corresponding DIP switch positions, refer to:

“® Station Numbers and DIP Switch Positions” on page App.1-2

Precautions on Installing the Control Bus Interface Card

* Install VF702/VF701 in the computer after setting up Windows but before configuring the
network settings.

« Install the control bus driver when you restart the computer after installing VF702/VF701.
Follow the procedure in this manual to install the driver.

For more information about the procedure to install the control bus driver in a computer, refer to:

B3.3.1, “Installing the Control Bus Driver” on page B3-33

Installing the Control Bus Interface Card

After you have set the station address on the VF702/VF701 card, follow these steps to install
it in the computer:

1. Turn off the power of the computer. For safety, remove the power plug from the outlet.
2. Remove the cover of the main unit of the computer.

3. Unscrew the screws fixing the slot cover and remove the slot cover.
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Insert the VF702/VF701 card in the corresponding slot and fix it to the slot.
Mount the cover back on the computer.

Write the station address on the label that comes with the VF702/VF701 card and paste it
in the front or other easy-to-see location of the computer.

B Setting Up the Vnet/IP Interface Card

You need to install a Vnet/IP interface card (VI702/VI701) in the computer that is to be con-
nected on a Vnet/IP network.

VI702 is for PCI Express, and VI701 is for PCI. Because VI702 and VI701 have the same
functionality, VI702 is used as an example in the following explanation.

The Vnet/IP interface card has DIP switches for setting the domain number, station number
and action mode. The combination of domain number and station number determines the sta-
tion address.

You must set the DIP switches before you configure network settings.
This section describes how to set the DIP switches.

DIP switches
Domain number  Station number

— sy )
O] STATION
Erad

Operating mode

Figure B3.1-4 Locations of DIP Switches

® Setting the Domain Number

A domain is a collection of stations that are connected on one control bus network. Set a do-
main number from 1 to 31 (1 to 16 when integrating with CENTUM).

DOMAIN NO.

(MSB)(LSB)

6 78

: ﬁﬁﬁﬁﬁuuu
\_|_/

Domain number (5 bits)
Fixed to 0 (2 bits)
Parity of the domain number (1 bit) (odd parity)

MSB : Most Significant Bit
LSB : Least Significant Bit

Figure B3.1-5 Domain Number Setting DIP Switches
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SEE

ALso For more information about domain numbers and corresponding DIP switch positions, refer to:

“@ Domain Numbers and DIP Switch Positions” on page App.1-1

® Setting the Station Number

Station numbers should be set in the range of 1 to 64; it is recommended to set starting from
64 in the descending order.

STATION NO.
2345678
PEdnbin
I—: Station number (7 bits)

Parity of the station number (1 bits) (odd parity)

(@)
W~ | T

MSB : Most Significant Bit
LSB : Least Significant Bit

Figure B3.1-6 Station Number Setting DIP Switches

SEE

ALso For more information about station numbers and corresponding DIP switch positions, refer to:

“® Station Numbers and DIP Switch Positions” on page App.1-2

® Action Mode Switch

SW4 on the printed circuit board is the action mode switch.

Use the card with all the bits of this DIP switch set to OFF (factory set defaults). The meaning
of DIP switch bits are as follows:

— N ™ < —— Bit number

"I

o

ABCD

Figure B3.1-7 Action Mode Switch

Table B3.1-1 DIP Switch Usage

DIP switch ON DIP switch OFF Remarks
A (bit1) |- Always OFF Reserved
B (bit2) | 100 Mbps 1 Gbps Communication speed (Default : OFF)
C (bit 3) |Force Auto Negotiation (Default : OFF)
D (bit4) |- Always OFF Reserved

® Precautions on Installing the Vnet/IP Interface Card

+ Install VI702 in the computer after setting up Windows but before configuring the network
settings.

» Install network drivers when you restart the computer after installing VI702. Follow the
procedure in this manual to install the drivers.

* If you use VI702 that was used in another system for a system consists of only ProSafe-
RS, erase the settings in the VI702 before installing it in the computer. When using such
VI702 in a system integrated with CENTUM, you do not need to erase the settings in the
VI702.
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SEE

ALso For more information about how to erase the internal settings of a VI702 card, refer to:
Appendix 2., “Procedure for Erasing VI702 Internal Settings” on page App.2-1
For more information about the procedure to install the network driver in a computer, refer to:
B3.3.1, “Installing the Control Bus Driver” on page B3-33
B3.3.2, “Installing the Vnet/IP Open Communication Driver” on page B3-35

® |Installing the Vnet/IP Interface Card

After you have set the station address and action mode on the VI702 card, follow these steps
to install it in the computer:

1. Turn off the power of the computer. For safety, remove the power plug from the outlet.
Remove the cover of the main unit of the computer.

Unscrew the screws fixing the slot cover and remove the slot cover.

Insert the VI702 card in the corresponding slot and fix it to the slot.

Mount the cover back on the computer.

Connect both the BUS1 and BUS2 cables to VI702 and Layer 2 switch. There is no need
to turn off the power of the Layer 2 switch.

o g A~ w DN

Connect the power cord of the computer back to the outlet and turn on the computer.
Make sure that the RDY lamp on VI702 is lit.

Write the station address on the label that comes with the VI702 card and paste it in the
front or other easy-to-see location of the computer.
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B3.2 Setting Up Windows

Before installing the ProSafe-RS software, you need to change the Windows settings on your
computer to the recommended settings.

This configuration should be performed on the computer where the Windows OS and its serv-
ice packs have been installed.
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B3.2.1 Configuring on Windows 7

Follow these procedures when you use a Windows 7 computer.

B File System

Ensure that the file system is in the NTFS format. If it is already formatted in the FAT format,
reinstall the operating system and reformat partitions into NTFS. Partitions not installed with
OS should also be formatted into NTFS.

B System Performance
Follow these steps to configure the system performance setting:
1. Log on as an administrative user.

2. From the Start menu, select [Control Panel] > [System and Security] > [System] > [Ad-
vanced system settings].
The System Properties dialog box appears.

3. Select the [Advanced] tab, and click [Settings] in the Performance section.
The Performance Options dialog box appears.

4. Click the [Visual Effects] tab and select [Let Windows choose what’s best for my comput-
er].

Visual Effects | Advanced I Data Execution Prevention

Select the settings you want to use for the appearance and
performance of Windows on this computer,

@ iet Windows choose what's best for my computer:
() Adjust for best appearance

bl | @ Adjust for best performance

() Custom:

Animate controls and elements inside windows
Animate windows when minimizing and maximizing
W Animations in the taskbar and Start Menu

Enable Aero Peek

Enable desktop composition

Enable transparent glass

Fade or slide menus into view

Fade or slide ToolTips into view

f Fade out menu items after didking

] save taskbar thumbnail previews

Show shadows under mouse pointer

Show shadows under windows

P Show thumbnails instead of icons

Show translucent selection rectangle

Show window contents while dragging

Slide open combo boxes T
Smooth edges of screen fonts

Smooth-scroll list boxes -

| »

m

[ ok || cancel |

Figure B3.2.1-1 Performance Options Dialog Box (Visual Effects Tab)

5. Click [OK].
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B Virtual Memory

ProSafe-RS does not require virtual memory configuration. However, if the ProSafe-RS and
CENTUM VP software coexist on the same computer, virtual memory should be configured

according to the instruction of CENTUM VP.

B Power Options

This section describes how to configure the Power Options settings. Some of the items in the
explanation may not be displayed on your computer, depending on the computer's hardware
configuration. If not displayed, the function of that item is not available on your computer.

TIP

TIP

1. Log on as an administrative user.

2. From the Start menu, select [Control Panel] > [Hardware and Sound] > [Power Options].

The Power Options window appears.

3. Select [High performance] under Preferred plans, click [Change plan settings] to the right

of it.
The Edit Plan Settings window appears.

If High performance does not appear under Preferred plan, click [Show additional plans]. Select [High per-
formance] and then click [Change plan settings] to the right of it.

4. Click [Change advanced power settings].

The Power Options dialog box appears, showing the advanced settings.

Depending on the computer configuration, the items of unavailable functions will not be displayed in the step

results hereafter.

5. Under Hard disk, set the setting for Turn off hard disk after to [Never].

Advanced settings

= Select the power plan that you want to customize, and
\@ then choose settings that reflect how you want your
computer to manage power.

'@ Change settings that are currently unavailable

lPower saver -

= Power saver
= Require a password on wakeup
Setting: Ves
= Hard disk
= Turn off hard disk after
Setting (Minutes): =
Desktop background settings
Wireless Adapter Settings
Sleep
LISR =ettinns

BH BB

H

m

[ Restore plan defaults

0K [ Cancel |[ sony

Figure B3.2.1-2 Power Options Advanced Settings

6. Configure the Sleep settings as follows:

IM 32Q01C50-31E

4th Edition : Jan.30,2015-00



<B3.2 Setting Up Windows>

B3-10

* [Sleep after]: Never
* [Allow hybrid sleep]: Off
+ [Hibernate after]: Never

* [Allow wake timers]: Disable

Advanced settings

then choose settings that reflect how you want your

\@ Select the power plan that you want to customize, and
computer to manage power,

'ﬁ' Change settings that are currently unavailable

[ High performance [Active] =

=) Sleep -
= Sleep after
Setting: Never
i = Allow hybrid sleep
Setting: Off
= Hibernate after

[ = Allow wake timers
Setting: Disable
w1 _LISR =ettinns

Setting: Never e

| Restore plan defauits

)

! T =

)

Figure B3.2.1-3 Power Options Advanced Settings

7. Set the setting for Power button action under Power buttons and lid to [Shut down].

Advanced settings

e Select the power plan that you want to customize, and
\@ then choose settings that reflect how you want your
computer to manage power,

'ﬁ' Change settings that are currently unavailable

[ High performance [Active] =

Wireless Adapter Settings -
USE settings

i = Power buttons and lid -
= Power button action

)

I Setting: Shut down -
PCI Express
[ Processor power management
Display Il
m_Multimedia settinns !
I
| Restoreplan defaults |
I ok [ Concel [[ tomy

Figure B3.2.1-4 Power Options Advanced Settings

8. Under Display, set the setting for Turn off display after to [Never].
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Advanced settings

= Select the power plan that you want to customize, and
\@ then choose settings that reflect how you want your
computer to manage power.

'@' Change settings that are currently unavailable

’High perfermance [Active] -

Wireless Adapter Settings »
Sleep i
USB settings

Power buttons and lid L
PCI Express

Processor power management
Display

m

-
OEEBHEBBE

[l = Turn off display after
Setting (Minutes):

Multimedia settinns

H

[ Restore plan defaults ]

ok J[ Camcel J[ oo |

Figure B3.2.1-5 Power Options Advanced Settings

9. Click [OK].

TIP

Configure UPS service settings after installing the ProSafe-RS software.

SEE

ALso For more information about setting up UPS services, refer to:

B3.9, “Configuring the Uninterruptible Power Supply (UPS) Service” on page B3-83

B Windows Defender

The Windows Defender software detects and removes spy ware.
It is recommended to turn off this function because it is not used in ProSafe-RS.

In a domain environment, turn off Windows Defender on domain member PCs at a time by
means of a domain management operation such as Group Policies.

In a workgroup environment, turn off Windows Defender by using either of the following pro-
cedures.

*  Turning Off Windows Defender in Control Panel

*  Turning Off Windows Defender in Local Group Policy Editor

TIP

If Tools of Windows Defender is grayed out, turn off Windows Defender in Local Group Policy Editor.

® Turning Off Windows Defender in Control Panel
1. Log on as an administrative user.
2. From the Start menu, select [Control Panel].

Select [Large icons] or [Small icons] for the display style, and then select [Windows De-
fender].
The Windows Defender window appears.
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4. Click [Tools] displayed at the top.
The Tools and Settings window appears.

5. Click [Options].
The Options window appears.

6. From the menu on the left, select [Administrator] and clear the check box for [Use this
program.

B Wirriows Deferdes e

&y Home I__""' Seam = 3 Hotory Q Tech |'§-:l -

Protection agarit igswise and petenlisly wirwasted ioftmine

f"_ Options

Ainemalic scanning o
Delsil sctior e this program

Fesah-Timve: poobecion When the eetting = an, thie program will aleek all v f ipywam or cthar potantio by
Enghyced 1l snd fabers urrwanied dofteare afermets ke runor nstall tsel on tha cempeter.
Lﬂl'"!d;'tﬁvﬂ [ésplay tems fram all users of this com peter
chu e
HEr Wihen the sething s an, this program will slcw yoesio see the History, Glewed fems, and

Quarsréined fermefrom ol e, Bama e hidden by defasl b2 protect uer pravasy:

Figure B3.2.1-6 Options

7. Click [Save].
A dialog box appears, informing that Windows Defender is turned off.

8. Click the [x] button.

® Turning Off Windows Defender in Local Group Policy Editor

If Tools of Windows Defender is grayed out, you can turn off Windows Defender in Local
Group Policy Editor.

Follow these steps to turn off Windows Defender:
1. Log on as an administrative user.

2. Click the Start button of Windows, and enter gpedit .msc in the Program and file search
box.
The Local Group Policy Editor window appears.

3. Select [Computer Configuration] > [Administrative Templates] > [Windows Components] >
[Windows Defender], and double-click [Turn off Windows Defender] in the right pane.
The Turn off Windows Defender dialog box appears.

4. Select [Enabled] and click [OK].
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EE] Tumn off Windows Defender [ Brevicus Settng | | mest Setting | |
|
Mot Canfigured Comment = ;
{
0 Desabsled
Supperted oy juast Windews Vista
H
i
! Oiptions: Help:
il |
i T off Windows Defendar Real-Tirme Pretection, and no mmore | =
I scans are scheduled,
f ¥ you enable this policy setting. Windows Defendar does not run,
[} and campubers vill net be scanned for Spyveane or olbhes
o potertially urmwanted softeare.
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i ¥ you disable or do not condigure this policy setting, by default
Windowes Defender runs and computers are scanmed for spyware
i and ather potentialy unwanted software.
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H
i
g
T T
e e e e ————— ==

Figure B3.2.1-7 Turn Off Windows Defender Dialog Box

B Disk Defragmenter

Disk Defragmenter Tool can be used to reorganize the fragmented files on computer hard disk
so as to improve the computer performance. With the default setting of Windows 7, the Disk
Defragmenter Tool is scheduled to start periodically at 1:00 on Wednesday. Because the per-
formance of ProSafe-RS may be affected significantly, it is recommended to disable the peri-
odic disk defragmentation.

Moreover, you may manually start the disk defragmenter when you feel the disk performance
is getting worse or when you perform system maintenance.

1. Log on as an administrative user.

2. From the Start menu, select [All Programs] > [Accessories] > [System Tools] > [Disk De-
fragmenter].
The Disk Defragmenter window appears.

3. Click [Configure schedule...].
The Modify Schedule dialog box appears.

4. Clear the [Run on a schedule (recommended)] check box and click [OK].

IM 32Q01C50-31E 4th Edition : Jan.30,2015-00



<B3.2 Setting Up Windows> B3-14

- —
Disk Defragmenter: Modify Schedule i u

B
3 Disk defragmenter schedule configuration:

[T} Run on a schedule {recommended};

Frequency: :Fygek[}:_ V_i
Day: E.\f‘.'ednesda}f v
Time: [1:00 AM -]
Disks: Select disks... ]

ok || cancel |

Figure B3.2.1-8 Modify Schedule Dialog Box
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B3.2.2

Configuring on Windows Vista

Follow these procedures when you use a Windows Vista computer.

B File System

Ensure that the file system is in the NTFS format. If it is already formatted in the FAT format,
reinstall the operating system and reformat partitions into NTFS. Partitions not installed with

OS should also be formatted into NTFS.

B System Performance

Follow these steps to configure the system performance setting:

1. Log on as an administrative user.
2.
[Advanced system settings].
The System Properties dialog box appears.
3.
The Performance Options dialog box appears.
4,
er].

From the Start menu, select [Control Panel] > [System and Maintenance] > [System] >

Select the [Advanced] tab, and click [Settings] in the Performance section.

Click the [Visual Effects] tab and select [Let Windows choose what’s best for my comput-

Visual Effects | Advanced I Data Execution Prevention

Select the settings you want to use for the appearance and
performance of Windows on this computer,

@ iet Windows choose what's best for my computer:
() Adjust for best appearance

(©) Adjust for best performance

() Custom:

Animate controls and elements inside windows
Animate windows when minimizing and maximizing
Animations in the taskbar and Start Menu
Enable Aero Peek

Enable desktop composition

Enable transparent glass

Fade or slide menus into view

Fade or slide ToolTips into view

Fade out menu items after didking

] save taskbar thumbnail previews

Show shadows under mouse pointer

Show shadows under windows

Show thumbnails instead of icons

Show translucent selection rectangle

Show window contents while dragging

Slide open combo boxes

Smooth edges of screen fonts

Smooth-scroll list boxes

| »

m

[ ok || cancel |

Figure B3.2.2-1 Performance Options Dialog Box (Visual Effects Tab)

5. Click [OK].
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B Virtual Memory

ProSafe-RS does not require virtual memory configuration. However, if the ProSafe-RS and
CENTUM VP software coexist on the same computer, virtual memory should be configured
according to the instruction of CENTUM VP.

B Power Options

This section describes how to configure the Power Options settings. Some of the items in the
explanation may not be displayed on your computer, depending on the computer's hardware
configuration. If not displayed, the function of that item is not available on your computer.

1.

2.

Advanced settings

Log on as an administrative user.

From the Start menu, select [Control Panel] > [Hardware and Sound] > [Power Options].

The Power Options window appears.

Select [High performance] under Preferred plans, and click [Change plan settings] below

it.
The Edit Plan Settings window appears.

Click [Change advanced power settings].

The Power Options dialog box appears, showing the advanced settings.

Under Hard disk, set the setting for Turn off hard disk after to [Never].

Select the power plan that you want to customize, and
then choose settings that reflect how you want your

Q computer to manage power.

@ Change settings that are currently unavailable

’ High performance [Active] -

L3

= Hard disk

= Turn off hard dizk after
Setting: MNever

Wireless Adapter Settings

Sleep

USE settings

Power buttons and lid

PCI Express

Processor nower mananoement

BHEH
m

(]

H B

[ Restore plan defaults

Figure B3.2.2-2 Advanced Settings in Power Options Dialog Box (Hard Disk Setting)

6

. Configure the Sleep settings as follows:

* [Sleep after]: Never
* [Allow hybrid sleep]: Off

* [Hibernate after]: Never

IM 32Q01C50-31E

4th Edition : Jan.30,2015-00



<B3.2 Setting Up Windows>

B3-17

Advanced settings

a Select the power plan that you want to customize, and
\@ then choose settings that reflect how you want your
computer to manage power,

@ Change settings that are currently unavailable

l High perfn_lnwan;e [Active] "

Hard disk -
Wireless Adapter Settings —
B Sleep
= Sleep after
Setting: Mever
= Allow hybrid sleep
Setting: Off
= Hibernate after
Setting: Mever
&l LISE cettinos

[ Restore plan defaults ]

ok ] [ Concel ][ oob ||

Figure B3.2.2-3 Advanced Settings in Power Options Dialog Box (Sleep Setting)

7. Configure the Power button and lid settings as follows:

* [Power button action]: Shut down

« [Start menu power button]: Shut down

Advanced settings

\E-:I Select the power plan that you want to customize, and

then choose settings that reflect how you want your
computer to manage power,

@ Change settings that are currently unavailable

[High_ perfo_lmanc_e [Active] s

Allow hybrid sleep -
Hibernate after
USBE settings
= Power buttons and lid
=l Power button action
Setting: Shut down
= Start menu power button
Setting: Shut down
PCI Express

Procecenr nower mananement

m

[ Restore plan defaults

Figure B3.2.2-4 Advanced Settings in Power Options Dialog Box (Power Button and LID Settings)

8. Under Display, set the setting for Turn off display after to [Never].
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Figure B3.2.2-5 Advanced Settings in Power Options Dialog Box (Display Setting)

Advanced settings

then choose settings that reflect how you want your
computer to manage power,

\[": _'I Select the power plan that you want to customize, and

@ Change settings that are currently unavailable

l High perfolnwan;e [Active] -

H B

o e H

USE settings -~

Power buttons and lid

PCI Express

Processor power management

Search and Indexing

Display

= Turn off display after
Setting: MNever

Adaptive display

Multimedia settinns

m

[ Restore plan defaults

etk [t [ b

9. Click [OK].

TIP

Configure UPS service settings after installing the ProSafe-RS software.

SEE

ALso For more information about setting up UPS services, refer to:

B3.9, “Configuring the Uninterruptible Power Supply (UPS) Service” on page B3-83

B Windows Defender

The Windows Defender software detects and removes spy ware.
It is recommended to turn off this function because it is not used in ProSafe-RS.

In a domain environment, turn off Windows Defender on domain member computers at a time

by means of a domain management operation such as Group Policies.

In a workgroup environment, turn off Windows Defender by using either of the following pro-
cedures.

Turning Off Windows Defender in Control Panel

Turning Off Windows Defender in Local Group Policy Editor

TIP

If Tools of Windows Defender is grayed out, turn off Windows Defender in Local Group Policy Editor.

® Turning Off Windows Defender in Control Panel
1.
2.

Log on as an administrative user.

From the Start menu, select [Control Panel] > [Security] > [Windows Defender].

The Windows Defender window appears.

Click [Tools] displayed at the top.
The Tools and Settings window appears.
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4. Click [Options].
The Options window appears.

When Windows Defender is on, all users are alerted if spyware or other potentially unwanted
software attempts to run or install itself on the computer. Windows Defender will check for new
definitions, regularly scan the computer, and automatically remove harmful software detected by
a scan.
[¥] Allow everyone to use Windows Defender
Allow users who do not have administrative rights to scan the computer, choose actions to
apply to potentially unwanted software, and review all Windaows Defender activities.

[ W save “ Cancel ]

Figure B3.2.2-6 Options
5. Clear the check box for [Use Windows Defender], and click [Save].
A confirmation dialog box appears.

6. Click [Close].

Turning Off Windows Defender in Local Group Policy Editor

If Tools of Windows Defender is grayed out, you can turn off Windows Defender in Local
Group Policy Editor.

Follow these steps to turn off Windows Defender:
1. Log on as an administrative user.

2. Click the Start button of Windows, and enter gpedit .msc in the Program and file search
box.
The Local Group Policy Editor window appears.

3. Select [Computer Configuration] > [Administrative Templates] > [Windows Components] >
[Windows Defender], and double-click [Turn off Windows Defender] in the right pane.
The Turn off Windows Defender Properties dialog box appears.

4. Select [Enabled] and click [OK].
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Turn off Windows Defender Properties

Setting | Explain

E Tum off Windows Defender

) Not Corfigured
() Disabled

Supportted on: At least Windows Vista

Previous Setting ] ’ MNext Setting

)

[ oK

| [ Coneet ]|

Apply

)

Figure B3.2.2-7 Turn off Windows Defender Properties Dialog Box

B Disk Defragmenter

Disk Defragmenter Tool can be used to reorganize the fragmented files on computer hard disk
so as to improve the computer performance. With the default setting of Windows Vista, the
Disk Defragmenter Tool is scheduled to start periodically at 1:00 on Wednesday. Because the
performance of ProSafe-RS may be affected significantly, it is recommended to disable the
periodic disk defragmentation.

Moreover, you may manually start the disk defragmenter when you feel the disk performance
is getting worse or when you perform system maintenance.

1. Logon as an administrative user.

2.  From the Start menu, select [All Programs] > [Accessories] > [System Tools] > [Disk De-

fragmenter].

The Disk Defragmenter dialog box appears.

3. Clear the [Run on a schedule (recommend)] check box and click [OK].

. Q&; Ij}sk f)éfmgmenle(

[TliRun on a schedule (recommended

ok
s Csa0

led,

@ Scheduled defragmentation is enabled
Your disks will be defragmented at the scheduled time,

= k.

1.» Disk Defragmenter consclidates fragrented files on your computer's hard disk to improve system
+ performance. How does Disk Defragmenter help?

Maodify schedule...

Defragment now ]

Figure B3.2.2-8 Disk Defragmenter Dialog Box
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B3.2.3 Configuring on Windows Server 2008 R2

Follow these procedures when you use a Windows 2008 R2 computer.

B File System

Ensure that the file system is in the NTFS format. If it is already formatted in the FAT format,
reinstall the operating system and reformat partitions into NTFS. Partitions not installed with
OS should also be formatted into NTFS.

B System Performance

Follow these steps to configure the system performance setting:
1. Log on as an administrative user.

2. From the Start menu, select [Control Panel] > [System and Security] > [System] > [Ad-
vanced system settings].
The System Properties dialog box appears.

3. Select the [Advanced] tab, and click [Settings] in the Performance section.
The Performance Options dialog box appears.

4. Select the [Visual Effects] tab and select [Adjust for best performance].

Performance Options x|

Visual Effects |Advanced | Data Execution Prevention I

Select the settings you want to use for the appearance and
performance of Windows on this computer.

™ Let Windows choose what's best for my computer

" Adjust for best appearance

& {divst for best performance!

" Custom:

[ Animate controls and elements inside windows
[ Animate windows when minimizing and maximizing
[ Animations in the taskbar and Start Menu

[ Fade or slide menus ints view

[ Fade or slide ToolTips into view

[ Fade out menu items after dicking

[0 show shadows under mouse pointer

[0 show shadows under windows

[ show translucent selection rectangle

[ show window contents while dragging

[0 slide open combe boxes

[0 smooth edges of screen fonts

[0 smooth-scroll list boxes

[ Use drop shadows for icon labels on the desktop
[ Use visual styles on windows and buttons

oK I Cancel Apply |

Figure B3.2.3-1 Performance Options Dialog Box (Visual Effects Tab)
5. Click [OK].

B Virtual Memory

ProSafe-RS does not require virtual memory configuration. However, if the ProSafe-RS and
CENTUM VP software coexist on the same computer, virtual memory should be configured
according to the instruction of CENTUM VP.
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B Power Options

This section describes how to configure the Power Options settings. Some of the items in the
explanation may not be displayed on your computer, depending on the computer's hardware
configuration. If not displayed, the function of that item is not available on your computer.

1. Log on as an administrative user.

2. From the Start menu, select [Control Panel] > [Hardware] > [Power Options].
The Power Options window appears.

3. Select [High performance] under Preferred plans, and click [Change plan settings] to the
right of it.
The Edit Plan Settings window appears.

TIP

If High performance does not appear under Preferred plan, click [Show additional plans]. Select [High per-
formance] and then click [Change plan settings] to the right of it.

4. Click [Change advanced power settings].
The Power Options dialog box appears, showing the advanced settings.

TIP Depending on the computer configuration, the items of unavailable functions will not be displayed in the step

results hereafter.

5. Under Hard disk, set the setting for Turn off hard disk after to [Never].

Advanced settings I

then choose settings that reflect how you want your

\ ['i Select the power plan that you want to customnize, and
computer to manage power.

IHigh performance [Active] j

High performance
= Hard disk
= Turn off hard disk after

|»

Setting (Minutes)

Desktop background settings
Sleep

USE settings

Power buttons and lid

PCI Express

Processor power management

Nicnla LI

Restore plan defaults |

ok | cancel | ooty |

Figure B3.2.3-2 Power Options Advanced Settings

1M EEEEE

6. Configure the Sleep settings as follows:
* [Sleep after]: Never
* [Allow hybrid sleep]: Off
* [Hibernate after]: Never

* [Allow wake timers]: Disable
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then cheose settings that reflect how you want your

\ E'i Select the power plan that you want to customnize, and
computer to manage power.

IHigh performance [Active] j

High performance -~
Hard disk
= Desktop background settings
Slide show
ep
Bl Sleep after
Setting: Newver
= Allow wake timers
Setting: Disable
USB settings
i Donrar Hlﬁfnnr=nd liel LI

B

i

Restore plan defaults |

ok | cacel | ooy |

Figure B3.2.3-3 Power Options Advanced Settings

7. Set the setting for Power button action under Power buttons and lid to [Shut down].

then choose settings that reflect how you want your

\ E'i Select the power plan that you want to customnize, and
computer to manage power.

IHigh performance [Active] j

Setting: Never ;l
= Allow wake timers
Setting: Disable
USB settings
Power buttons and lid
= Power button action
Shut down ™

o m

PCI Express
Processor power management
Display

H H B

Restore plan defaults |

ok | cancel | ooty |

Figure B3.2.3-4 Power Options Advanced Settings

8. Under Display, set the setting for Turn off display after to [Never].
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Advanced settings I

\ ['i Select the power plan that you want to customnize, and

then cheose settings that reflect how you want your
computer to manage power.

IHigh performance [Active] j

Setting: Disable ﬂ
USB settings
= Power buttons and lid
= Power button action
Setting: Shut down
PCI Express
Processor power management
Display
=l Turn off display after

[+

o & &

Setting (Minut

Restore plan defaults |

ok | cacel | ooy |

Figure B3.2.3-5 Power Options Advanced Settings

9.

Click [OK].

TIP

Configure the UPS settings after installing the ProSafe-RS software.

EE . . . ,
ALso For more information about setting up UPS services, refer to:

B3.9, “Configuring the Uninterruptible Power Supply (UPS) Service” on page B3-83

B Password Setting

Because security is enhanced in Windows Server 2008 R2, complexity may be required when
you set a user password or you may not be able to set a password as intended.

In this case, do the following:

1.
2.

Log on as an administrative user.

From the Start menu, click [Administrative Tools] > [Local Security Policy].
The Local security policy window appears.

In the left pane, select [Security Settings] > [Account Policies] > [Password Policy].
A list of policies is displayed.

In the right pane, double-click [Password must meet complexity requirements].
The properties dialog box for the policy Password must meet complexity requirements ap-
pears.

Select [Disabled] and click [OK].

Confirm that Disabled is indicated for the policy Password must meet complexity require-
ments.
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E. Local Security Policy = -0 I
File  Action” Miew Help

e el alle . 200 B

3} Security Settings Palicy =~ | Security Setting
El ['& Account Polides |is] Enforce passward history 0 passwords remem. ..
5 Password Policy 14| Maximum password age 42 days
A Account Lackout Palicy lzie] Minimum password age 0 days
ocal Polices Lo} Minimum password length 0 characters

[ Windows Firewall viith Advanced Security
1 Network List Manager Policies

__| Public ey Policies

[__] Software Restriction Polices

g IP Security Policies on Local Computer

lzie] Password must meet complexity r..  Enabled
lele| Store passwords using reversible ... Disabled

| | ¥

Figure B3.2.3-6 Local Security Policy Window

B Enabling .NET Framework 3.5.1

If you are using Windows Server 2008 R2, you must enable .NET Framework 3.5.1 as it is
disabled by default. Follow these steps to enable .NET Framework 3.5.1:

TIP

.NET Framework 3.0 is also enabled by the same procedure. In this case, you can follow the same procedure
to enable .NET Framework 3.0.

1. Log on as an administrative user.

2. From the Start menu, select [Administrative Tools] > [Server Manager].
The Server Manager window appears.

3. Inthe left pane, select [Features] and select [Add Features] in the right pane.
The Add Features Wizard appears.

4. Select the [.[NET Framework 3.5.1] check box under .NET Framework 3.5.1 Features,
and click [Next].

Confirm that the correct feature has been selected for installation and click [Install].

Confirm that the installation is completed, and click [Close].
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5 Installation Results

| wredows autometic updating is ok enatled, To ensure that vour nevhyinstaled rols or festure is
subomebically updsbed, bum on Windows Updats in Conbrol Parel,

@}JEIFMS.H Fealures @ Installation succesded
Troe: Fobowing features wene installed:
JMET Framesrork 3.5.1

Figure B3.2.3-7 Installation Results
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B3.2.4 Configuring on Windows Server 2008

Follow these procedures when you use a Windows 2008 computer.

B File System

Ensure that the file system is in the NTFS format. If it is already formatted in the FAT format,
reinstall the operating system and reformat partitions into NTFS. Partitions not installed with
OS should also be formatted into NTFS.

B System Performance

Follow these steps to configure the system performance setting:
1. Log on as an administrative user.

2. From the Start menu, select [Control Panel] > [System and Maintenance] > [System] >
[Advanced system settings].
The System Properties dialog box appears.

3. Select the [Advanced] tab, and click [Settings] in the Performance section.
The Performance Options dialog box appears.

4. Select the [Visual Effects] tab and select [Adjust for best performance].

Performance Options x|

Visual Effects |Advanced | Data Execution Prevention I

Select the settings you want to use for the appearance and
performance of Windows on this computer.

™ Let Windows choose what's best for my computer

" Adjust for best appearance

& {divst for best performance!

" Custom:

[ Animate controls and elements inside windows
[ Animate windows when minimizing and maximizing
[ Animations in the taskbar and Start Menu

[ Fade or slide menus ints view

[ Fade or slide ToolTips into view

[ Fade out menu items after dicking

[0 show shadows under mouse pointer

[0 show shadows under windows

[ show translucent selection rectangle

[ show window contents while dragging

[0 slide open combe boxes

[0 smooth edges of screen fonts

[0 smooth-scroll list boxes

[ Use drop shadows for icon labels on the desktop
[ Use visual styles on windows and buttons

oK I Cancel Apply |

Figure B3.2.4-1 Performance Options Dialog Box (Visual Effects Tab)
5. Click [OK].

B Virtual Memory

ProSafe-RS does not require virtual memory configuration. However, if the ProSafe-RS and
CENTUM VP software coexist on the same computer, virtual memory should be configured
according to the instruction of CENTUM VP.
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B Power Options

This section describes how to configure the Power Options settings. Some of the items in the
explanation may not be displayed on your computer, depending on the computer's hardware
configuration. If not displayed, the function of that item is not available on your computer.

1. Log on as an administrative user.

2. From the Start menu, select [Control Panel] > [Hardware and Sound] > [Power Options].
The Power Options window appears.

3. Select [High performance] under Preferred plans, and click [Change plan settings] below
it.
The Edit Plan Settings window appears.

4. Click [Change advanced power settings].
The Power Options dialog box appears, showing the advanced settings.

TIP

Depending on the computer configuration, the items of unavailable functions will not be displayed in the step
results hereafter.

5. Under Hard disk, set the setting for Turn off hard disk after to [Never].
Advanced settings I

= Select the power plan that you want to customnize, and
\@ then choose settings that reflect how you want your
computer to manage power.

IHigh performance [Active] j

= Additional settings
[l Require a password on wakeup
Setting: Yes
= Hard disk
= Turn off hard disk after

IE

Setting (Minutes]

[+

Sleep

USB settings

Power buttons and lid
PCI Express

-
Dramarcar masiar maanansssent J

F &

eS|

Restore plan defaults |

oK | Caneel | mopy |

Figure B3.2.4-2 Power Options Advanced Settings

6. Configure the Sleep settings as follows:
* [Sleep after]: Never
* [Allow hybrid sleep]: Off

* [Hibernate after]: Never
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then cheose settings that reflect how you want your

\ E'i Select the power plan that you want to customnize, and
computer to manage power.

IHigh performance [Active] j

=l Turn off hard disk after ﬂ
Setting: Never

Bl Sleep after
Setting: Newver
USB settings
Power buttons and lid
PCI Express
Processor power management
Display

[+

F &

F &

Restore plan defaults |

ok | cacel | ooy |

Figure B3.2.4-3 Power Options Advanced Settings

7. Configure the Power button and lid settings as follows:
* [Power button action]: Shut down

* [Start menu power button]: Shut down

« Select the power plan that you want to customnize, and
\@ then cheose settings that reflect how you want your
computer to manage power.

IHigh performance [Active] j

Setting: Newver ﬂ
B Sleep
Bl Sleep after

Setting: Never
USB settings
Power buttons and lid

o &

Setting: Shut down
E Start menu power button
Setting: Shut down

1 DT Fynraes LI

Restore plan defaults |

ok | cacel | ooy |

Figure B3.2.4-4 Power Options Advanced Settings

8. Under Display, set the setting for Turn off display after to [Never].
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-f* Power Options e |
Advanced settings I
\ ['i Select the power plan that you want to customnize, and

then cheose settings that reflect how you want your
computer to manage power.

IHigh performance [Active] j

Setting: Shut down ﬂ
El Start menu power button
Setting: Shut down
PCI Express
Processor power management
= Display
=l Turn off display after

Setting (Minut

1 Adaptive display
Setting: Off

Restore plan defaults |

ok | cacel | ooy |

Figure B3.2.4-5 Power Options Advanced Settings

9. Click [OK].

TIP Configure the UPS settings after installing the ProSafe-RS software.

EE . . . ,
ALso For more information about setting up UPS services, refer to:

B3.9, “Configuring the Uninterruptible Power Supply (UPS) Service” on page B3-83

B Password Setting

Because security is enhanced in Windows Server 2008, complexity may be required when
you set a user password or you may not be able to set a password as intended.

In this case, do the following:
1. Log on as an administrative user.

2. From the Start menu, click [Administrative Tools] > [Local Security Policy].
The Local security policy window appears.

3. Inthe left pane, select [Security Settings] > [Account Policies] > [Password Policy].
A list of policies is displayed.

4. In the right pane, double-click [Password must meet complexity requirements].
The properties dialog box for the policy Password must meet complexity requirements ap-
pears.

5. Select [Disabled] and click [OK].

6. Confirm that Disabled is indicated for the policy Password must meet complexity require-
ments.
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i Local Security Policy

Bile  Action View Help

=101x|

€= | HEXE (= | H

i Security Settings

Policy =~
Bl [[4 Account Policies

| Security Setting

liis] Enforce password history
liio] Mandmum password age
[51e) Minimum password age
[51o] Minimum password length
d must om|

|4 Password Policy

["& Account Lockout Policy
["& Local Policies
(] Windows Firewall with Advanced Security

5] Metwork List Manager Polides

(] Public Key Polides
[ ] software Restriction Policies
lg IP Security Policies on Local Computer

4] |

ltio) Store passwords using reversible ...

0 passwords remem...

42 days
0 days
0 characters

ec
Disabled

Figure B3.2.4-6 Local Security Policy Window
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B3.3 Configuring Network Settings

To use the control bus, you need to install the control bus driver. If Vnet/IP is used as the con-
trol bus, you need to install the Vnet/IP open communication driver as well.

This section describes how to install the control bus driver and the Vnet/IP open communica-
tion driver.

If you use the built-in Ethernet interface of the computer or an over-the-counter Ethernet card,
read the attached instruction manual and install the proper Ethernet driver accordingly.
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B3.3.1

Installing the Control Bus Driver

This section describes the procedure for installing the control bus driver on Windows 7 as an
instance.

B Precautions at Installation

TIP

Mount a control bus interface card or Vnet/IP interface card in computers to be connected on
a control bus network. In addition, you must install the control bus driver. Observe the follow-
ing precautions when you install the control bus driver.

Before installing the control bus driver, be sure to install a control bus interface card or
Vnet/IP interface card in the computer.

If you installed the control bus driver without installing a control bus interface card or
Vnet/IP interface card by mistake, uninstall the control bus driver. Then, install a control
bus interface card and install the driver again.

If you want to change the slot in which a control bus interface card or Vnet/IP interface
card is installed, uninstall the control bus driver first and then change the slot. After
changing the slot, install the driver again.

When you remove a control bus interface card or Vnet/IP interface card from the comput-
er where the control bus driver was installed with the card installed, uninstall the driver
before you remove the card from the slot.

When installing the control bus driver, restarting the computer is basically not required. However, restart
the computer if a dialog box indicating completion of the installation (restarting required) is displayed.

After you install the driver, you need to configure network settings.

B Notes on Using SCS Simulator

To use the SCS simulator, an environment where ProSafe-RS is integrated with CENTUM is
mandatory. You can run the SCS simulator even on a computer where a control bus interface
card or Vnet/IP interface is not mounted; however, you must always install the control bus
driver on such computers. Observe the following precautions when you install the control bus
driver on a computer where these cards are not mounted in order to use the SCS simulator.

TIP

Install the control bus driver, and then configure Windows network settings.

If you use the expanded test functions to run SCS simulators on multiple computers, in-
stall the control bus driver in all the computers on which you run the SCS simulator with-
out mounting a control bus card. If mounted, you cannot launch the SCS simulator re-
motely.

If a control bus card is not mounted when you install the control bus driver, a control bus driver of the
version for use without a control bus card is installed. This driver is used when the SCS simulator is run
without mounting a control bus card.

To reuse or divert a computer installed with a without-a-control-bus-card version of control bus driver for
use in actual plant operation, uninstall the control bus driver, mount a control bus card, and then install
the control bus driver again.

The control bus driver should be installed according to the procedure for installing the
control bus driver.

For the IP address for the control bus driver on each computer, set the address of control
bus, “domain number (dd) .station number (ss)”.
Example: 172.16.dd.ss

Note that dd.ss must not overlap with the addresses of the other stations. In particular, it
must not overlap with the “domain number.station number” used for SCS and FCS.
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B Installation Procedure

TIP

TIP

Log on as an administrative user.
Insert the ProSafe-RS software medium into the drive.
+ If the AutoPlay dialog box appears, click [Run Launcher.exe].

» If the AutoPlay dialog box does not appear, use Explorer and double-click Launch-
er.exe in the top folder of the ProSafe-RS software medium.

The installation menu appears.

On the installation menu, click [Control Bus Driver].
A dialog box appears, prompting you to confirm the setup.

Select [INSTALL] and click [OK].
A dialog box appears, confirming to execute the installation.

Click [OK].
A Windows Security dialog box appears, confirming installation of network protocol.

Make sure that the [Always trust software from “Yokogawa Electric Corporation”] check
box is clear and click [Install].

Another Windows Security dialog box appears, confirming installation of the network
adapter.

Make sure that the [Always trust software from “Yokogawa Electric Corporation”] check
box is clear and click [Install].

Do not click [Don'’t Install] on the Windows Security dialog boxes. If clicked, an error occurs.

Do not select the [Always trust software from “Yokogawa Electric Corporation”] check box. If selected, a
confirmation dialog box will not appear during the subsequent installations.

8.

When the message telling successful installation is displayed, click [OK].

If you have added or deleted any other devices before you install the control bus driver, a message prompting
you to restart the computer may be displayed. In such a case, be sure to restart the computer.
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B3.3.2

Installing the Vnet/IP Open Communication Driver

When Vnet/IP is used as the control bus, the Vnet/IP open communication driver also needs
to be installed. If Ethernet is also used, the installed Vnet/IP open communication driver must
be disabled.

This section describes the procedure for installing the Vnet/IP open communication driver on
Windows 7 as an instance.

ﬂ IMPORTANT

When the Vnet/IP interface card is mounted, always install the Vnet/IP open communication
driver even if Vnet/IP open communication is not used.

B Precautions at Installation

TIP

Before installing the Vnet/IP open communication driver, be sure to install a Vnet/IP inter-
face card in the computer. You cannot install the driver if the card is not installed.

If you want to change the slot in which a Vnet/IP interface card is mounted, uninstall the
Vnet/IP open communication driver and control bus driver and then change the slot. After
changing the slot, install the drivers again.

When removing a Vnet/IP interface card from a computer after the Vnet/IP open commu-
nication driver is installed, uninstall the driver before you remove the card from the slot.

When installing the Vnet/IP open communication driver, restarting the computer is basically not required.
However, restart the computer if a dialog box indicating completion of the installation (restarting re-
quired) is displayed.

When Ethernet is also used, configure network settings after you install the Vnet/IP open communication
driver and disable the driver.

When Ethernet is not used, configure network settings after you install the Vnet/IP open communication
driver.

B Installation Procedure

Log on as an administrative user.
Insert the ProSafe-RS software medium into the drive.
» If the AutoPlay dialog box appears, click [Run Launcher.exe].

+ If the AutoPlay dialog box does not appear, use Explorer and double-click Launch-
er.exe in the top folder of the ProSafe-RS software medium.

The installation menu appears.

On the installation menu, click the [Vnet/IP Open com driver].
A dialog box appears, prompting you to confirm the setup.

Select [INSTALL] and click [OK].
A dialog box appears, confirming to execute the installation.

Click [OK].
A Windows Security dialog box appears.

Make sure that the [Always trust software from “Yokogawa Electric Corporation”] check
box is clear and click [Install].
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TIP

* Do not click [Don’t Install] on the Windows Security dialog box. If clicked, an error occurs.

* Do not select the [Always trust software from “Yokogawa Electric Corporation”] check box. If selected, a
confirmation dialog box will not appear during the subsequent installations.

7. When the message telling successful installation is displayed, click [OK].

TIP

If you have added or deleted any other devices before you install the Vnet/IP open communication driver, a
message prompting you to restart the computer may be displayed. In such a case, be sure to restart the com-
puter.
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B3.3.3 Configuring Windows Network Settings

You must configure the Windows network settings after installing the network driver.

This section explains the procedures for configuring Windows network settings related to con-
trol bus, Vnet/IP open communication, and Ethernet, assuming settings are made on Win-
dows 7/Windows Server 2008 R2. Information of other OS versions is provided as necessary
as TIP.

B Cautions on Cable Wiring

ALSO

When the cable is wired for network connection, the Set Network Location dialog box may ap-
pear.

For more information about the Set Network Location dialog box, refer to:

C9.2.1, “Precaution on Network Cable Connection” on page C9-4

B Checking the Network Interface Card

TIP

Check the network interface card installed in the computer.

When a Control Bus Interface Card is Installed

In a system using V net, a control bus interface card is installed in computers. In this case,
configure Windows network settings for control bus communications and Ethernet communi-
cations.

When a Vnet/IP Interface Card is Installed

In a system using Vnet/IP, a Vnet/IP interface card is installed in computers.

In this case, a combination of either control bus communications and Ethernet communica-
tions or control bus communications and Vnet/IP open communications is used. Configure the
Windows network settings according to the network configuration of the system.

The Vnet/IP open communication refers to Ethernet communication performed on bus 2 of Vnet/IP.

In a system using Vnet/IP open communications, bus 1 is normally used for control bus communications and
bus 2 is used for Ethernet communications. If bus 1 fails, bus 2 is used for both control bus communications
and Ethernet communications.

B Vnet/IP Network Configurations and Windows Network Settings

Vnet/IP network configurations and their required Windows network settings are describes as
follows.
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Ethernet
(Ethernet communication)
172.17.1.64 172.17.1.63 172.17.1.62
LE] LE] LE]
Computer 1 Computer 2 Computer 3
[ ] [P ]
192.168.1.128 192.168.1.126
Vnet/IP

Bus 1 (Control communication)

192.168.129.126 L
Bus 2 (Control communication)

192.168.129.128

E: Ethernet Interface Card or Onboard NIC
IP: Vnet/IP Interface Card

Figure B3.3.3-1 Network Configuration and Interface (Vnet/IP and Ethernet are Installed)

Computer 1 Computer 2 Computer 3

1P 1P P

192.168.1.128

192.168.1.126

192.168.1.124

192.168.129.128

192.168.129.126

192.168.129.124

Vnet/IP
Bus 1 (Control communication)
Bus 2 (Vnet/IP open communication)

IP: Vnet/IP Interface Card

Figure B3.3.3-2 Network Configuration and Interface (Only Vnet/IP is Installed)

Table B3.3.3-1 Network Configurations and Network Connections to be Set Up on Windows

Network connection to be set up on

Network Configuration |Computer (Example in the figures) Windows

Connected to Vnet/IP and Ethernet | Control bus, Ethernet, and Vnet/IP open
(Computers 1 and 2) communications(*1)

Vnet/IP + Ethernet
Connected to Ethernet only (Com-

puter 3)

Connected to Vnet/IP (Ethernet
communication on bus 2) (Comput-
ers 1to 3)

Ethernet communications

Control bus, Ethernet, and Vnet/IP open

Vnet/IP only communications(*2)

*1:  After installing the Vnet/IP open communication driver, you need to disable the corresponding device.
*2: You need to disable the Ethernet device.

SEE

ALso For more information about network construction when using Vnet/IP open communication, refer to:

Vnet/IP Network Construction Guide (Legacy Edition) (T1 30A10A10-01E)

B Cautions on Using Vnet/IP

On the computers connected on Vnet/IP, you need to disable the unused devices according to
the network configuration.
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® When Vnet/IP and Ethernet are Installed

A\

TIP

IMPORTANT

In a system where both Vnet/IP and Ethernet are Installed, Vnet/IP open communications are
not used. Even in this case, you need to install the Vnet/IP open communication driver and
disable the driver on computers installed with a Vnet/IP interface card.

172.16.1.62

= =g
E |

Ethernet

Vnet/IP

Vnet/IP

Disable Vnet/IP open communication

Figure B3.3.3-3 Vnet/IP and Ethernet are Installed

On a computer installed with a Vnet/IP interface card, follow these steps to disable the
Vnet/IP Open communication driver:

1. Log on as an administrative user.

2. From the Start menu, select [Control Panel] > [System and Security] > [Device Manager].

In Windows Vista and Windows Server 2008 environment, select [Control Panel] > [System and Maintenance]

> [System] > [Device Manager].

3. On Device Manager, unfold Network adapters.
4. Select [Vnet/IP Open Communication Driver (BUS2)] and then click the Disable button on

the toolbar.
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File Action View Help

== HH= LA 1) ' Disable button

a 2 HIS0464
5«;@ Computer
> = Disk drives
o.ﬂ Display adaptzrs
b -5 DVD/CD-ROM drives
b 4 Floppy disk drives
b kﬁ Floppy drive controllers
;.> Etﬁ Human Interface Devices
b £ IDE ATAVATA controllers
[ &= Keyboards
bﬂ Mice and other pointing devices
;l-l; Monitors
a Network adapters
: Broadcom Metktreme 5T Gigabit Controller
| ¥ Yokogawa Vnet Adapter
- | Portable Devices
b T3 Ports (COM & LPT)
JB Processars
..3 -Pu Sound, video and game controllers
& /M System devices

B i Universal Serial Bus controllers

Figure B3.3.3-4 Disabling the Vnet/IP Open Communication Device

® When Only Vnet/IP is Installed

Disable Ethernet

Vnet/IP
Vnet/IP

Figure B3.3.3-5 Only Vnet/IP is Installed

On a computer in a system where only Vnet/IP is installed, follow these steps to disable the
Ethernet device:

1. Log on as an administrative user.

2. From the Start menu, select [Control Panel] > [System and Security] > [Device Manager].

TIP

In Windows Vista and Windows Server 2008 environment, select [Control Panel] > [System and Maintenance]
> [System] > [Device Manager].

3. On Device Manager, unfold Network adapters.

4. Select the Ethernet device and then click the Disable button on the toolbar.

B Prohibitions
Do not use the following features in ProSafe-RS.
* Internet Connection Sharing (ICS)

* Bridge Connection
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TIP

*  Homegroup

Internet Connection Sharing (ICS)

Do not select the [Allow other network users to connect through this computer’s Internet con-
nection] check box on the Sharing tab in the properties dialog box for V net, VnetlPOpen, or
Ethernet (these connection names are set in the procedures described later).

" —
Ln'] Vnet Properties M
Shating

Intemet Connection Sharing

[]#llow other network users to connect through th|s
‘computer’s Intemet connection ;

Allow other network users to control or disable the
shared Intemet connection

Using ICS {Intemet Connection Sharing) Seffings...

[ ok || canca |

Figure B3.3.3-6 Vnet Properties (Default Setting)

Internet Connection Sharing (ICS) is for sharing the internet connection by the computers in a small scale
office network or home network.

Bridge Connection

Do not use bridge connection. If bridge connection is created in the computer, not only the
control bus communication of the computer becomes abnormal, but also the communication
of the whole control bus network may be jeopardized. (If the bridge connection is already cre-
ated, you need to delete the bridge connection.)

Orgaane » Disable this network device Diagnose this connection »

= | Ethernet || Vnet
&g_ Enabled, Bridged ™ _ Enabled, Bridged

Broadcom NetXtreme 57xx¢ Gigabi... E- 4 Yokogawa Vnet Adapter

Metwork Bridge
—| Metwork cable unplugged
= MAC Bridge Miniport

Figure B3.3.3-7 Example of Prohibited Network Setting (Bridge Connection is Enabled)
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® Homegroup (Windows 7 Only)

In a ProSafe-RS system, folders and printers are shared using the file sharing function for the
workgroup/network environment as with the earlier OS versions. Accordingly, do not select
[Home Network] in the network location setting.

B Procedure 1: Rename Local Area Connections

A network after the installation is named “Local Area Connection.” The network can be identi-
fied more easily if you rename the local area connection.

Rename the local area connections as necessary according to the network configuration of
the system.

1. Select [Control Panel] > [Network and Internet] > [Network and Sharing Center].
The Network and Sharing Center window appears.

2. Select [Change adapter settings].
The Network Connections window appears.

e TTTTYTEE
Search Network Connections 0O

Organize »

"E Ethernet ‘E Local Area Connection
o Network | Identifying...
@ Intel(R) 82578DM Gigabit Networ... -4 Yokogawa Vnet Adapter

Figure B3.3.3-8 Network Connections (Before Renaming)

TIP

» If you are using Windows Vista or Windows Server 2008, select [Manage network connections]

» If connections are not displayed here, the corresponding installations have failed or the drivers are not
working properly. Address the issues so that the connections are displayed here.

3. Right-click each of the Local Area Connection icons and select [Rename] to change the
name.

Table B3.3.3-2 Renaming of Network Connections

Network type Display on Netwc:jrk Connections win- Name
ow
Ethernet Ethernet driver names Ethernet
Control bus Yokogawa Vnet Adapter Vnet
Vnet/IP open communication Xangglzp) Open Communication Driver VnetIPOpen
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Organize »

- | Ethernet | Vnet
Network B Identifying...
@ Intel(R) 82578DM Gigabit Networ.., @ Vokogawa Vnet Adapter

S
G < Netw + Neork Comesions >~

| File Edit View Tools Advanced Help |
Organize =

w ™ T =L/ VnetlPOpen
Unidentified network . - Unidentified network

e Yokogawa Vnet Adapter = Vnet1P Open Communication Dr...

Figure B3.3.3-10 Network Connections — Vnet/IP Network (After Renaming)

TIP

In the instruction manuals until ProSafe-RS R2.03, it is instructed to change the name of control bus commu-
nication connection when Vnet/IP is used to “VnetIP” rather than “Vnet.”

B Procedure 2: Configure Properties

In the properties of each type of network connection, you need to configure the items to be
used.

Configure the properties as necessary according to the network configuration of the system.

Table B3.3.3-3 List of Items Used for Network Connections

ltem Network(*1)
Ethernet VnetIPOpen Vnet
Microsoft network client X X -
QoS packet scheduler X X -
Microsoft network file and printer sharing X X -
Yokogawa Vnet Protocol - - X
Internet protocol version 6 (TCP/IPv6) - - -
Internet protocol version 4 (TCP/IPv4) X X X
Link-Layer Topology Discovery Mapper I/O Driver X X -
Link-Layer Topology Discovery Responder X X -

*1: X :ltem used, - : Item not used
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TIP

Items in the table, except “Yokogawa Vnet Protocol,” are installed during the Windows OS installation.

® V net Properties

1. In the Network Connections window, right-click [Vnet] and select [Properties].

The Vnet Properties dialog box appears.

F ~
[ Vnet Properties

—— ==

Networking | Sharing

Connect using:

LF ‘Yokogawa Vnet Adapter

This connection wses the following items:

[1 o®% Client for Microsoft Networks

O =305 Packet Scheduler

O Q File and Printer Sharing for Microsoft Networks

I8 Yokogawa Unet Protocal |

[ - Intemet Protocol Version & (TCP/IPvE)

i Intemet Protocol Version 4 (TCP/IPvd)

[ - Link-Layer Topology Discovery Mapper 1/0 Driver
[ -a Link-Layer Topology Discovery Responder

[ Install .. ] [ Uninstall ] Properties
Description
Vet Protocol Driver
| OK || Cancel

Figure B3.3.3-11 Vnet Properties Dialog Box

2. Based on “Table List of Items Used for Network Connections,” select only the check box-

es for [Yokogawa Vnet Protocol] and [Internet protocol version 4 (TCP/IPv4)].

3. After the setting is complete, click [OK].

® VnetlPOpen Properties

1. In the Network Connections window, right-click [VnetlPOpen] and select [Properties].
The VnetlPOpen Properties dialog box appears.
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-
" VnetlP Properties

Networking | Sharing

i

Connect using:

| I? Yokogawa Vet Adapter

This connection uses the following items:

8 Client for Microsoft Networks

Ul 0105 Packet Scheduler

.@ File and Printer Sharing for Microsoft Networks

[ -iYokogawa Vnet Protocal

MW | t=miet Protocol Version & (TCP/IPvE)

- Intemet Protocol Version 4 (TCP/IPvd)

i Link-Layer Topology Discovery Mapper /0 Driver

& Link-Layer Topology Discovery Responder

Uninstall Properties

Description

TCP/IP version &. The latest version of the intemet protocol
that provides communication across diverse interconnected
networks.

| ok || cance |

Figure B3.3.3-12 VnetIPOpen Properties Dialog Box

2. Based on “Table List of Items Used for Network Connections,” clear the check boxes for

[Yokogawa Vnet Protocol] and [Internet protocol version 6 (TCP/IPv6)].

3. After the setting is complete, click [OK].

® Ethernet Properties

1.

In the Network Connections window, right-click [Ethernet] and select [Properties].
The Ethernet Properties dialog box appears.
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[ [ Ethernet Properties §1
Connect using:
l_-'!‘ Intel({R) 825780M Gigabit Network Connection |

This connection uses the following items:

a Client for Microsoft Networks

Ul 0105 Packet Scheduler

.@ File and Printer Sharing for Microsoft Networks

[ - Yokogawa Vnet Protocal

[ -a Intemet Protocol Version & (TCP/IPvE)

- Intemet Protocol Version 4 (TCP/IPvd)

i Link-Layer Topology Discovery Mapper /0 Driver
& Link-Layer Topology Discovery Responder

[ Install.... ] l Uninstall l Properties

Description

Allows your computer to access resources on a Microsoft
netwaork.

0K || Cancel |

Figure B3.3.3-13 Ethernet Properties Dialog Box

2. Based on “Table List of Items Used for Network Connections,” clear the check boxes for
[Yokogawa Vnet Protocol] and [Internet protocol version 6 (TCP/IPv6)].

3. After the setting is complete, click [OK].

B Procedure 3: Set IP Addresses

On Windows, DHCP is enabled by default after a network driver is installed. However, since
ProSafe-RS does not use DHCP, you need to set IP addresses. You need to set IP addresses
also when the system is used in the domain environment. Set the IP addresses according to
the network configuration of the system.

® Setting IP Address for Vnet

1. In the Network Connections window, right-click the Vnet icon and select [Properties].
The Vnet Properties dialog box appears.

2. Select [Internet Protocol Version 4 (TCP/Ipv4)] and click [Properties].
The Internet Protocol Version 4(TCP/Ipv4) Properties dialog box appears.

3. Select [Use the following IP address] and set the IP address, subnet mask, and default
gateway. Set the IP address to a standard value that is determined based on the station
address of the computer as long as there is no special reason.

TIP

The standard values for Vnet are as follows:

IP address: 172.16.Domain number.Station number (*1)
Subnet mask: 255.255.0.0
Default gateway: No setting is required.

*1:  If the network address overlaps with the network address of the existing environment, you can use an address other than
172.16.
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You can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

{©) Obtain an IP address automatically

(@ Use the following IP address:

IP address: 172. 16 . 13 . 64
Subnet mask: 255.255. 0 .0

Default gateway:

Obtain DNS server address automatically
i@ Use the following DNS server addresses:
Preferred DNS server:
Alternate DNS server:

[] validate settings upon exit

Figure B3.3.3-14 Example of IP Address Setting (Vnet)

4. After the setting is complete, click [OK]. You do not need to restart the computer.

® |P Address for VnetIPOpen

This setting is not required when Vnet/IP is used together with Ethernet.

1. In the Network Connections window, right-click the VnetIPOpen icon and select [Proper-
ties].
The VnetlPOpen Properties dialog box appears.

2. Select [Internet Protocol Version 4 (TCP/IPv4)] and click the [Properties].
The Internet Protocol Version 4 (TCP/IPv4) Properties dialog box appears.

3. Select [Use the following IP address] and specify the following values for the IP address,
subnet mask, and default gateway.

« If the computer is to be used in an existing environment, specify the values used in
that network environment.

» If the computer is to be used in a new environment, specify the standard values de-
termined based on the station address.

TIP

The standard values for VnetlIPOpen are as follows:

IP address: 192.168.<128 + domain number>.<129 + station number> (*1)
Subnet mask: 255.255.255.0
Default gateway: Specify the IP address of L3SW if another Vnet/IP domain exists

*1:  Normally, use a standard value. However, you can also use other address.
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r B
Internet Protocol Version 4 (TCP/IPv4) Properties @g

General

You can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

(7) Obtain an IP address automatically
@ Use the following IP address:

IP address: 192 . 168 . 141 . 193
Subnet mask: 255,255,255, 0 I
Default gateway: 192 . 168 . 141 . 253

Obtain DNS server address automatically
@ Use the following DNS server addresses:

Preferred DNS server:

Alternate DNS server:

[ validate settings upon exit

[ OK ] ’ Cancel l

Figure B3.3.3-15 IP Address Setting Example (Vnet/IP Open Communication)

4. After the setting is complete, click [OK]. You do not need to restart the computer.

® Setting IP Address for Ethernet

1. In the Network Connections window, right-click the Ethernet icon and select [Properties].
The Ethernet Properties dialog box appears.

2. Select [Internet Protocol Version 4(TCP/IPv4)] and then click [Properties].
Internet Protocol Version 4 (TCP/IPv4) Properties dialog box appears.

3. Select [Use the following IP address] and set the IP address, subnet mask, and default
gateway for Ethernet as follows:

« If the computer is to be used in an existing environment, specify the values used in
that network environment.

» If the computer is to be used in a new environment, specify the standard values de-
termined based on the station address.

TIP

The standard values for Ethernet are as follows:

IP address: 172.17.<Domain Number>.<Station Number> (*1)
Subnet mask: 255.255.0.0
Default gateway: No setting is required.

*1:  Normally, use a standard value. However, you can also use other address.
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ﬂ IMPORTANT

In workgroup environment, do not change the settings for DNS server address and the

settings accessed by clicking [Advanced)].

In Windows domain environment, you need to set the DNS server address according to

the settings of Windows domain server.

Figure B3.3.3-16 Example of IP Address Setting (Ethernet)

| Ge-nal

You can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

™) Obtain an IP address automatically

@ Use the following IP address:

IP address: 172. 17 . 13 . &4
Subnet mask: 255.255. 0 . 0O

Default gateway:

Obtain DNS server address automatically
@) Use the following DNS server addresses:
Preferred DNS server:

Alternate DNS server:

[] validate settings upon exit

4. After the setting is complete, click [OK]. You do not need to restart the computer.

B Procedure 4: Configure Bindings

You need to configure network bindings because ProSafe-RS uses multiple network devices:
combination of Ethernet communication and control bus communication or combination of
Vnet/IP open communication and control bus communication. Configure the network bindings

according to the network configuration of the system.

If multiple net work cards are installed, a card that is installed later has higher priority. Be-

cause of this, you need to change the binding settings so that the following priority order is
ensured.

If the system uses Ethernet and Vnet, follow these steps:

1.

Ethernet has higher priority than Vnet.

If Vnet/IP open communication is used, VnetlPOpen has higher priority than Vnet.

If both Vnet/IP open communication and Ethernet are used, the priority shall be in this or-
der: Ethernet, VnetlPOpen, and then V net, where Ethernet is the highest.

From the Advanced menu on the Network Connections window, select [Advanced Set-

tings].
The Advanced Settings dialog box appears.
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TIP

If you cannot find the Advanced menu, press the Alt key to display the menu bar.

Adapters and Bindings | Provider Order |

Connections are listed in the order in which they are accessed by
network services.

[ & File and Printer Sharing for Microsoft Networks
[ -+ Intemet Protocol Version 4 (TCP/IPv4)
[J - Intemet Protocol Version 6 (TCP/IPvE)

[] o™ Client for Microsoft Metworks
[J - Intemet Protocol Version 4 (TCP/1Pv4)
[J 4 Intemet Protocol Version & (TCP./IPvE)

Figure B3.3.3-17 Advanced Settings (Network binding setting is inappropriate)

In the above figure, the control bus has higher priority than the Ethernet because the con-
trol bus (Vnet) driver was installed later than the Ethernet driver.

2. Use the arrow buttons next to the Connections box to set the priority of Ethernet higher
than Vnet.

Adapters and Bindings | Provider Order |

Connections are listed in the order in which they are accessed by
network services.

Connections:

=L Bthemet

/et |

Bindings for Vinet:

O File and Printer Sharing for Microsoft Networks
[J - Intemet Protocol Version 4 (TCP/IPv4)
[J 4 Intemet Protocol Version 6 (TCP/IPvE)

[] o™ Client for Microsoft Networks
[J . Intemet Protocol Version 4 (TCP/1Pv4)
[J 4 Intemet Protocol Version & (TCP/IPvE)

Figure B3.3.3-18 Advanced Settings (Network binding setting is appropriate)
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3. Click [OK].
The setting of bindings is finished.

TIP

After changing the bindings, there is no need to restart the computer.

ﬂ IMPORTANT

» Do not change the priority of Remote Access connections so as to keep it at the lowest
position.

* There is no need to configure the settings on the Provider Order tab.

* Do not change the bindings for Ethernet, Vnet and VnetIPOpen that are shown in the
Bindings box below the Connections box.

B Setup Procedure 5: Change Computer Name

It is recommended to set the station names used in the ProSafe-RS system as the computer
names.

1. Select [Control Panel] > [System and Security] > [System] > [Advanced system settings].
The System Properties dialog box appears.

2. In the Computer Name tab, click [Change].
The Computer Name/Domain Changes dialog box appears.

3. Enter the station name as the new computer name (case-insensitive) for the computer.

Computer Name/Domain Changes M

You can change the name and the membership of this

Q-_t:mputer name: _
SENG1364 |
Full computer name: f
SEMG1364 I

Member of

(7 Domain:

i@ Workgroup:
WORKGROUP

Figure B3.3.3-19 Computer Name/Domain Changes Dialog Box

4. Click [OK].
A message box appears to prompt for restarting the computer.

5. Restart the computer.

IM 32Q01C50-31E 4th Edition : Jan.30,2015-00



<B3.3 Configuring Network Settings> B3-52

B Procedure 6: Repair TCP/IP Settings

TIP

TIP

TIP

Before you install the ProSafe-RS software, run the TCP/IP Inconsistency Detect Tool. If any
inconsistency is found, use the TCP/IP Inconsistency Repair Tool and configure the TCP/IP
settings again.

On a computer where the control bus driver or Vnet/IP open communication driver had ever been uninstalled,
the TCP/IPv4 network settings of IP addresses, subnet masks, and default gateway addresses may be lost
every time the computer is restarted. This problem is caused by errors of the Windows OS.

Running the TCP/IP Inconsistency Detect Tool

1.  Use Windows Explorer to open the TOOLS directory under the following path in the Pro-

Safe-RS software medium.
(Drive of ProSafe-RS software medium) :\ProSafe-RS\TOOLS

TCP/IP Inconsistency Detect Tool is installed in the following folder when you install the ProSafe-RS software:
(ProSafe-RS Installation Folder)\ProSafe-RS\YOKOGAWA\net\tool

2. Right-click [TcpiplnconsistencyDetector.cmd], and select [Run as administrator] from the
context menu.
Messages are displayed according to the inconsistencies detected.

3. Click [OK] to end the tool.

If no inconsistency is detected, the computer can be connected on the network normally.

If no inconsistency is detected, the Windows system continues to work but the network con-
nection may not. You need to use the TCP/IP Inconsistency Repair Tool and then configure
the TCP/IP network settings again.

Running TCP/IP Inconsistency Repair Tool

IMPORTANT

TCP/IP Inconsistency Repair Tool resets the TCP/IP settings of all the network interface cards
that are installed in the computer. Therefore, before you run the TCP/IP Inconsistency Repair
Tool, you need to write down or save the current settings of the following TCP/IPv4 informa-
tion for every network interface card:

 |P Address
e Subnet Mask
+ Default Gateway

1. Use Windows Explorer to open the TOOLS directory under the following path in the Pro-
Safe-RS software medium.
(Drive of ProSafe-RS software medium) :\ProSafe-RS\TOOLS

TCP/IP Inconsistency Repair Tool is installed in the following folder when you install the ProSafe-RS soft-
ware:

(ProSafe-RS Installation Folder)\ProSafe-RS\YOKOGAWA\net\tool

2. Right-click [TcpiplnconsistencyRepair.cmd], and select [Run as administrator] from the
context menu.
Messages are displayed according to the inconsistencies detected.
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If no inconsistency is detected in the network settings, click [OK] to end the tool.
The computer can be connected on the network normally.

If any inconsistency is detected, click [Yes]
The network settings are reset and a message appears, prompting you to restart the
computer.

Click [Yes] to restart the computer.

After the computer is restarted, re-configure the settings on the Internet Protocol Version
4 (TCP/IPv4) Properties windows for all the network interface cards.
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B3.4 Installing the ProSafe-RS Software

This section describes how to install the ProSafe-RS software.

B Administrative User who Performs New Installation

When installing the ProSafe-RS software for the first time on a computer, the installation must
be performed by an administrative user who belongs to the group shown in the following ta-

ble.

The user who has installed the software is automatically added to the PSF_MAINTENANCE

group.

Table B3.4-1 Groups to Which the User Who Performs New Installation Belongs

Security model and user management type to be applied

Legacy model

Standard model

Standalone management

Domain/Combination manage-

ment

Administrators of the local comput-
er

Administrators of the local comput-
er

Domain Admins of the domain (*1)

*1:  Install while the computer is connected to the domain.

B Installation Procedure

Follow these steps to install the ProSafe-RS software:

1. Log on as an administrative user.

2. Terminate all running applications, including resident programs such as anti-virus soft-

ware.

3. Insert the ProSafe-RS software medium into the drive.

+ If the AutoPlay dialog box appears, click [Run Launcher.exe].

+ If the AutoPlay dialog box does not appear, use Explorer and double-click Launch-
er.exe in the top folder of the ProSafe-RS software medium.

The installation menu appears.

IM 32Q01C50-31E

4th Edition : Jan.30,2015-00



<B3.4 Installing the ProSafe-RS Software> B3-55

r
ProSafe-RS SETUP

ProSafe-RS Software |

Setting IT Security(File server/domain controller use) |

License Manager Software |

Install drivers
Control Bus Driver |

VnetlP Open com driver |

Figure B3.4-1 Installation Menu

4. Click [ProSafe-RS Software] in the installation menu.

5. If a dialog box appears, confirming to install Windows redistributable modules, click [In-
stall].

The following compenents will be installed on your machine:

Vigual C++ Runtime Libraries (x86)
MET Framework 35 5P1
MSXML4.0 SP3

Do you wish to install these components?

¥ you choose Cancel, setup will exit.

[ nwat | [ cames |

Figure B3.4-2 Dialog Box for Confirming Module Installation

TIP This dialog box appears when the Windows redistributable modules required to run ProSafe-RS are not al-
ready installed.
The following modules are necessary for ProSafe-RS:
* Microsoft .NET Framework 3.5 SP1
+ MSXML 4.0 SP3
» Microsoft Data Access Object 3.5
* Microsoft Visual C++ 2008 redistributable package (x86)
If you click [Cancel], the installation of the ProSafe-RS software is discontinued.

Restarting the computer may be required after installing the modules. If required, restart the computer and
then continue the ProSafe-RS installation.

For Windows Server 2008 R2, Microsoft .NET Framework 3.5 SP1 is included in the OS but displayed when it
is disabled. If displayed, interrupt the installation and enable this module. The installation fails otherwise.

6. If the following dialog box appears, restart the computer and log on again using the same
user account.
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| YOKOGAWA products insts

Administrative rights are granted to the logon user account. The computer will now restart to apply the
changes. You must log on again using the same user account to continue the installation.

Figure B3.4-3 User Rights Setting Confirmation Dialog Box

TIP

Restarting the computer here grants the currently logged on user the rights required to perform the subse-

quent installation tasks.

7.

Installation of the ProSafe-RS software starts and the Welcome dialog box appears.

In the Welcome dialog box, click [Next].
A dialog box for entering user information and the installation folder appears.

Register user information
Enter the user name and organization.

’ - User Name:

Welcome g I

* User Information Organization:

Confirm Settings = fraxocawa

Install
Install to:
Browse to a folder that you want to install to:

C:\Program Files (x86)\ProSafe-RSY

Complete

Language:

T .

Figure B3.4-4 User Information Dialog Box

TIP

If a different version of control bus driver or Vnet/IP open communication driver is already installed, a
dialog box appears, prompting you to update the driver. Confirm the message and click [OK]. To update
the control bus driver, uninstall the existing driver and then install the new one after you install the Pro-
Safe-RS software. To update the Vnet/IP open communication driver, install the new driver after you in-
stall the ProSafe-RS software.

After updating the Vnet/IP open communication driver, disable the driver if the computer is to be connec-
ted to Ethernet.

Enter the user name and company name. It is recommended not to change the installa-
tion folder from the default location.

TIP

If you want to change the installation folder, click [Browse] and specify a new location within 50 charac-
ters.

The language is determined automatically by the system language: if the system language is Japanese,
the Japanese version software is installed, otherwise, the an English version is installed.

Click [Next].
The installation setting confirmation dialog box appears.

10. Confirm that the installation settings are correct, and click [Install].
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Installation of the ProSafe-RS software is started.

11. When the installation complete dialog box appears, perform either of the following opera-
tions.

* If you install only ProSafe-RS, select [Yes, | want to set up IT security now.] and click
[Finish]. The IT Security Tool then starts.

» If you install another YOKOGAWA product, select [No, | want to install other software
products.] and click [Finish] to complete the installation.

f' Installation of YOKOGAWA ProSafe-RS
Welcome ' R3.01.00 was completed.

User Information
YOKOGAWA ProSafe-RS has been successfully installed to your computer.

Confirm Settings Do you want to set up IT security without installing other software
products?
Install

= Complete

If you select 'No', you must execute IT security tool after installation.

ProSafeR, -'

Figure B3.4-5 Installation Completed Dialog Box

ﬁ IMPORTANT

After you have installed other YOKOGAWA products, be sure to run the IT Security Tool to
configure IT security settings. The IT security settings are configured for all the installed prod-
ucts at a time.

If you do not configure IT security settings, the products will not function properly.
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B3.5 Configuring IT Security Settings

After installing the ProSafe-RS software, you need to configure settings to strengthen Win-
dows security.

Upon completion of the installation, exit the installer with [Yes, | want to set up IT security
now.] selected. The IT Security Tool starts, allowing you to configure security settings.

This section describes how to configure security of the computer by using the Tl Security
Tool.

ﬂ IMPORTANT

* The security model and user management type of IT security settings must be consistent
in the entire system. If you change the security model or user management type, make
the changes on all computers including file server computers.

» If you have changed any security settings from their default values, always save the se-
curity settings by using the Save function of the IT Security Tool to enable security set-
tings to be restored at computer failure.

» After you have activated the license of the SOE OPC Interface package (CHS2200), be
sure to run the IT Security Tool from the start menu.
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B3.5.1 IT Security Tool

The IT Security Tool is the security configuration tool that was developed for Yokogawa sys-
tem products. You need to use this tool to provide security measures on the computers instal-
led with ProSafe-RS.

The IT Security Tool applies security settings on a computer automatically based on the se-
lected security model and the user management type.

The functions of the IT Security Tool are shown in the following table.

Table B3.5.1-1 Functions of the IT Security Tool

Function Description
Setup Applies the Legacy model or Standard model of security settings.
Save Saves the security settings of the OS. The security settings are encrypted with a specified

password (encryption key).

Restore Restores the security settings of the OS to the saved security settings.

Change Pass-
word
(Encryption key)

Changes the password (encryption key) of the saved security settings. This function is
used when you want to change the password periodically.

ALso For more information about the functions of the IT Security Tool other than "Setup”, refer to:
» (8.2, “Saving the IT Security Settings” on page C8-8
» (8.3, “Restoring the IT Security Settings” on page C8-13
* (8.4, “Changing the Security Setting File Password” on page C8-17

B Security Model

You can select from the following security models according to the required security strength.

® Legacy Model

This model does not strengthen security. This model can be used if the priority is to be com-
patible with ProSafe-RS R3.01 or earlier versions, and to integrate with other YOKOGAWA
products that do not support the IT Security Tool. Since this model disables Windows Firewall,
you need to consider the possible impact of this model's vulnerability to information leaks,
worms, and virus attacks when you select this model.

® Standard Model

This model enables access control by user authentication, DCOM setting, and Windows Fire-
wall to guard against direct attacks and network attacks.

TIP

If you need a higher level of security than what the Standard model provide, the Strengthened model is avail-
able.

SEE

ALso For more information about security models, refer to:

2., “Security Models” in ProSafe-RS Security Guide (IM 32Q01C70-31E)

B User Management Types

The Standard model of security settings are applied in the following three types, according to
the selected user management type. With the Legacy model, you can select only Standalone
management as the user management type.
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® Domain Management

Select this option when managing user and group accounts using the Windows domain con-
troller. The groups must be created on the domain controller prior to configuring the security
setting.

Standalone Management

Select this option when managing user and group accounts for each computer without using
the Windows domain controller. Although user accounts are created on each computer in this
case, user groups and the user management method must match on all related computers.

Combination Management

Combination management refers to a method of user management that combines the Domain
management and the Standalone management. Combination management mainly manages
the domain users; nevertheless, it is also designed under the assumption that the workgroups
users are also managed for routine management. Unlike Domain management, however, this
allows more operations to be performed with the administrative rights of a local computer, in-
creasing security vulnerability.

B Security Model and User Management within a Control Bus Domain

Within a V net domain or a Vnet/IP domain, the security model and user management type
must be consistent. As the exception, however, Domain management and Combination man-
agement can be mixed. This mixed use of user management is also allowed for file server
computers.

B Standalone Management and Windows Domain

Even on Windows domain member computers, you can apply the "Standard model with
Standalone management" type of security settings.

B Security Setting Items

SEE

By running the IT Security Tool, various security setting items are configured. The tool config-
ures a different set of security setting items, according to the selected combination of security
model and user management type.

ALso For more information about the setting items set by the IT Security Tool, refer to:

“m Security Setting Items” in 6.1, “IT Security Tool” in ProSafe-RS Security Guide (IM 32Q01C70-31E)

B Groups and Users Automatically Created during Security

Configuration

By applying the Standard model of security settings, a specific set of users and groups are
automatically created.

EE . . .
ALso For more information about the users and groups that are automatically created by the tool, refer to:

2.2.3, “Users/Groups Respect to the Combination of User Management and Security Model” in ProSafe-
RS Security Guide (IM 32Q01C70-31E)

B User Groups and Accessible Functions

The ProSafe-RS functions that can be used by individual users are determined in user group
units.

IM 32Q01C50-31E 4th Edition : Jan.30,2015-00



<B3.5 Configuring IT Security Settings> B3-61

Access control is applied to the functions that are registered to the Start menu during installa-
tion of the ProSafe-RS software.

EE . . . ,
ALso For more information about the functions that are accessible to each user group, refer to:

“m Access Permissions to Programs” in 3.1.1, “Access Permissions to Files and Folders” in ProSafe-RS
Security Guide (IM 32Q01C70-31E)
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B3.5.2 Running the IT Security Tool

This section describes the procedure for configuring the IT security settings following the
completion of ProSafe-RS software installation.

ﬂ IMPORTANT

When using the IT Security Tool of ProSafe-RS R3.01 or later on a computer for the first time,
any security model/user management type can be selected.

If the settings have already been configured using the IT Security Tool of the following ver-
sions of YOKOGAWA products on the computer, the security model and user management
type that have been set will be selected automatically, and you cannot change them to a dif-
ferent security model or user management type here.

e CENTUM VP R5.01 or later
«  PRM R3.10 or later
*  ProSafe-RS R3.01 or later

To change the security model or user management type, first complete the IT security setting
procedure with the exiting settings, and then change the IT security settings by following the
procedure for changing the security settings.

B Running Procedure

1. When the ProSafe-RS software installation is complete, a dialog box appears. Select
[Yes, | want to set up IT security now.] and click [Finish].

Installation of YOKOGAWA ProSafe-RS
Welcome R3.01.00 was completed.

User Information
YOKOGAWA ProSafe-RS has been successfully installed to your computer,

Confirm Seftings Do you want to set up IT security without installing other software
products?
Install

» Complete

@ {fes, 1 want to setup IT security now,
(70 Mo. I want to install other software products.

If you select 'No', you must execute IT security tool after installation,

Figure B3.5.2-1 ProSafe-RS Setup Dialog Box (Completed)

The IT Security Tool starts.
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IT Security Tool - Setup

[T Security Settings

Select security model

(7) Standard Model

@) Legacy Model

Select user management

() Domain Management

(©) Combination Management

() Standslone Management

Figure B3.5.2-2 IT Security Tool — Setup

2. On the Select security model pane, select either [Standard Model] or [Legacy Model].

3. On the Select user management pane, select [Domain Management], [Combination Man-
agement], or [Standalone Management].

*  When you select the Legacy model, you cannot change the user management type from Standalone
management.

» If you select [Standalone Management] on a Windows domain member computer, a warning message is
displayed. You can go on by clicking [OK].

4. If you do not need to configure the individual setting items, click [Next] and proceed to

step 7. If you want to change the setting of any individual items, click [Details].
The Select Setting ltems page appears.
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TIP

MsecwryTool-sewp ]
Select Setting Items

P
V]
V]
Ed
[¥]

Descrnti
Create th users and in Local PC.

Grants issions for files of each product.
Grants issions for the registry used by each prod.
Setsthe COM level and port range. Grants accey

Cete the fiahte reqLir e

Changing IT environment settings

- Changing... | Sets the LAN Manager authentication level to onfy NTLMv2.

Changing IT environment settings -

Hiding th... |Hides the user name of the last logon user.

Changing IT environment settings -

Applying

Disables the AutoRun function

Changing IT environment settings -

Disabling .. | Disables NetBIOS over TCP/IP

Changing IT environment settings -

Applying

t... | Sets removable storage media to read-only devices.

Changing IT environment settings -

Disabling ... | Disables USB storage devices.

O0oEEEEE

Changing IT environment settings -

Applying

t... | Sets the Software Restriction Policies.

o [[ e | [ cams

Figure B3.5.2-3 Select Setting Items Page

5. Select or clear the check boxes of the items you want to change.

It is recommended not to change settings when the Standard model is selected.

6. Click [Next].

The Confirm Setting Information page appears.

Confirm Setting Information

The setting contents are as follows.

Setting ftem

C g
Access Control for files and folders

Description

Create the necessary users and groups in Local PC.

Grants access 13 for files and folders of each product

Access Control for product registry

Grants access pemi: 18 for the registry used by each product.

Access Control for DCOM (OPC) objects

Sets the COM authentication level and port range. Grants access pq

Personal Firewall tuning

Sets firewall policies.

Local Security

Sets the rights required to run products.

Changing T environment settings - Changing

Sets the LAN Manager authentication level to only NTLMvZ2

Changing I T environmert settings - Hiding th..

Hides the user name of the last logon user.

Changing | T environment settings - Applying ...

Disables the AutoRun function.

(N N e =

Figure B3.5.2-4 Confirm Setting Information Page
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TIP

If the settings specified are different from the default values of the security model, a warning dialog box ap-
pears.

To apply the current settings, click [Yes]. If you click [No], you will return to the Select Setting Items page.

7. Confirm the settings and click [Next].

TIP

« If this tool was used in the past to configure security settings without opening the Select Setting Items
page, the last configured IT security settings are applied. If these settings and the default settings of the
selected security model do not match, a warning dialog box appears.

To apply the current settings, click [Yes]. If you click [No], you will return to the IT Security Settings page.

When the setup is complete, the Setup Completed page appears. If there is any setting
items that have failed, the failed items are displayed.

8. Select the [Restart now] check box and click [Finish].
The IT Security Tool is exited and the computer is restarted automatically.

A\ wporTaNT
If any failed setting items are displayed, contact YOKOGAWA Service.

TIP If you are using Windows Vista, Windows 7, Windows Server 2008, or Windows Server 2008 R2, the Pro-

gram Compatibility Assistant dialog box may appear after the security settings configuration is completed.
Even this dialog box appears, the settings have been configured successfully, so click [Cancel] to close it.

SEE

ALso For more information about changing the IT security settings, refer to:

C8.1, “Changing the IT Security Settings” on page C8-2

® Notes on the Case when NetBIOS over TCP/IP is Disabled

When the Standard model is selected, you can configure to disable NetBIOS over TCP/IP.
With Domain management or Combination management, NetBIOS over TCP/IP is disabled by
default.

If it is disabled, you need to make the following settings for name solution.

+ Standalone management
In the LMHOSTS file of each station, set the computer names of the stations it needs to

access.

Location of the LMHOSTS  %Systemroot%\system32\drivers\etc

file: %Systemroot% is the directory where the Windows OS is
installed. Usually, it is C: \Windows.

Example script in the The following is an example of accessing HIS0124.

LMHOSTS file:

####4#444# 1mhosts
172.17.1.24 HIS0124 #PRE

Table B3.5.2-1 LMHOSTS File Settings
Station type Stations to be set in the LMHOSTS file

License management station All license-assigned stations

Continues on the next page
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Table B3.5.2-1 LMHOSTS File Settings (Table continued)

Station type

Stations to be set in the LMHOSTS file

License-assigned station

» License management station

» Computer that holds project files
(File server computer; if integrated with CENTUM, computer that
holds CENTUM project database)

« Domain management/Combination management
In the DNS server, set the license management station and all the license-assigned sta-

tions.
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B3.6 Distributing and Accepting Licenses

Licenses are the rights to use ProSafe-RS software packages.

To make the installed software packages available for use, you need to distribute the licenses
from the license management station to license-assigned stations and accept the licenses on
each license-assigned station. This process of making software packages available for use is
called “activation of software packages.”

In a ProSafe-RS system, there is always one license management station and other stations
are license-assigned stations. The license management station can be set up on a computer
where SENG runs.

EE , . o R
§Lso For more information about the procedure for distributing and activating licenses, refer to:

1., “Overview of license management” in License Management (IM 32Q01C60-31E)
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B3.7 Creating User Accounts

Create accounts for ProSafe-RS.

When the Standard model is selected in IT security configuration, rights to access the installa-
tion folder, registries, etc. are set by the IT Security Tool, based on the access rights granted
to the ProSafe-RS user groups. Therefore, you need to register the created user as a mem-
ber of the appropriate ProSafe-RS user group according to the user's role, such as engineer
and maintenance personnel.

This section describes the procedures for the cases where the security settings of the Stand-
ard model with Standalone management or the Legacy model are applied.

In the case of Standard model with Domain management or Combination management, user
accounts should be created in the process of setting up the domain environment.

SEE , _ . . , . .
ALso For more information about creating user accounts in a Windows domain environment, refer to:

B2.4, “Creating Domain Users” on page B2-9

B Limitation on User Account Names
e 20 characters at maximum.

* Space, tabs, and multi-byte characters such as half-width katakana and Chinese charac-
ters (kanji) cannot be used.

TIP

When the Access Control and Operation History Management Package is used and Windows authentication
mode is specified, different limitations are applied.

EE . . I . _
ALso For more information about the limitations on user account names when using Windows authentication mode
of the Access Control and Operation History Management Package, refer to:

“@ Creating User Accounts in Windows Authentication Mode” on page B4-7
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B3.7.1 When the Standard Model with Standalone
Management Security Settings are Applied

When the security settings of Standard model with Standalone management are applied, user
accounts should be created on each computer.

Follow these steps to create a user account:

1. Logon as an administrative user.

2. From the Start menu, choose [Control Panel] > [System and Security] > [Administrative
Tools] and double-click [Computer Management].
The Computer Management window appears.

3. On the tree view in the left pane of the window, select [System Tools] > [Local Users and
Groups] > [Users].

4. Select [Action] > [New User].
The New User dialog box appears.

5. Add a user account. (The rest of the steps shows an example of adding a new user ac-
count, OPERATOR.)

[ New User M

User name: OPERATOR

Full name:

Description:

Password: ssssenREEe

Corfirm password: ssssesanne

User must change password &t next logon
[] User cannet change password
[] Password never expires
[] Account is disabled

Help [ Ceste ][ Oose |

Figure B3.7.1-1 New User Dialog Box

6. Right-click the user you have created and select [Properties], and then click [Add] on the
Member of tab.
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TIP

OPERATOR Properties (D [
ember Of | e
Member of:
@ Users
- Chianges to a user's group membership
I Add... I | Femove | arenot effective until the next time the
E— user logs on.

() (o) [ o (o)

Figure B3.7.1-2 User Properties

7. Select an appropriate user group for the created user and click [OK].

From this location:

Select Groups m
Select this object type:
Groups Object Types...

SENG1150

Enterthe object names to select

Locations...

(examples):

SENG1150VPSF_OPERATOR

Advanced...

Check Names

-

Figure B3.7.1-3 Select Groups

A user who belongs to the administrative group (PSF_MAINTENANCE) must also be a member of the Ad-
ministrators group.

8.

In the user properties dialog box, confirm that the group you selected has been added to

the Member of list.
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B3.7.2 When the Legacy Model of Security Settings are
Applied
The procedure for creating user accounts is the same as that for creating user accounts on a

Standalone management computer. However, with the Legacy model, Windows groups
PSF_xxxx are not supported. So, there is no need to add the created users to these groups.

ALso For more information about creating user accounts, refer to:

B3.7.1, “When the Standard Model with Standalone Management Security Settings are Applied” on page
B3-69

IM 32Q01C50-31E 4th Edition : Jan.30,2015-00



<B3.8 Configuring Windows Environment Settings for Each User> B3-72

B3.8 Configuring Windows Environment
Settings for Each User

After creating user accounts, configure the required Windows environment settings for each
user.
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B3.8.1 Configuring on Windows 7

Follow these procedures when you use a Windows 7 computer.

B Showing Icons on the Task Tray

On license-assigned stations running Windows 7, you must set so that the License Agent icon
is always shown on the task tray.

1. Log on using the user account for which the License Agent icon should be displayed.

2. From the Start menu, select [Control Panel] > [Notification Area Icons].

TIP

If you cannot find Notification Area Icons, select [Large icons] or [Small icons] from the View by: drop-down
list in the upper right of the Control Panel window.

The Notification Area Icons window appears.

» Control Panel » All Contral Panel ltems » Notification Area Icons v | #3 W] Search Controt Panet I3

Select which icons and notifications appear on the taskbar

T you choose to hide icons and netifications, you won't be notified about changes or updates. To view hidden icons at any time, click the arrow next
to the notification area on the taskbar.,

Icons Behaviors

[R5 Action Center

ol 1 oo [Show icon and notifications -
Solve PC issues: 3 important messages 4total messages

mn

W Network
Unidentifi

ified network No network access [showicon and niiatens s

1} Volume

[Showicen end natifications -
Speakers: 66%

% LicenseAgent.TaskTray

et [nly show netifications -

Turn system icons on or off
Restore default icon behaviors

[ Always show all icons and netifications on the taskbar

Figure B3.8.1-1 Notification Area Icons Window

3. For License Agent.TaskTray, select [Show icon and natifications] and click [OK].

B Display Properties
The procedure for setting the display properties is explained as follows.
1. Log on using the user account for which to set display properties.

2. From the Start menu, select [Control Panel] > [Personalization] > [Desktop Background].
The Desktop Background window appears.
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g« All Control Panel tems » Personalization » Desktop Background w | 43 [ll Search Control Panel P

Choose your desktop background

Click a picture to make it your desktop background, or select more than one picture to create a slide show.

Picture location: |Solid Colors -] [ Browse..

]

Figure B3.8.1-2 Desktop Background Window

3. Set[Solid Colors] for Picture Location, select the color of your choice, and then click
[Save Changes].

4. Select [Screen Saver].
The Screen Saver Settings dialog box appears.

Screen zaver

’{Noneq v“ Settings... || Preview

Wait: | 1 : | rminutes ] On resume, display logon screen

Power management

Conserve energy or maximize performance by adjusting display
brightness and other power settings.

Change power settings

Figure B3.8.1-3 Screen Saver Settings Dialog Box

5. Select [(None)] for Screen saver and then click [OK].
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6. Select [Display] > [Adjust resolution] > [Advanced Settings].
The Advanced Settings dialog box appears.

Generic PnP Monitor and NVIDIA Quadro FX 580 (Microsoft Corp...

| Adapter | Manitar |TrouHeshoot I Color Managementl

Monitor Type

&: Generic PnP Manitor

Maonitor Settings

Screen refresh rate:

(58 Hertz -

Hide modes that this monitor cannot display

Clearing this check box allows you to select display modes that this
monitor cannot display correctly. This may lead to an unusable
display andfor damaged hardware.

Colars:
’True Color (32 bit) ']

o] Coma ) [ o

Figure B3.8.1-4 Advanced Settings Dialog Box

7. Select the [Monitor] tab, set [True Colors (32 bit)] for Colors and click [OK].
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B3.8.2 Configuring on Windows Vista

Follow these procedures when you use a Windows Vista computer.

B Display Properties
The procedure for setting the display properties is explained as follows.
1. Log on using the user account for which to set display properties.

2. From the Start menu, select [Control Panel] > [Personalization] > [Desktop Background].

The Desktop Background window appears.

PN )
e -~ e
@Uw@ » Control Panel » Personzlization » Desktop Background v |+ |5.=_an:h pl

- e we e

Choose a desktop background

Click a picture to make it your desktop background. To use a picture that's not listed, browse to the picture
and double click it.

Location ISDIidCDImS V] [ Browse... ]

m | »
-

= =

Figure B3.8.2-1 Desktop Background Window

3. Set [Solid Colors] for Location, select a color of your choice, and then click [OK].

TIP

When the background color is defined as a solid color or another color after the first logon,

the background

color may revert to black at the second logon. If this problem occurs, you need to define the background color

again with the same procedure.

4. Select [Screen Saverl].
The Screen Saver Settings dialog box appears.
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B Screen Saver Settings M
Screen Saver

Screen saver

[(Nnne] v] | Settings... | | Preview :

it | W0E | minutes [ ] On resume, display logon screen

Power management

Conserve energy or maximize performance by adjusting display
brightness and other power settings.

Change power settings...

Figure B3.8.2-2 Screen Saver Settings

5. Select [(None)] for Screen saver and then click [OK].
6. Select [Display Settings].
The Display Settings dialog box appears.
L Display Settings l_ - :
Monitor
Drag the icons to match your monitors,

1. Generic PnP Monitor on ATI FireGL V3300 (Microsoft Corporation - WDD =

[¥] This is my main monitor
[] Extend the desktop onto this monitor

Resolution: Colors:
Low! D | High Highest (32 bit) -

1280 by 1024 pixels

How do get the best display? Adyanced Settings...

ook [ el J[ e |

Figure B3.8.2-3 Display Settings

7. Select [Highest (32 bit)] for Colors and then click [OK].
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B3.8.3 Configuring on Windows Server 2008 R2

Follow these procedures when you use a Windows 2008 R2 computer.

B Showing Icons on the Task Tray

On license-assigned stations running Windows Server 2008 R2, you must set so that the Li-
cense Agent icon is always shown on the task tray.

1. Log on using the user account for which the License Agent icon should be displayed.

2. From the Start menu, select [Control Panel] > [Notification Area lcons].

TIP If you cannot find Notification Area Icons, select [Large icons] or [Small icons] from the View by: drop-down

list in the upper right of the Control Panel window.

The Notification Area Icons window appears.

» Control Panel » All Contral Panel ltems » Notification Area Icons v | #3 W] Search Controt Panet I3

Select which icons and notifications appear on the taskbar

T you choose to hide icons and netifications, you won't be notified about changes or updates. To view hidden icons at any time, click the arrow next
to the notification area on the taskbar.,

Icons Behaviors

[R5 Action Center

i [Show icon and notifications -

ressages

mn

[Show icon and notifications -

1} Volume

[Showicen end natifications -
Speak 66"

% LicenseAgent.TaskTray
License Agent

[nly show netifications -

Turn system icons on or off
Restore default icon behaviors

[ Always show all icons and netifications on the taskbar

Figure B3.8.3-1 Notification Area Icons Window

3. For License Agent.TaskTray, select [Show icon and natifications] and click [OK].

B Display Properties
The procedure for setting the display properties is explained as follows.
1. Log on using the user account for which to set display properties.

2. From the Start menu, select [Control Panel] > [Appearance and Personalization] > [Per-
sonalization] > [Desktop Background].
The Desktop Background window appears.
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|:"_I Desktop Background

=10l x|

@‘C)v @ = Appearance and Personalization » Personalization - Desktop Background - I Search Control Panel

fle Edit View Tools Help

Choose your desktop background
Click a picture to make it your desktop background, or select more than one picture to create a slide show.

Picture location: ISoIidCoIors j Browse... |

11181 F

. Hore...

Save changes Cancel

Figure B3.8.3-2 Desktop Background Window

3. Set[Solid Colors] for Picture Location, select the color of your choice, and then click
[Save Changes].

4. Select [Screen Saver].
The Screen Saver Settings dialog box appears.

:_.':.' Screen Saver Settings 5'

Screen Saver |

 Screen saver
Settitigs.. Presies,
ifait I 1 _I::' rminutes [~ On resume, display logon screen
i Power
C energy or imi: f e by adjusting display

p
brightness and other power settings.

Change power settings

0K I Cancel | Apply |

Figure B3.8.3-3 Screen Saver Settings Dialog Box

5. Select [(None)] for Screen saver and then click [OK].

6. Select [Display] > [Adjust resolution] > [Advanced Settings].
The Advanced Settings dialog box appears.
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Generic PnP Monitor and NVIDIA Quadro FX 580 Properties

Figure B3.8.3-4 Advanced Settings Dialog Box

7. Select the [Monitor] tab, set [True Colors (32 bit)] for Colors and click [OK].
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B3.8.4

Configuring on Windows Server 2008

Follow these procedures when you use a Windows 2008 computer.

B Display Properties

The procedure for setting the display properties is explained as follows.

1. Log on using the user account for which to set display properties.

2. From the Start menu, select [Control Panel] > [Appearance and Personalization] > [Per-
sonalization] > [Desktop Background].
The Desktop Background window appears.

[Z] Desktop Background =1o] x|

%@ |@ ~ Personalizaton + Desktop Background * B [seacn Bl

File Edit View Tools Help

Choose a desktop background
Click a picture to make it your desktop background. To use a picture that's not listed, browse to the picture and double dick

it.
Browse... |

. More...

Location

(] =

Figure B3.8.4-1 Desktop Background Window

3. Set[Solid Colors] for Location, select a color of your choice, and then click [OK].

4. Select [Screen Saver].

The Screen Saver Settings dialog box appears.
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- Screen Saver Settings

Figure B3.8.4-2 Screen Saver Settings Dialog Box

5. Select [(None)] for Screen saver and then click [OK].

6. Select [Display Settings].
The Display Settings dialog box appears.

- Display Settings

1. Generic PnP Menitor on NVIDIA Quadro 600

righes G260

—
o | _cne | wov |

Figure B3.8.4-3 Display Settings

7. Select [Highest (32 bit)] for Colors and then click [OK].
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B3.9 Configuring the Uninterruptible Power
Supply (UPS) Service

You can install uninterruptible power supply (hereinafter referred to as UPS) software and
make various settings to protect data in the computer at power supply failures.

B UPS Software Setting

Specify the UPS battery operation time so that the computer can continue operation with the
UPS battery without shutting down even if a power supply error (for example, power interrup-
tion) occurs for a short period of time. Use several seconds as a guideline for setting the UPS
battery operation time.

TP Although the UPS battery operation time can be set longer than several seconds, the computer should be
shut down at a power interruption of several seconds for safety reasons.

SEE

ALso For more information about the UPS software that can coexist with ProSafe-RS, refer to:

“® Software that can Coexist with ProSafe-RS” on page A3-4
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B4. Configuring Function-Specific
Settings on SENG

This section describes the settings specific to functions that run on the SENG.
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B4.1 Online Manual Setting

Configure Adobe Reader to view the online manuals.

B Setting of Adobe Reader

When using Adobe Reader 9.5/10.1/11.0, make sure that the [Open cross-document links in
same window] check box is selected.

* The [Open cross-document links in same window] check box can be displayed by select-
ing [Preferences] - [Documents] from the [Edit] menu of Adobe Reader. It is necessary to
do this setting for each logon user.
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B4.2

Settings of Project Database Folder

This section explains the procedure for strengthening the security of project databases.

B Strengthening the Security of the Project Database on SENG PC

When ProSafe-RS software is installed, C:\RS-Projects folder is automatically created as the
default location for saving project data. By running the IT Security Tool after the installation,
share folder settings and security reinforcement are done for this default folder.

Shown below is the procedure for reinforcing security when you place the project database in
a location other than the default folder on an SENG PC and have it shared with other comput-

ers.
1.
2.

Create a new folder for storing project data.

Log on as an administrative user belonging to the PSF_MAINTENANCE group and as-
sign the share name RS-Projects to a folder to which the project database is to be stored.

Grant full control access permissions to Everyone.

Launch the IT Security Tool from the Start menu and configure security settings without
changing the security model and user management type.

B Strengthening the Security of Version Control Tool's Check-in
Folder

If you place the Version Control Tool's check-in folder on an SENG PC, follow these steps to
strengthen the security of the folder.

1.
2.

Create a new folder for use as the check-in folder of Version Control Tool.

Log on as an administrative user belonging to the PSF_MAINTENANCE group and as-
sign the share name RS-Share to the check-in folder.

If the folder should be shared with other computers, grant full control access permissions
to Everyone.

Launch the IT Security Tool from the Start menu and configure security settings without
changing the security model and user management type.
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B4.3 Settings for Message Cache Tool

If you want to check the status of data collection by other stations using the Message Cache
Tool, the following setups are required.

B On Workgroup Member Computers

1. Create a user account on the station whose status of data collection shall be checked.
The user account name and password should be the same as the user account of the
computer that uses the Message Cache Tool.

2. Make the created user account created in step 1 belong to the PSF_ENGINEER user
group.

B On Windows Domain Member Computers
Register users of the Message Cache Tool to the PSF_ENGINEER user group.
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B4.4 Settings Required for OPC
Communication

This section explains how to make settings required to perform OPC communication when the
standard IT security setting model is selected on an SENG PC running the CHS2200 SOE
OPC Interface Package. If the standard model of security settings is applied by the IT Securi-
ty Tool after installation of ProSafe-RS, access to DCOM will be set. By this setting, only users
belonging to ProSafe-RS user groups can access the SOE OPC interface.

B Setting when Using Packages Performing OPC Communication with
SENG PC

When you are using packages (OPC clients) that perform OPC communication with SENG
PC (OPC servers), you must make the setting explained here.

® In the Case of Standalone Management or When Combination
Management is Applied on Some Computers

Perform the following procedure on an SENG PC performing OPC communication.

1. Create a program user of the OPC client package. Set the same user name and pass-
word as those on the client computer.

2. Make the created program user belong to the PSF_OPC user group.
® In the Case of Domain Management or When Combination Management is
Applied on All Computers
* In the case of package that can join the domain
1. Make a computer that runs the OPC client package join the domain.

2. Register the package program user to the domain and make it belong to the
PSF_OPC user group.

* In the case of package that cannot join the domain
Perform the following procedure on the SENG PC performing OPC communication.

1. Create a program user of the OPC client package. Set the same user name and
password as those on the computer running the package.

2. Make the created program user belong to the PSF_OPC_LCL user group.

A|_Es(E) For more information about the settings for a computer where the SOE OPC Interface Package and
CENTUM VP ExaOPC Interface Package coexist, refer to:

D1.1.2, “CENTUM VP Standard Operation and Monitoring Function and ProSafe-RS SOE OPC Interface
Package” on page D1-5

For more information about the settings for using Exaquantum as an OPC client, refer to:

D1.3.1, “ProSafe-RS SOE OPC Interface Package and Exaquantum PIMS Server” on page D1-17
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B4.5 Setup when Using the Access Control and
Operation History Management Package

In ProSafe-RS R3.01 and later, it is possible to manage operation histories on SENG by using
the CHS5170 Access Control and Operation History Management Package. This section ex-
plains the operations required to use this package.

EE , . . : N
ALso For more information about the precautions to be followed when setting the access control/operation history
management function, refer to:

» 2.13, “Access Control / Operation History Management Functions” in Engineering Guide (IM
32Q01C10-31E)

* 16., “Access Control/Operation History Management Function” in Engineering Reference (IM
32Q04B10-31E)

B Windows User Groups to which Administrators and Engineers
Belong
There are two types of personnel in a system where the access control and operation history

management is applied: “administrators of access control and operation history management”
(hereinafter referred to as “administrator” in this section) and “engineers.”

After creating user accounts for administrators and engineers, add them to the Windows user
groups shown in the following table.

Table B4.5-1 Windows User Groups to which Administrators and Engineers Must Belong

Personnel Windows user group to belong to
Standard or Strengthened model Legacy model
Administrator Either of the following: Group with administrator privilege

PSF_MAINTENANCE (*1)
PSF_MAINTENANCE_LCL (*1)

Engineer One of the following: Any group
PSF_OPERATOR
PSF_ENGINEER
PSF_OPERATOR_LCL
PSF_ENGINEER_LCL

*1:  Users belonging to these groups must also have the Windows administrator privileges. Make them also belong to the Admin-
istrators or Domain Admins group.

B Security Model and User Authentication Mode

If you select the Standard model with the IT Security Tool, you can select either ProSafe au-
thentication mode or Windows authentication mode as the user authentication mode of the
operation history management function on SENG. By default, ProSafe authentication mode is
selected.

If you select the Legacy model with the IT Security Tool, only ProSafe authentication mode is
available.

You can configure user authentication modes by using the operation history management set-
ting tool included in the Access Control and Operation History Management Package.

EE . . .
ALso For more information about security models, refer to:

2., “Security Models” in ProSafe-RS Security Guide (IM 32Q01C70-31E)
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B Creating User Accounts in Windows Authentication Mode

In Windows authentication mode, Windows user names are used to log on to the SENG func-
tions and authenticate users.

ﬂ IMPORTANT

When you use Windows authentication mode, create Windows users following the naming
convention below, rather than the Windows naming convention. This naming convention is the
same as the naming convention for engineers.

The naming convention for users in Windows authentication mode is as follows:

Table B4.5-2 User Naming Convention in Windows Authentication Mode

Number of characters Up to 16 characters
Character type Alphanumeric characters and the following symbols can be used: ! # $
% ()--"_{}~

Double-byte characters cannot be used.

Restriction Upper-case characters only (*1)

For the head character, alphanumeric characters and the following
symbols can be used: * _{}~

Names ending with a period cannot be used.

*1:  Only upper-case characters can be used for engineer names to be registered in the Engineers’ Account Builder. Although
both upper-case and lower-case characters can be used on the Windows side, they are not distinguished; use upper-case
characters only.

You can set passwords within 63 characters using alphanumeric characters and symbols.

 Passwords are case-sensitive.

» The following symbols and space character are allowed:
"#8% &' () +,-./;<=>2@[\]"_{|}~

SEE

ALso For more information about how to create Windows user accounts, refer to:

B3.7, “Creating User Accounts” on page B3-68
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B4.5.1 Setup Procedure when Using Access Control and

SEE
ALSO

Operation History Management Functions

This section explains the setup procedure you should perform after installing the Pro-Safe-RS
software when using the access control and operation history management functions. If you
want to introduce the access control and operation history management functions later, use
the procedure at a proper timing.

Perform the following tasks after creating administrator and engineer user accounts on Win-
dows.

1. Add the Windows accounts for administrators and engineers to their respective appropri-
ate user groups.

2. Configure security settings for the operation history database.

On a computer granted with the licenses of CHS5100 Safety System Generation and
Maintenance Function Package and CHS5170 Access Control and Operation History
Management Package, use the Operation History Management Setup Tool and Engi-
neers’ Account Builder to perform required setting.

For more information about how to create Windows user accounts, refer to:
B3.7, “Creating User Accounts” on page B3-68

For more information about the explanation of the procedure involved in making security settings for opera-
tion history management databases, refer to:

B4.5.2, “Security Settings for the Operation History Database” on page B4-9

For more information about the precautions to be followed when setting the access control/operation history
management function, refer to:

16.2, “Setting Up Access Control/Operation History Management” in Engineering Reference (IM
32Q04B10-31E)
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B4.5.2 Security Settings for the Operation History Database

The administrator must specify the folder for storing the operation history database by using
the operation history management setting tool. Set the security of the folder for storing the op-
eration history database at proper timing before starting to use the operation history manage-
ment function.

This section explains the procedures to configure security settings when the operation history
database is placed on an SENG PC and when it is placed on a file server. After performing
these procedures, the administrator and engineers can access the operation history database
folder.

B Setting when Operation History Databases are Placed on SENG PC

If you place an operation history database on an SENG PC, perform the following procedure
to reinforce the security of the folder for storing the operation history database.

1. Create a new folder for storing the operation history database.

2. Log on to the system as an administrative user who belongs to the PSF_MAINTENANCE
group and assign the sharing name “RS-Share” to the folder for storing the operation his-
tory database.

3. If the folder needs to be shared with other computers, grant a full control permission to
Everyone.

4. Launch the IT Security Tool from the Start menu and execute it again without changing
the setting made the last time it was executed.

B Setting when Operation History Databases are Placed on a File
Server

If you place an operation history database on a computer not installed with the ProSafe-RS
software and allow SENG to access the database via a network, perform the procedure to re-
inforce security of the file server.

SEE

ALso For more information about the procedure for reinforcing the security of the file server, refer to:

B5., “Setting Up a File Server” on page B5-1
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BS5. Setting Up a File Server

Provide a file server in the system, and you can access the files placed on this server comput-
er from other computers. On a file server, you may place a project database, the check-in
destination folder for Version Control Tool, and/or the operation history database of the Ac-

cess Control and Operation History Management Package, allowing access to these databa-
ses via the network.

This section describes how to set up a file server computer for the following cases:
» Computer that serves only as a file server

Computer that serves as both a file server and an SENG

Computer that serves as both a file server and a license management station

H Item to be Prepared

Have the following item at hand before you set up a file server.
* ProSafe-RS software medium (Model: CHSKM30)

B File System

Ensure that the file system is in the NTFS format.
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B5.1 Setting Up a Computer that Serves Only as
a File Server

This section describes how to set up a computer that is used only as a file server.

B Administrative User who Performs the Setup

A file server must be set up by an administrative user who belongs to the groups shown in the
following table.

Table B5.1-1 Groups to Which the Administrative User Who Sets Up a File Server Belongs
Security model and user management type to be applied

Standard model
Legacy model - -
Standalone management Domain/Combination management
Administrators of the lo- | Administrators and PSF_MAINTE- Domain Admins and PSF_MAINTE-
cal computer NANCE of the local computer NANCE of the domain (*1)

*1:  Log on to the computer when the computer is connected to the domain.

B Procedure 1: Prepare to Configure IT Security Settings on a File
Server

Perform one of the following procedures according to the security model to be applied.

® Legacy Model
1. Log on as a member of the Administrators group.
2. Perform one of the following operations:
*  On Windows Server 2008 R2, enable .NET Framework 3.5.1.
*  On Windows Server 2008, enable .NET Framework 3.0.
Restart the computer.

Log on using the same user account as in step 1.

SEE

ALso For more information about how to enable .NET Framework 3.5.1 and 3.0, refer to:

‘@ Enabling .NET Framework 3.5.1” on page B3-25

® Standard Model with Standalone Management
1. Log on as a member of the Administrators group.
2. Create the PSF_MAINTENANCE group.

3. Add the user to be set as the administrator to the Administrators and PSF_MAINTE-
NANCE groups.

TIP

If any other YOKOGAWA product coexists in the computer, the user also needs to be a member of the MAIN-
TENANCE group of the coexisting product. For example, if CENTUM VP coexists, also add the user to the
CTM_MAINTENANCE group.

4. Perform one of the following operations:
*  On Windows Server 2008 R2, enable .NET Framework 3.5.1.
*  On Windows Server 2008, enable .NET Framework 3.0.

5. Restart the computer.
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6.

Log on as the user set in step 3 above.

A,_ES(E) For more information about how to enable .NET Framework 3.5.1 and 3.0, refer to:

“@ Enabling .NET Framework 3.5.1” on page B3-25

® Standard Model with Domain/Combination Management

1.

3.
4.

Log on as a user who belongs to both the Domain Admins and PSF_MAINTENANCE
groups of the domain.

Perform one of the following operations:

*  On Windows Server 2008 R2, enable .NET Framework 3.5.1.
*  On Windows Server 2008, enable .NET Framework 3.0.
Restart the computer.

Log on using the same user account as in step 1.

TIP

If any other YOKOGAWA product coexists in the computer, the user also needs to be a member of the MAIN-

TENANCE group of the coexisting product. For example, if CENTUM VP coexists, also add the user to the
CTM_MAINTENANCE group.

SEE

ALso For more information about how to enable .NET Framework 3.5.1 and 3.0, refer to:

“@ Enabling .NET Framework 3.5.1” on page B3-25

B Procedure 2: Create and Set Up the Shared Folders

In order to reinforce the security of folders that store databases using the IT Security Tool, you
must name the target folders with the following share names.

Project database
Share name: RS-Projects

Operation history database and check-in destination folder of Version Control Tool
Share name: RS-Share

ﬂ IMPORTANT

If the shared name does not match the name above, the IT Security Tool is not able to rein-
force the folder security. Be sure to set the share name above using the following procedure
so that you can reinforce security.

® Creating a New Folder

1.
2.

Start Windows Explorer and create a folder in which the project folders are to be placed.

On the Sharing tab in the properties of the folder that is created, click [Advanced Shar-
ing].
Select [Share this folder] and set RS-Projects or RS-Share as the share name.

Click [Permissions] and grant full control to [Everyone] in the Share Permissions section.
This access permission setting will be changed when you run the IT Security Tool.
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® When a Shared Folder is Already Created on the File Server

Before configuring IT security settings, add a share name, “RS-Projects” or “RS-Share,” to the
folder. The folder will be included in the process of IT security setting configuration and ac-
cess permissions setting will be applied. Share names that were previously set up do not
need to be deleted.

ﬂ IMPORTANT

If a folder with the share name “RS-Projects” or “RS-Share” has already been created for an-
other purpose on an existing file server, change the existing share name to another name.
Since the access permissions are granted to folders with the share name “RS-Projects” or
“RS-Share” during configuration of IT security settings, unintended settings will be applied if
these share names are not assigned to appropriate folders.

If IT security settings have been applied to an unintended folder, delete the permissions set
during the configuration of IT security settings and set the original access permissions based
on the setting of another folder, such as the C:\Windows folder.

B Procedure 3: Save the IT Security Settings on the File Server

ﬂ IMPORTANT

The existing security settings before using the IT Security Tool will be required as the initial
data when you change the security settings in the future. So, you must save the existing se-
curity settings here.

If the file server computer is to be added to a domain, save two sets of initial security settings
before and after you add it to the domain.

If the file server computer is not to be added to a domain, you need to save only one set of
initial security settings.

Follow these steps to save the security settings:
1. Log on as a user who has the rights to set up a file server.
2. Insert the ProSafe-RS software medium into the drive.
* If the AutoPlay dialog box appears, click [Run Launcher.exe].

» If the AutoPlay dialog box does not appear, use Explorer and double-click Launch-
er.exe in the top folder of the software medium.

The installation menu appears.

3. Click [Setting IT Security (File server/domain controller use)].
The IT Security Tool starts.
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IT Security Tool =] ® ]

IT Security Tool

Setup

Save

Festore

Change Password
{Encryption Key)

Figure B5.1-1 IT Security Tool Menu

4. Save the security settings.

TIP

If the file server is a member of a domain, when restoring the initial security settings on the file server, the
initial data should have two types, either the initial data for a standalone computer or the initial data for a
member of domain.

If you do not have the initial data for a standalone file server computer, you need to remove the file server
from the domain temporarily and then save the security settings as the initial data for the standalone comput-
er.

SEE

ALso For more information about the subsequent operations of the IT Security Tool, refer to:

C8.2.1, “Procedure for SENG PC” on page C8-9

B Procedure 4: Configure the IT Security Settings on the File Server

1. From the IT Security Tool Menu, click [Setup].
A confirmation dialog box appears

2. If you have saved the above mentioned initial security setting data, click [OK].

TIP

If you have not saved the initial security setting data, click [Cancel] to return to the tool's menu and save the
security settings.

The Select Security Model page appears.
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IT Security Tool - Setup

Select Security Model

Setting Model -

Description of Setting File

Setting ftem Description

s

Figure B5.1-2 Select Security Model

3. From the Setting Model drop-down list, select a security model for the file server.
You can select from the following four models.

Table B5.1-2 Security Models for a File Server
Model Description

Select this model to apply Legacy model to the file

File Server Legacy Model server, regardless of the user management type.

Select this model to apply Standard model to the file
server when the user management type is Stand-
alone management.

File Server Standard Model with Standalone Man-
agement

Select this model to apply Standard model to the file
server when the user management type is Domain
management.

File Server Standard Model with Domain Manage-
ment

Select this model to apply Standard model to the file
server when the user management type is Combina-
tion management.

File Server Standard Model with Combination Man-
agement

4. Click [Next].
The Confirm Setting Information page appears.

TIP

If you click [Detail] here, the Select Setting Items page appears.

5. The subsequent steps are the same as those for the IT security setting configuration after
installing the ProSafe-RS software.

ALES(E) For more information about the IT security setting operations that are performed following the ProSafe-RS
software installation, refer to:

B3.5.2, “Running the IT Security Tool” on page B3-62
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B Procedure 5: Create Accounts on the File Server for Users who
Access Project Data

On the file server computer, create accounts for users who access the project data, according
to the selected security model and user management type.

® Standard Model with Domain/Combination Management

On the domain controller, add the accounts for accessing projects. No account needs to be
created if already created.

® |Legacy/Standard Model with Standalone Management

Perform the following procedure on the file server.

1.

Create a user account.
The user name and the password must be the same as those of the SENG PCs from
which the projects are accessed.

Register the user you have created to the same group as that on the SENG PCs which
access the file server.

TIP

If the Standard model is applied, the following user groups have been created during the procedures so far.

PSF_MAINTENANCE
PSF_OPERATOR
PSF_ENGINEER
PSF_OPC

B Procedure 6: Create the Project Folder on the File Server and Start
the Operation

Project database
From an SENG PC, create an RS project under the shared folder “RS-Projects” created
in Procedure 2.

Check-in folder of Version Control Tool

On an SENG PC, use the Version Control Tool to specify a folder under the shared folder
“RS-Share” created in Procedure 2 as the check-in destination folder, and start project
operation.

Operation history database

On an SENG PC, use the operation history management setting tool to specify a folder
under the shared folder “RS-Share” created in Procedure 2 as the top folder of the opera-
tion history database, and start the access control and operation history management
function.
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B5.2 Setting Up the File Server Function on

TIP

TIP

SEE

ALSO

SENG

This section describes the required settings when you use a computer that has been set up
as an SENG also to be used as a file server.

On an SENG, the project database is created under the installation folder by default. The procedure descri-
bed in this section is for the case when the project database is placed in a location other than the installation
folder.

1. Setup a computer as an SENG.

You do not need to configure security settings during this setup.

2. On the computer, create and set up the shared folder.
3. Start the IT Security Tool from the Start menu and configure IT security settings.

4. Create a project folder in a location under the shared folder of the computer.

IMPORTANT

On a computer used as both a file server and an SENG, do not use the [Setting IT Security
(File server/domain controller use)] button on the installation menu to start the IT Security
Tool.

For more information about how to create the project folder on the file server, refer to:
“@ Procedure 6: Create the Project Folder on the File Server and Start the Operation” on page B5-7
For more information about new setup of SENG, refer to:
B3., “Setting Up the SENG” on page B3-1
For more information about the shared folder settings, refer to:
“@ Procedure 2: Create and Set Up the Shared Folders” on page B5-3
For more information about creating accounts for users who access the project database, refer to:

“® Procedure 5: Create Accounts on the File Server for Users who Access Project Data” on page B5-7
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B5.3 Setting Up the Computer that Serves as
Both File Server and License Management
Station

This section describes the setup required for the computer that serves as both a file server
and a license management station.

B Setup Procedure
1. Install the license management software.

2. On the dialog box that appears on completion of the installation, select [No, | want to in-
stall other software products.] and click [Finish].

Configure the shared folder settings required for a file server.

Start the IT Security Tool from the Start menu and configure IT security settings.

ﬂ IMPORTANT

On a computer used as both a file server and a license management station, do not use the
[Setting IT Security (File server/domain controller use)] button on the installation menu to start
the IT Security Tool.

ALES(E) For more information about installing only the license management software, refer to:
B6., “Setting Up the Computer Dedicated to License Management” on page B6-1
For more information about the shared folder settings, refer to:

“® Procedure 2: Create and Set Up the Shared Folders” on page B5-3
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B6. Setting Up the Computer Dedicated

to License Management

You can use a computer as the license management station by installing only the license
management software on it.

This section describes the procedure for setting up the computer dedicated to license man-
agement.

B [tems to be Prepared

Have the following item at hand before installing the license management software.

ProSafe-RS software medium (Model: CHSKM30)

B Installation Procedure

TIP

TIP

Follow these steps to install the license management software.

1.
2.

Log on as an administrative user.
Insert the ProSafe-RS software medium into the drive.
* If the AutoPlay dialog box appears, click [Run Launcher.exe].

« If the AutoPlay dialog box does not appear, use Explorer and double-click Launch-
er.exe in the top folder of the ProSafe-RS software medium.

The installation menu appears.

Click [Install License Manager Software].
The Welcome dialog box appears.

If modules required to run ProSafe-RS, such as Microsoft .NET Framework, are not already installed, a
dialog box appears, prompting you to install such modules. Click [Install] .

Restarting the computer may be required after installing the modules. If required, restart the computer
and then continue the ProSafe-RS installation.

For Windows Server 2008 R2, Microsoft .NET Framework 3.5 SP1 is included in the OS but displayed
when it is disabled. If displayed, interrupt the installation and enable this module. The installation fails
otherwise.

A message that prompts restarting the computer may be displayed so as to grant the currently logged on
user the rights required to perform the subsequent installation tasks. If prompted, restart the computer
and log on using the same user account to continue the installation of the license management software.

Click [Next].
The User Information dialog box appears.

If a different version of control bus driver is already installed, a dialog box appears, prompting you to update
the driver. However, you do not need to install the control bus driver on a computer dedicated to license man-
agement. Click [OK] to close the dialog box.

5.

7.

In the User Information dialog box, enter the name and company name, select the instal-
lation folder, and confirm the language for installation, and click [Next].
The Confirm Settings dialog box appears.

Review the installation settings and click [Install].
A dialog box showing the installation progress appears, and when the license manage-
ment software installation is compete, the Installation Complete dialog box appears.

Select [Yes, | want to set up IT security now.] and click [Finish].
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The IT Security Tool starts.

8. Go on to configure the security settings.
TIP

When deleting the ProSafe-RS function and installing only the license management software after installing
ProSafe-RS, first log on using an administrative user account and uninstall ProSafe-RS, and then install the
license management software.

ﬂ IMPORTANT

If you want to manage other product's licenses on the computer dedicated to license manage-
ment, you also need to install the license management software from the software medium of
that product.

SEE

ALso For more information about how to uninstall the ProSafe-RS software, refer to:
C6.1.1, “Uninstalling the ProSafe-RS Software” on page C6-3
For more information about configuring the IT security settings, refer to:

B3.5.2, “Running the IT Security Tool” on page B3-62
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B7. Configuring the Hardware of SCS
and Devices for Connection
between Domains

Configure the hardware of SCS and devices used for connection between domains, such as
V net routers and L3 switches.

* On the processor module of SCS, set the V net or Vnet/IP address.

+ IfaV netrouter (AVR10D) is used to connect a Vnet/IP domain and a V net domain, the
V net router address should be set on the CENTUM side.

A WARNING

When removing and installing the cards to set DIP switches, take measure to prevent the
damages caused by static electricity.

SEE

ALso For more information about Antistatic measures, refer to:
Appendix 3., “Antistatic Precautions When Handling Hardware” on page App.3-1

For more information about setting up the hardware when using V net routers, bus converters, and communi-
cation gateway, refer to:

*+  CENTUM VP Communication Devices (IM 33K50D10-50E)
«  CENTUM VP Communication Devices (IM 33M50D10-40E)
+ CS 1000/CS 3000 Communication Devices (IM 33Y06H01-01E)
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B8.

TIP

Installing the Functions that
Operate with CENTUM VP Licenses

The test function and SOE Viewer of ProSafe-RS operate in coordination with CENTUM VP
packages. You can set up a computer so as to use only these functions without using other
SENG functions. First, grant the computer licenses (at least one license for the test functions)
of the CENTUM VP packages that operate in coordination.

Then, install the ProSafe-RS software from the ProSafe-RS software medium. Licenses for
ProSafe-RS software packages are not required.

« If the CENTUM VP coexisting on the computer is earlier than R5.01, the CENTUM VP package that op-
erates in coordination must be installed with the correct key code. The explanation in the subsequent
sections assumes that the version of the coexisting CENTUM VP is R5.01 or later.

When you move the CENTUM package from a computer where the function that operates with CENTUM
VP licenses is used, fully install the ProSafe-RS software also on the new computer.

B Installation on the Computer for Running SCS Simulator

E
ALSO

SCS simulator is used in combination with the CENTUM packages listed in the following ta-
ble. Licenses for ProSafe-RS packages are not required.

Table B8-1 CENTUM Packages Required for SCS Simulator

Model CENTUM VP package name
LHS5420 Test Function Package
LHS5426 FCS Simulator Package
LHM5150 Test Function Package (for CENTUM VP Small)

With CENTUM VP R5.01 or later version, perform the following tasks on the computer where
you use the SCS simulator. Either task can be performed first.

« Install CENTUM software and grant a license for any of the CENTUM packages in the ta-
ble.

* Install ProSafe-RS software.

If the CENTUM VP version is earlier than R5.01, one of the following packages must be in-
stalled on the computer using the CENTUM VP key code, rather than through operation of the
License Manager, before you install the ProSafe-RS software.

For more information about installation of CENTUM VP software, refer to:
+  CENTUM VP Installation (IM 33K01C10-50E)
*  CENTUM VP Installation (IM 33M01A20-40E)

B Installation on the Computer for Integration of CENTUM SOE Viewer

In the case of system configurations integrating CENTUM, it is possible to display SOE (Se-
quence of Events) of SCS on the CENTUM SOE Viewer. This is referred to as integration of
CENTUM SOE Viewer. The ProSafe-RS software package licenses are not required.

With CENTUM VP R5.01 or later version, perform the following tasks on the computer where
you use the SCS simulator. Either task can be performed first.

* Install CENTUM software and grant a license for the CENTUM SOE Viewer package
(LPC6920).
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* Install ProSafe-RS software.

If the CENTUM VP version is earlier than R5.01, the CENTUM SOE Viewer package must be
installed on the computer using the CENTUM VP key code, rather than through operation of
the License Manager, before you install the ProSafe-RS software.

In order to display SOE of SCS on the CENTUM SOE Viewer, it is necessary to connect the
computer and SCS via V net or Vnet/IP.

ﬁ,_ES(E) For more information about how to grant license of CENTUM SOE Viewer Package (LPC6920), refer to:

License Management (IM 33K01C20-50E)
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C. Maintenance

This section describes the tasks required in the operation and maintenance of stations after
they have been newly set up.
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C1. Adding Licenses and Changing
License Assignments

This section describes how to add licenses, which is required to add new software packages
on a station, and how to change the assignments of licenses, which is required to migrate
software packages between stations.
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C1.1 Adding a License

The procedure for loading an additionally purchased license on the license management sta-
tion is the same as the procedure for new installation.
SEE

ALso For more information about how to load an additionally purchased license on the license management sta-
tion, refer to:

3.1, “Reading additional licenses on a license management station” in License Management (IM
32Q01C60-31E)
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C1.2 Changing License Assignments

Use the License Manager on the license management station to add the license for the soft-
ware package additionally required on a license-assigned station.

Also use the License Manager on the license management station to remove the license for
the software package no longer required on a license-assigned station.

These operations are called “changing license assignments.”
SEE

ALso For more information about changing license assignments, refer to:

3.2, “Modifying licenses” in License Management (IM 32Q01C60-31E)
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C2.

Setting Up the Windows Domain
Environment Later

This section describes the procedure for the case when you want to change the system that
has been built as a Standalone management system to a Domain management system.

B Workflow

Set up the domain controller

Configure IT security settings
for the domain controller

Create domain users

Add domain users
to domain groups

Add existing stations
to the domain

Change user management type
on the existing stations

Synchronize the time of stations

End

Figure C2-1 Workflow for Setting Up the Windows Domain Environment Later

B Setup Procedure

1.

o gk~ w DN

Prepare a computer to be used as the domain controller and configure a domain control-
ler on it.

Configure IT security settings.

Create domain users.

Add the domain users to domain groups.

Add the client computer stations to the domain.

On each station, change the user management type to Domain management or Combi-
nation management.

Synchronize the time of the stations within the domain.
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SEE

ALso For more information about configuring the domain controller, refer to:

B2.2, “Configuring the Domain Controller (Windows Server 2008/Windows Server 2008 R2)” on page
B2-3

For more information about configuring IT security settings on the domain controller, refer to:
B2.3, “Configuring Security Settings for the Domain Controller’ on page B2-5
For more information about how to create domain users and add them to domain groups, refer to:
B2.4, “Creating Domain Users” on page B2-9
For more information about how to add client computers to a domain, refer to:
B2.5, “Adding Client Computers to the Domain” on page B2-13
For more information about how to set up time synchronization within a domain, refer to:
B2.7, “Setting Up Time Synchronization in Windows Domain Environment” on page B2-19
For more information about changing the user management type, refer to:

C8.1.2, “Procedures for a File Server or Domain Controller” on page C8-5
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C3. Backing Up the System

To be prepared for system failures, it is recommended to back up the system periodically. The
files in the folders listed in the following table should be regularly backed up:

Table C3-1 Folder Backups
Contents Folder Registry When to back up

* When changes have been made to
the system; for example, after pro-

Sackup of entire Win- All hard disk Entire reg- gram installation or completion of
ows istry

setup.

 After closing all applications
ProSafe-RS engineering SCS project folders - After closing the SENG software

data

When you back up a system where the Standard model of IT security settings is applied, log
on to Windows as an administrative user who has the right to access ProSafe-RS-related
folders.

B Backing Up Entire Windows

Back up Windows using a commercially available software program in preparation against
disk trouble.

B Creating Windows Repair Disk

Installing various application programs on a computer can cause troubles: for example, Win-
dows does not start up, or you cannot log on to Windows. In such cases, if you have a system
repair disk and boot disk, you can restore the system to the state at the time you created
these disks.

To be prepared for Windows troubles, create a system repair disk and boot disk when you
have changed the state of the system by installing a program, changing hardware configura-
tion, etc.

SEE

ALso For more information about how to create a repair disk, refer to:

Windows-related manual or the web site of Microsoft Corporation

B Backing Up Projects

You can copy the ProSafe-RS folders to a backup medium using Windows Explorer. It is also
possible to use commercially available backup software to back up the folders.

The SCS project folders should be backed up using Version Control Tool.

EE _ _ . .
ALso For more information about the explanation of Version Control Tool, refer to:

13., “Version Control” in Engineering Reference (IM 32Q04B10-31E)
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C4. Upgrading the ProSafe-RS Software

This section explains the procedure to follow when upgrading the ProSafe-RS software and
tasks to be performed after upgrading.
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C4.1 Installation for Upgrading

This section explains the procedure to upgrade the ProSafe-RS software already installed on
a computer to a newer version or revision.

TIP

Upgrading the software where the number next to R is incremented by 1 or more, for example from R2.03 to
R3.01, denotes version up, while the number next to R does not change, for example from R2.02 to R2.03,
denotes revision up.

B Items to be Prepared

Prepare the following items so that they are at hand before upgrading the ProSafe-RS soft-
ware.

* ProSafe-RS software medium (Model: CHSKM30)
* ProSafe-RS license medium (Model: CHSCM30)
* ProSafe-RS license sheet (with project ID)

B User Who Performs Update Installation
When update installation is performed, IT security settings are configured following the instal-

lation of the ProSafe-RS software. Update installation must be performed by a user who be-
longs to the groups shown in the following table.

Table C4.1-1 Groups to Which the User Who Performs Update Installation Belongs

Currently applied se- Security model and user management type to be applied

curity model and user Standard model
management type | Legacy model

Standalone type Domain/Combination type

Domain Admins and PSF_MAINTE-
Administrators and PSF_MAINTENANCE | NANCE of the domain (*1)

Legacy model

Standalone | ©f the local computer Administrators and PSF_MAINTE-
type NANCE of the local computer (*1) (*2)
Standard -
model (':Doommbai‘g;/_ Administrators and PSF_MAINTE- Domain Admins and PSF_MAINTE-
tion type NANCE_LCL of the local computer (*1) NANCE of the domain (*1)

*1:  Log on the computer while it is connected to the domain.
*2:  While changing, the user name and password of the domain administrator are required.
B Installing Latest Network Driver

Before upgrading the software, install the latest network driver (included in the new ProSafe-
RS software version to be installed).

This section explains how to upgrade the control bus driver and Vnet/IP open communication
driver.

® Upgrading Control Bus Driver

When you upgrade the control bus driver, uninstall the current control bus driver first and then
install the latest control bus driver.

SEE

ALso For more information about the uninstallation procedure of control bus driver, refer to:
“® Uninstalling Control Bus Driver” on page C6-5
For more information about installing the control bus driver, refer to:

B3.3.1, “Installing the Control Bus Driver” on page B3-33
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® Upgrading Vnet/IP Open Communication Driver

SEE

The procedure to upgrade Vnet/IP open communication driver is the same as the installation
procedure of Vnet/IP open communication driver. If it is necessary to upgrade the Vnet/IP
open communication driver, you can select [INSTALL] in the Setup dialog box.

Be sure to reboot the computer after upgrading the Vnet/IP open communication driver.

ALso For more information about installing the Vnet/IP open communication driver, refer to:

B3.3.2, “Installing the Vnet/IP Open Communication Driver” on page B3-35

B Procedure for Update Installation

Follow these steps below to upgrade the ProSafe-RS software.

TIP

TIP

1.
2.

Log on as an administrative user.

Insert the ProSafe-RS software medium to the drive. The ProSafe-RS installation menu
appears.

If the installation menu does not appears, double-click Launcher.exe in the top folder of
the software medium using Explorer.

Click [ProSafe-RS software].

The Welcome dialog box appears if all the Windows redistribution modules required for
ProSafe-RS have been installed. Proceed to step 6.

The dialog box for confirming module installation appears if any of Windows redistribution
modules required for ProSafe-RS have not been installed.

Click [Install] in the module installation confirmation dialog box. Module installation starts.

If the dialog box for confirming the privilege setting appears, reboot the computer and log
on again.

a. Click [OK] and reboot the computer.

b. After rebooting the computer, log on again as the same user. The Welcome dialog
box appears automatically.

Click [Next] in the welcome dialog box.
The dialog box for confirming installation setup appears.

If a different version of control bus driver or Vnet/IP open communication driver is already installed, a
dialog box appears, prompting you to update the driver. Confirm the message and click [OK]. To update
the control bus driver, uninstall the existing driver and then install the new one after you install the Pro-
Safe-RS software. To update the Vnet/IP open communication driver, install the new driver after you in-
stall the ProSafe-RS software.

After updating the Vnet/IP open communication driver, disable the driver if the computer is to be connec-
ted to Ethernet.

Check the installation settings in the dialog box for confirming installation setup and click
[Install]. The installation of ProSafe-RS starts and the dialog box showing installation pro-
gress status appears.

When you have completed the installation of the ProSafe-RS software, the installation
complete dialog box appears.

If there are no products to be installed subsequently, select [Yes, | want to set up IT se-
curity now.] and click [Finish].

If you intend to continue to install other YOKOGAWA products, select [No, | want to install other software
products.] and click [Finish].
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ﬂ IMPORTANT

If you select [No, | want to install other software products.] here, you must perform IT security
settings when you install the last product.

B Additional Execution of IT Security Configuration

If you are upgrading from R2 where the standard model of security settings are applied, you
must configure IT security settings again in this way: after configuring the IT security settings
following the installation of the product, reboot the computer and then start the IT Security
Tool from the Start menu to configure the IT security settings.

B Tasks Related to Licenses

After making IT security settings, perform the tasks related to licenses.
SEE

ALso For more information about tasks related to licenses, refer to:

B3.6, “Distributing and Accepting Licenses” on page B3-67
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C4.2 Settings after Upgrading ProSafe-RS
Software

This section explains the tasks to be performed after upgrading the SENG software.

Because the SCS databases and SCS system programs that SENG manages are basically
upward compatible, there is no need to modify the engineering data created with earlier ver-
sion software. However, in order to use the new features supported by the newer SCS system
program, re-creation of the SCS project or offline downloading of database to SCS may be
required after upgrading the SENG.

ﬂ IMPORTANT

* The SENGs in the same RS project should have the software of the same release num-
ber.

* Once opening an existing SCS project or creating a new SCS project using newer revi-
sion software in SENG, the SCS project cannot be opened using older revision software.

* The SCS system program release number of SCSs in a system should basically be the
same, but mixture of different release numbers is allowed. However, the SCSs communi-
cating with each other using the Inter-SCS safety communication function must have ap-
propriate release numbers to be compatible.

TIP

If Adobe Acrobat is not installed on the computer, it is recommended to upgrade the software for viewing the
online manual to the Adobe Reader version recommended in this manual.

§|_ES(E) For more information about release numbers of the SENG software and SCS system program in each soft-
ware release and compatibility in inter-SCS safety communication between different revisions, refer to:
C5., “Upgrading to R3.02.20” on page C5-1

Appendix 4., “Compatibility between Revisions and Cautionary Notes for Upgrading” on page
App.4-1

For more information about Adobe Reader settings, refer to:

B4.1, “Online Manual Setting” on page B4-2

B Checking Inconsistency in TCP/IP Settings

After updating the software on the SENG, run the TCP/IP Inconsistency Detection Tool. If any
inconsistencies are found in the setting, make TCP/IP settings again after executing the tool
for repairing inconsistency in TCP/IP setting.

SEE

ALso For more information about the TCP/IP Inconsistency Detect Tool and TCP/IP Inconsistency Repair Tool, re-
fer to:

“@ Procedure 6: Repair TCP/IP Settings” on page B3-52

B Settings after Upgrading Software

After upgrading the ProSafe-RS software, the following procedures need to be performed.

What procedure needs to be performed depends on what new features to be used. User
needs to run the following procedures in accordance with each guideline of the revision up-
grade procedure.
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SEE
ALSO

*  Procedure A: Opening SCS Projects

* Procedure B: Master Database Offline Download

*  Procedure C: Creating New SCS Project and Offline Download

* Procedure D: Setting Definition Items for New Features and Offline Download
* Procedure E: Clean Project, Build and Offline Download

* Procedure F: Setting Definition Items for New Features, Clean Project, Build, and Offline
Download

Generally, only Procedure A needs to be performed after upgrading the software.

IMPORTANT

You must perform one of the above procedures on SCS projects of all the SCSs that commu-
nicate with each other by inter-SCS safety communication. Be sure to perform "Procedure A"
even for the SCSs that do not use new features. Otherwise, an error may occur during build.

For more information about the procedures to use new features in each revision, refer to:
C5., “Upgrading to R3.02.20” on page C5-1

Appendix 4., “Compatibility between Revisions and Cautionary Notes for Upgrading” on page
App.4-1

Procedure A: Opening SCS Projects

After installing the latest revision of software in SENG, use SCS Manger to open the existing
SCS projects created by the older revision software.

The SCS can continue to run. However, only the functions supported with older versions can
be changed online.

IMPORTANT

* The newer revision SCS Manager can simply open the SCS project created by the older
revision SCS Manager.
However, the project created by the older revision workbench can not be opened in the
Read-Only status. It is necessary to open the SCS project in the Read-Write status.

To open the project with password, the password needs to be entered and then open the
project in the Read-Write status.

» ltis necessary to use the newer revision SCS Manager at least once to open the library
created by older revision SCS Manager.

*  Procedure A must be done for the SCS projects of all the SCSs that communicate with
each other by inter-SCS safety communication. Otherwise, an error may occur during
build.

Procedure B: Master Database Offline Download

For using the new features, this procedure may be necessary.

After upgrading the SENG, perform Master Database Offline Download to the SCS. Re-test-
ing of SCS application is not required.
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SEE
ALSO

TIP

The outline of the procedure is as follows:
1. Run Procedure A.

2. Offline download to the SCS using Master Database Offline Download.

For more information about the procedure of Master Database Offline Download, refer to:

9.3, “Master Database Offline Download” in Engineering Reference (IM 32Q04B10-31E)

Procedure C: Creating New SCS Project and Offline Download

For using the new features, this procedure may be necessary.

After upgrading SENG, create a new SCS project and remake the existing SCS project and
then offline download the SCS project.

The procedure is the same as creating a new SCS project. And it is roughly as follows:

1. Create a new project and enter all the project settings.
The existing SCS project can be upgraded to a later revision by using Import/Export func-
tions. Upgrading the SENG to a newer revision and creating a new SCS project, the
whole existing project data can be transferred to the new SCS project.

If the new SCS project uses a library, the library must be opened by a new-revision SCS Manager. However,
if the library POU uses FB/FU supported only by a new revision, create a new library.

When you have upgraded an SENG, you must ensure that all SCS projects and library are of the same revi-
sion as the upgraded SENG.

Follow these steps to upgrade the revision of SCS and library:

1. Open each original library projects to upgrade. Then, copy the library to the predetermined folder, LI-
BRARIES, of the SCS project that uses the library.

2. Open each SCS project to upgrade.

If a project-level password is set for the SCS project or library, you have to enter the password and open it in
ReadWrite mode in order to upgrade. If you do not know the password, contact the creator of the SCS project
and library.

2. Run build, and check the project data using Integrity Analyzer/Cross Reference Analyzer.

3. Offline download the project.

IMPORTANT

The SCS project and library created by an SENG in a revision later than the currently used
revision cannot be used.

* The SCS project created or opened by a new revision of SENG cannot be opened by an
SENG in an earlier revision.

* The library created or opened by a new revision of SENG cannot be added to the SCS
project of an earlier revision.
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SEE

ALSO

SEE

ALSO

For more information about the procedures for transferring the existing SCS project using Import/Export func-
tions, refer to:

2.20, “Import/Export Function” in Engineering Guide (IM 32Q01C10-31E)

For more information about the procedures for migrating the existing SCS project using the Import/Export
functions, refer to:

“m Confirming a Regenerated Project” in 2.20.4, “Data Transfer Procedure During SCS Project Regener-
ation” in Engineering Guide (IM 32Q01C10-31E)

For more information about offline downloading, refer to:

9.1, “Offline Download” in Engineering Reference (IM 32Q04B10-31E)

Procedure D: Setting Definition Items for New Features and Offline
Download

Some new features require this procedure.

Install the new revision of SENG software, set the definition items for the new features, and
offline download the project.

The procedure is as follows:
1. Using SCS Manager, open the old-revision project.

2. Set the definition items for the new features.
The items to be set are described in the section of upgrading procedures for each soft-
ware release number.

3. Run Build. Then use Integrity Analyzer and Cross Reference Analyzer for approval
check.

IMPORTANT

Even if all POUs are displayed in green in the result of checking by Cross Reference Ana-
lyzer, further check is required if Cross Reference Analyzer is unable to detect differences re-
lated to the definition items of the new features.

4. Offline download the project.

For more information about the items that cannot be detected by Cross Reference Analyzer , refer to:

“m Other Changes Not Detectable by Cross Reference Analyzer” in 8.2.5, “Precautions on Cross Refer-
ence Analyzer” in Engineering Reference (IM 32Q04B10-31E)

Procedure E: Clean Project, Build, and Offline Download

Some new features require this procedure.

After upgrading the SENG, run Clean Project and Build for the existing project, and offline
download the project.

The procedure is as follows:
1. Using SCS Manager, open the old-revision project.
2. Run Clean Project.

3. Run Build. Then use Integrity Analyzer and Cross Reference Analyzer for approval
check. In the check using Cross Reference Analyzer, make sure that all POUs are dis-
played in green.

4. Offline download the project.
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® Procedure F: Setting Definition Items for New Features, Clean Project,
Build, and Offline Download

Some new features require this procedure.

This procedure consists of “Procedure D” plus Clean Project.
The procedure is as follows:

1. Using SCS Manager, open the old-revision project.

2. Set the definition items for the new features.
The items to be set are described in the section of upgrading procedures for each soft-
ware release number.

Run Clean Project.

Run Build. Then run Integrity Analyzer and Cross Reference Analyzer for an approval
check.

ﬂ IMPORTANT

Even if all POUs are displayed in green in the result of checking by Cross Reference Ana-
lyzer, further check is required if Cross Reference Analyzer is unable to detect differences re-
lated to the definition items of the new features.

5. Offline download the project.
SEE

ALso For more information about the items that cannot be detected by Cross Reference Analyzer , refer to:

“m Other Changes Not Detectable by Cross Reference Analyzer” in 8.2.5, “Precautions on Cross Refer-
ence Analyzer” in Engineering Reference (IM 32Q04B10-31E)
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C4.3 Upgrading the Computer Dedicated to
License Management

This section describes how to upgrade the computer dedicated to license management.

B Upgrade Procedure

1. Install only the license management software from the ProSafe-RS software medium.

TIP When upgrading the computer dedicated to license management, you can install the license management
software in the same way as when it is installed for the first time. However, you are not required to enter the
following items because the data already set are applied.

* Name
+ Company name

* Installation folder

2. Configure IT security settings.

§|_ES(E) For more information about configuring the IT security settings, refer to:
B3.5.2, “Running the IT Security Tool” on page B3-62
For more information about installing the license management software, refer to:

B6., “Setting Up the Computer Dedicated to License Management” on page B6-1
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C5. Upgrading to R3.02.20

This section describes the cautions that you must exercise when upgrading from R3.02.10 to
R3.02.20. Before you upgrade, also read the cautionary notes for upgrading to the previous
versions that were issued after the software version currently installed on your computer and
perform the required tasks for each upgrade.

ﬂ IMPORTANT

We recommend that you use the R5.04.00 or a later version of CENTUM VP when integrating
ProSafe-RS with CENTUM VP.

B Software Revisions

The respective software release number of R3.02.20 is as follows:

Software Release R3.02.20 (*1)
»  SENG software release number: R3.02.20 (*1)

+ SCS system program release number: R3.02.20 (*1)

*1:  The last two digits of the release number will be changed in accordance with the software revisions after the release of
R3.02.20.

® Inter-SCS Safety Communication

The release number of the SCS system program of an SCS that performs Inter-SCS safety
communication with SCS with system program version R3.02.20 must be R1.01.30 or later.

If Vnet/IP is used for route of the Inter-SCS safety communication, the system programs on
the SCSs must be of R1.02 or later.

® Control bus Drivers

The control bus drivers that are installed on the computer should be upgraded to the version
supplied in R3.02.20.

SEE

ALso For more information about how to update the control bus driver, refer to:

“® Upgrading Control Bus Driver” on page C4-2

B Basic Procedure for Upgrading

To use the features added or modified, install the ProSafe-RS software R3.02.20 or later and
open the existing SCS project.

B Procedure for Using New and Modified Features

The following features added and upgraded in R3.02.20 cannot be used by the basic proce-
dure for upgrading the revision. After the SENG software has been upgraded to R3.02.20, the
steps such as offline downloading to SCS are required. Follow these steps to use each func-
tion.

EE . . . ,
ALso For more information about settings after upgrading software, refer to:

“@ Settings after Upgrading Software” on page C4-5
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® ProSafe-SLS Communication Function

To collect ProSafe-SLS data or events in SCS by using the ProSafe-SLS communication
function, you need to perform "Procedure D" on an SENG of R3.02.20 or later.

® DNP3 Slave Function

To start communications from a DNP3 master by using the DNP3 slave function, you need to
perform "Procedure C" on an SENG of R3.02.20 or later.
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C6. Uninstalling the ProSafe-RS
Software

This section describes how to uninstall the ProSafe-RS software and network drivers. Proce-
dures are provided for the following two cases:

* Uninstallation on SENG

« Uninstallation on the computer dedicated to license management

Note, however, that uninstalling the ProSafe-RS software does not remove the project data-
base, user settings, registries, and so on. If you need to remove ProSafe-RS software com-
pletely, reinstall your operating system.
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C6.1 Uninstallation on SENG

This section describes the procedures for uninstallation on SENG.
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C6.1

TIP

N

Uninstalling the ProSafe-RS Software

If you uninstall the ProSafe-RS software, the license management software is also uninstal-
led. However, the license management data, IT Security Tool, and project data will not be de-

leted.

The IT Security Tool is also used by YOKOGAWA products other than ProSafe-RS. Therefore, even if you
uninstall the ProSafe-RS software, the Start menu setting, programs and files of the IT Security Tool will not
be removed. To completely uninstall the IT Security Tool, you need to uninstall all the products that use the IT
Security Tool and then run the command for uninstalling the IT Security Tool.

B Deleting and Deactivating the Licenses

If there are any active licenses distributed on the SENG PC, delete the licenses to deactivate
the software packages before uninstalling the ProSafe-RS software.

SEE

ALso For more information about how to deactivate software packages on a computer, refer to:

“m Deleting a license from a license-assigned station” in 3.2.1, “Modifying license assignments” in Li-

cense Management (IM 32Q01C60-31E)

B Uninstallation Procedure

After deactivating the packages (deleting the licenses), follow these steps to uninstall the Pro-

TIP

Safe-RS software:

1. From the Start menu, select [Control Panel] > [Programs] > [Programs and Features].

The following window appears.

[=[ElEE]

s
E » Contral Panel » Programs » Programs and Features
o

v [ 4 | Search P

ograms ond Features. O |

Control Panel Home "

Uninstall or change a program
View installed updates

& Turn Windows features on or

Bt Organize v

Name Publisher

B8 Adobe Reader X (10.01)

EIntel(R) Network Connections 15.7176.0

[57] Microsoft Visual C++ 2008 Redistributable - 86 9.0.3...
57 MSKML 4.0 5P3 Parser

B snagita13

[ YOKOGAWA ProSafe-RS

Adobe Systems Incorporated
Intel

Microsoft Corporation
Microsoft Carporation
TechSmith Corporation
Yokogawa Electric Corporation

To uninstall a pragram, select it from the list and then click Uninstall, Change, or Repair.

Installed On
4/2772011
12/28/2010
2172011
472172011
4/21/2011
6/20/2011

Size

= @
Version
1001
1571760
9.0.30729
43021000
91314
30100

111 MB
137 MB
596 KB
147 MB
59.1 MB
283 MB

@ if

=1

kg

Currently installed programs Total size: 469 MB

6 programs installed

Figure C6.1.1-1 Programs and Features

2. Select [YOKOGAWA ProSafe-RS] and click [Change].
The Welcome dialog box appears.
3. Click [Next].
A dialog box for confirming the uninstallation appears.
4. Click [Remove].

Uninstallation starts and a dialog box showing the progress of uninstallation appears.

If any active license is found, a dialog box appears confirming the continuation of the uninstallation process.
Select [Yes] to continue the uninstallation. The active licenses are deactivated at this point.

However, the license information on the license management station remains unchanged. Update the license

information on the license management station as necessary.
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5. If a User Account Control dialog box appears, click [Yes] or [Allow].

TIP

If you leave the User Account Control dialog box without clicking [Yes] or [Allow], the dialog box closes auto-
matically. Then, a dialog box indicating failure of uninstallation appears, and the uninstallation is discontinued.
In this case, run the uninstallation again.

6. In the uninstallation complete dialog box that appears upon completion of the uninstalla-
tion, do either of the following operations.:

To restart the computer now, select [Yes, | want to restart my computer now.] and
click [Finish].

To restart the computer later, select [No, | will restart my computer later.] and click
[Finish].
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C6.1.2

Uninstalling the Network Drivers

This section describes how to uninstall the network drivers.

B Uninstalling Control Bus Driver

Follow these steps to uninstall the control bus driver:

1.
2.
3.

Log on as an administrative user.

Terminate all applications that are running.

Set the ProSafe-RS software medium in the drive.

+ If the AutoPlay dialog box appears, click [Run Launcher.exe].

+ If the AutoPlay dialog box does not appear, use Explorer and double-click Launch-
er.exe in the top folder of the software medium.

The installation menu appears.

Click [Control Bus Driver].
The following dialog box appears.

Welcome

This program let you install or uninstall Vnet Driver.
Choose one of the options below.

 INSTALL
Install Vnet Driver to your system.

¥ UNINSTALL
Remove installed Vet Driver .

o] conc

Figure C6.1.2-1 Setup Selection Dialog Box

5.

8.

Select [UNINSTALL] and then click [OK].
A dialog box appears, confirming the uninstallation.

Click [OK].
The uninstallation starts.

In the uninstallation complete dialog box that appears upon completion of the uninstalla-
tion, click [OK].

Restart the computer.

ﬂ IMPORTANT

After uninstalling the driver, run the TCP/IP Inconsistency Detection Tool.

If any inconsistency is detected, use the TCP/IP Inconsistency Repair Tool and then configure
the TCP/IP settings again.

SEE

ALso For more information about the TCP/IP Inconsistency Detect Tool and TCP/IP Inconsistency Repair Tool, re-
fer to:

“@ Procedure 6: Repair TCP/IP Settings” on page B3-52
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B Uninstalling the Vnet/IP Open Communication Driver

Follow these steps to uninstall the Vnet/IP open communication driver:

1. Log on as an administrative user.
2. Terminate all applications that are running.
3. Set the ProSafe-RS software medium in the drive.
+ If the AutoPlay dialog box appears, click [Run Launcher.exe].
« If the AutoPlay dialog box does not appear, use Explorer and double-click Launch-
er.exe in the top folder of the software medium.
The installation menu appears.
4. Click [Vnet/IP Open com driver].
The following dialog box appears.
Vnet/IP Open Communi

Welcome

This program let you install or uninstall Vnet/TP Open Communication Driver.
Choose one of the options below.

€ INSTALL
Install Vnet/IP Open Communication Driver to your system,

(% UNINSTALL
Remove all installed Vnet/IP Open Communication Drivers,

Figure C6.1.2-2 Setup Selection Dialog Box

5.

8.

Select [UNINSTALL] and then click [OK].
A dialog box appears, confirming the uninstallation.

Click [OK].
The uninstallation starts.

In the uninstallation complete dialog box that appears upon completion of the uninstalla-
tion, click [OK].

Restart the computer.

ﬂ IMPORTANT

After uninstalling the driver, run the TCP/IP Inconsistency Detection Tool.

If any inconsistency is detected, use the TCP/IP Inconsistency Repair Tool and then configure
the TCP/IP settings again.

SEE

ALso For more information about the TCP/IP Inconsistency Detect Tool and TCP/IP Inconsistency Repair Tool, re-
fer to:

“@ Procedure 6: Repair TCP/IP Settings” on page B3-52
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C6.2 Uninstallation on the computer Dedicated
to License Management

This section describes the procedure for uninstalling the license management software on the
computer dedicated to license management.

B Running the Uninstallation
Follow these steps to uninstall the license management software:
1. Log on as an administrative user.
2. From the Start menu, select [Control Panel] > [Programs] > [Programs and Features].

3. From the program list, select [YOKOGAWA ProSafe-RS] and click [Change].
The Welcome dialog box appears.

4. Click [Next].
A dialog box for confirming the uninstallation appears.

5. Click [Delete].
Uninstallation starts and a dialog box showing the progress of uninstallation appears.

6. In the uninstallation complete dialog box that appears upon completion of the uninstalla-
tion, do either of the following operations.:

+ To restart the computer now, select [Yes, | want to restart my computer now.] and
click [Finish].

« To restart the computer later, select [No, | will restart my computer later.] and click
[Finish].
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C7. Reinstalling the ProSafe-RS
Software

This section describes how to reinstall the ProSafe-RS Software. The procedures are ex-
plained for the cases when changing and not changing the computer to be used. For each
case, the reinstallation procedure is explained for license-assigned stations and for the li-
cense management station.
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C7.1 When the Computer Used is the Same

This section describes the procedure for reinstalling the ProSafe-RS software to restore the
software when the installed file gets damaged or deleted accidentally. The assumption is that
the computer on which the software is to be installed is the same as before.

The software cannot be reinstalled by overwriting the software already installed. You must first
uninstall the ProSafe-RS software and install the ProSafe-RS software again.

B Reinstallation for a License-Assigned Station

SEE

ALSO

SEE
ALSO

This section describes the reinstallation procedure for a license-assigned station.
The flow of reinstallation is as follows.

Start
Reinstallation

Uninstall

Configure IT Security Settings

Redistribute Licenses from
License Management Station

Configure Function-Specific
Settings

Finish
Reinstallation

Figure C7.1-1 Flow of Reinstallation for a License-Assigned Station

Uninstall the ProSafe-RS Software

Uninstall the ProSafe-RS software.

For more information about the uninstallation procedure, refer to:

C6.1.1, “Uninstalling the ProSafe-RS Software” on page C6-3

Install the ProSafe-RS Software

Install the ProSafe-RS software.

For more information about installing the ProSafe-RS software, refer to:

B3.4, “Installing the ProSafe-RS Software” on page B3-54

Configure IT Security Settings

Configure IT security settings in the same way as that for a new installation of the ProSafe-RS
software.
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SEE

ALso For more information about configuring the IT security settings, refer to:

B3.5, “Configuring IT Security Settings” on page B3-58

® Redistribute Licenses from the License Management Station

Redistribute the licenses from the license management station.

SEE

ALso For more information about redistributing licenses from the license management station, refer to:

3.4, “Redistributing licenses to license-assigned stations” in License Management (IM 32Q01C60-31E)

® Configure Function-Specific Settings

Configure the settings specific to the functions that run on the SENG.

SEE

ALso For more information about configuring the settings specific to each function of SENG, refer to:

B4., “Configuring Function-Specific Settings on SENG” on page B4-1

B Reinstallation for the License Management Station

This section describes the reinstallation procedure for the license management station. The
license management station can be a computer installed with the ProSafe-RS software or a
computer dedicated to license management, where only the license management software is
installed. You need to perform reinstallation according to the type of the license management
station.
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SEE
ALSO

Start
Reinstallation

Back Up License Project (*1)

Uninstall

Install

Configure IT Security Settings

Are License
Projects Displayed in
License Manager?

Yes

Restore License Project

Redistribute Licenses to
License-assigned Stations (*2)

Configure Function-Specific
Settings (*2)

Finish
Reinstallation

*1: If the license project backup is already created, this task is not required.
*2: These tasks are not required for the computer dedicated to license management.

Back Up the License Projects

Back up the license projects managed on the computer.

Figure C7.1-2 Flow of Reinstallation for the License Management Station

For more information about the procedure for backing up the license project, refer to:

3.6, “Backing up and restoring a license project” in License Management (IM 32Q01C60-31E)

Uninstall the ProSafe-RS Software

Uninstall the ProSafe-RS software. For a computer dedicated to license management, unin-
stall the license management software.

For more information about the procedure for uninstallation on an SENG PC, refer to:

C6.1, “Uninstallation on SENG” on page C6-2

For more information about the procedure for uninstallation on the computer dedicated to license manage-
ment, refer to:

C6.2, “Uninstallation on the computer Dedicated to License Management” on page C6-7
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SEE
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SEE

ALSO

SEE
ALSO

SEE
ALSO

SEE
ALSO

Install the ProSafe-RS Software

Install the ProSafe-RS software. For a computer dedicated to license management, install the
license management software.

For more information about installing the ProSafe-RS software, refer to:
B3.4, “Installing the ProSafe-RS Software” on page B3-54
For more information about how to install the license management software, refer to:

B6., “Setting Up the Computer Dedicated to License Management” on page B6-1

Configure IT Security Settings

Configure IT security settings in the same way as that for a new installation of the ProSafe-RS
software.

For more information about configuring the IT security settings, refer to:

B3.5, “Configuring IT Security Settings” on page B3-58

Restore the License Projects

Start the License Manager and then check if license projects are displayed. If not displayed,
you need to restore the license projects from the backup.

For more information about the procedure for restoring a license project, refer to:

“m Restoring a license project in another license management station” in 3.6, “Backing up and restoring a
license project” in License Management (IM 32Q01C60-31E)

Redistribute Licenses to License-Assigned Stations

Redistribute the licenses to the license-assigned stations.

For more information about redistributing licenses from the license management station, refer to:

3.4, “Redistributing licenses to license-assigned stations” in License Management (IM 32Q01C60-31E)

Configure Function-Specific Settings

Configure the settings specific to the functions that run on the SENG.

For more information about configuring the settings specific to each function of SENG, refer to:

B4., “Configuring Function-Specific Settings on SENG” on page B4-1
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C7.2 When the Computer Used is Not the Same

This section describes the procedure for reinstallation on a different computer when the com-
puter installed with the ProSafe-RS software can no longer be used due to damage or other
reasons.

B Reinstallation for a License-Assigned Station

This section describes the reinstallation procedure for a license-assigned station.

The procedure is the same as that for a new setup of SENG except that you need to restore
the data that were backed up.

Start
Reinstallation

Set Up the Hardware

Set Up Windows

Set Up the Network

Install

Configure IT Security Settings

Restore Backed Up Data

Redistribute Licenses from
License Management Station

Create User Accounts

Configure Windows Environment
Settings for Each User

Set Up UPS Service

Configure Function-Specific Settings

Set Up for Connection with
Other Systems

Finish
Reinstallation

Figure C7.2-1 Flow of Reinstallation for a License-Assigned Station
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ﬂ IMPORTANT

For the station name of the new computer, specify the same name as that set on the previous
computer.

A,_ES(E) For more information about the procedures for a new setup of SENG, refer to:
« B3, “Setting Up the SENG” on page B3-1
»  B4., “Configuring Function-Specific Settings on SENG” on page B4-1
* D1, “Connecting YOKOGAWA products” on page D1-1

® Restore the Backed Up Data

Restore the backed up data on the new computer.
SEE

ALso For more information about the backed up data, refer to:

C3., “Backing Up the System” on page C3-1

B Reinstallation for the License Management Station

The license management station can be a computer installed with the ProSafe-RS software or
a computer dedicated to license management. You need to perform reinstallation according to
the type of the license management station.

The procedure is the same as that for a new setup except that the following tasks are in-
volved:

« Back up license projects
* Restore the backed up data
+ Restore the license projects

* Redistribute licenses to the license-assigned stations
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Start
Reinstallation

Back Up License Project

Set Up the Hardware (*1)

Set Up Windows (*1)

Set Up the Network (*1)

Install

Configure IT Security Settings

Restore Backed Up Data

Restore License Project

Redistribute Licenses to
License-assigned Stations (*1)

Create User Accounts (*1)

Configure Windows Environment
Settings for Each User (*1)

Set Up UPS Service (*1)

Configure Function-Specific
Settings (*1)

Set Up for Connection with
Other Systems (*1)

Finish
Reinstallation

*1: For the computer dedicated to license management, these tasks are not required
or may be omitted according to the circumstances.

Figure C7.2-2 Flow of Reinstallation for the License Management Station

ﬂ IMPORTANT

For the station name of the new computer, specify the same name as that set on the previous

computer.
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ALSO
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For more information about the procedures for a new setup of SENG, refer to:
» B3, “Setting Up the SENG” on page B3-1
« B4., “Configuring Function-Specific Settings on SENG” on page B4-1
D1, “Connecting YOKOGAWA products” on page D1-1

For more information about the procedure for a new setup of a computer dedicated to license management,
refer to:

B6., “Setting Up the Computer Dedicated to License Management” on page B6-1

Back Up the License Projects

Back up the license projects managed on the previous computer.

For more information about the procedure for backing up the license projects, refer to:

3.6, “Backing up and restoring a license project” in License Management (IM 32Q01C60-31E)

Restore the Backed Up Data

Restore the backed up data on the new computer.

For more information about the backed up data, refer to:

C3., “Backing Up the System” on page C3-1

Restore the License Projects

Restore the license projects from the backup.

For more information about the procedure for restoring the license projects, refer to:

“m Restoring a license project in another license management station” in 3.6, “Backing up and restoring a
license project” in License Management (IM 32Q01C60-31E)

Redistribute Licenses to License-Assigned Stations

Redistribute licenses to the license-assigned stations.

For more information about redistributing licenses from the license management station, refer to:

3.4, “Redistributing licenses to license-assigned stations” in License Management (IM 32Q01C60-31E)
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C8. Maintenance Tasks Related to IT
Security

This section describes the tasks related to IT security settings that are performed apart from
new or upgrade installation of the ProSafe-RS software.
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C8.1 Changing the IT Security Settings

This section describes how to change the security settings that have been applied.
Changing the security settings may do the following:
» Change the security model

+ Change the user management type

* Change Individual setting items

ﬂ IMPORTANT

Before you change the IT security settings, take a backup of the current security settings.

SEE

ALso For more information about the explanation of how to back up security settings, refer to:

C8.2, “Saving the IT Security Settings” on page C8-8

B Confirming the Applied Security Model and User Management Type

You can confirm the currently applied security model and user management type.

SEE

ALSO ror more information about how to check the currently set security model and user management type, refer
o:

“m Find Out the Applied Security Model and User Management Type” in 6.1, “IT Security Tool” in Pro-
Safe-RS Security Guide (IM 32Q01C70-31E)
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C8.1.1 Procedures for SENG PC

This section describes the procedures for changing the security settings on an SENG PC.

B Precautionary Notes
Precautionary notes on changing IT security settings on a computer installed with ProSafe-RS
software are as follows:
® Note on Changing the Security Model to Legacy Model

When you have changed to the Legacy model for a system using Windows authentication,
which is a user authentication mode available with the access control and operation history
management functions, you must configure the settings for using ProSafe authentication.

SEE

ALso For more information about required settings for ProSafe authentication mode, refer to:

* “m Specifying the User Authentication Mode” in 16.2.1, “Settings for Access Control” in Engineering
Reference (IM 32Q04B10-31E)

» “m Settings Required When ProSafe Authentication Mode is Selected” in 16.2.1, “Settings for Ac-
cess Control” in Engineering Reference (IM 32Q04B10-31E)

» “m Tasks Required after Changing User Authentication Mode” in 16.3.2, “Operations Performed by
Administrators” in Engineering Reference (IM 32Q04B10-31E)

® Notes on Changing the User Management Type

*  When you change from Standalone management to Domain/Combination management,
create user groups and user accounts in advance using the domain controller.

*  When you change from Standalone management to Domain/Combination management,
add the computer to the domain before applying the IT security settings.

*  When you change from Domain/Combination management to Standalone management,
you may remove the computer from the domain either before or after applying the IT se-
curity settings.

For a system using Windows authentication, which is a user authentication mode available
with the access control/operation history management function, you need to perform the fol-
lowing tasks:

*  When you have changed from Standalone management to Domain/Combination man-

agement or vice versa, you need to set up the users who uses SENG again. If you cre-
ated a new Windows user of SENG, register the user in the Engineers’ Account Builder.

EE , . : ,
§LSO For more information about the tasks on the domain controller and how to add computers to a domain, refer
to:

B2., “Setting Up the Windows Domain Environment” on page B2-1
For more information about the explanation of how to register engineers, refer to:

“m Registering an Engineer's Account” in 16.2.3, “Registering Engineers” in Engineering Reference (IM
32Q04B10-31E)
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B User Who Changes IT Security Settings

Table C8.1.1-1 Groups to Which the User Who Changes IT Security Settings Belongs

Currently applied se-
curity model and user
management type

Security model and user management type to be applied

Standard model

Legacy model

Standalone type

Domain/Combination type

Legacy model

Standard
model

Administrators and PSF_MAINTENANCE
of the local computer

Domain Admins and PSF_MAINTE-
NANCE of the domain (*1)

Standalone Administrators and PSF_MAINTE-
type NANCE of the local computer (*1) (*2)
go°r;“b?g_ Administrators and PSF_MAINTE- Domain Admins and PSF_MAINTE-
tion type NANCE_LCL of the local computer (*1) NANCE of the domain (*1)

*1:  Log on to the computer while it is connected to the domain.
*2:  While changing, the user name and password of the domain administrator are required.

B Changing Procedure
1. Log on to the computer as the user who changes the security settings.

2. From the Start menu, click [YOKOGAWA Security] > [IT Security Tool].
The IT Security Tool starts.

Click [Setup].

4. Select the security model and user management type you want to change to.
The rest of the procedure is the same as that for the normal setups.

SEE

ALso For more information about running the IT Security Tool, refer to:

B3.5.2, “Running the IT Security Tool” on page B3-62

B Changing the Security Model when CENTUM VP R4.01 to R4.03 is
Coexisting on the Computer
If CENTUM VP of a version from R4.01 to R4.03 is coexisting on the computer, the security

model should be changed by a user who belongs to both the PSF_MAINTENANCE and
CTM_MAINTENANCE groups.

In this case, change the security model for CENTUM VP first, and then change the security
model for ProSafe-RS.
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C8.1.2 Procedures for a File Server or Domain Controller

This section describes the procedures for changing the security settings on a computer that
serves only as a file server or a domain controller computer.

ﬂ IMPORTANT

When you change the IT security settings on a file server or domain controller computer, pre-
pare the initial security settings that were saved before using the IT Security Tool.

B User Who Changes IT Security Settings on a File Server

Table C8.1.2-1 Groups to Which the User Who Changes the Security Settings Belongs

Currently applied Security model and user management type to be applied
security model and

user management | Legacy model

Standard model

type Standalone type Domain/Combination type

Administrators | Administrators and
Legacy model of the local PSF_MAINTENANCE of
computer Local Group (*1)

Domain Admins and PSF_MAINTE-
NANCE of the domain (*1) (*2)

Stand- type of the local computer (*1) NANCE of the local computer (*1) (*3)

model

Standalone | Administrators and PSF_MAINTENANCE | Administrators and PSF_MAINTE-

ard Domain/ | Administrators and PSF_MAINTE-

. Domain Admins and PSF_MAINTE-
Combina- | NANCE_LCL of the local computer (*1) e
tion type | (*2) NANCE of the domain (*1) (*2)

*1:

*2:
*3:

If any other YOKOGAWA product coexists in the computer, the user also needs to be a member of the MAINTENANCE group
of the coexisting product. For example, if CENTUM VP coexists, also add the user to the CTM_MAINTENANCE group.

Log on to the computer while it is connected to the domain.

Until you reset the security settings to the initial status, log on the computer while it is standalone. Subsequently, when you
log on the computer to apply security settings, the computer should be connected to the domain.

B User Who Changes IT Security Settings on the Domain Controller

When changing the IT security settings on the domain controller computer, log on the comput-
er as a user who belongs to the Domain Admins and PSF_MAINTENANCE groups of the do-
main.

B Changing Procedure

The following three procedures are described here.

Basic procedure

Procedure to change from Standard model (Standalone management) to Standard model
(Domain/Combination management) on a file server

Procedure to change from Standard model (Domain/Combination management) to Stand-
ard model (Standalone management) on a file server

® Basic Procedure for Changing Security Settings

1.
2.

Log on as the user who changes the security settings.

Start the installation menu from the ProSafe-RS software medium and click [Setting IT
Security (File server/domain controller use)] to start the IT Security Tool.

Click [Restore].

Select a file that the previous security settings are saved prior to running the IT Security
Setting Tool so as to restore the securities.
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SEE
ALSO

For a file server, if it is not a domain member now, use the file holding the initial security
settings that were saved while it was standalone. If it is a domain member now, use the
file holding the initial security settings that were saved after it joined the domain.

After restoring is completed, restart the computer.

For a file server, if its domain membership is to be changed, add to or remove from the
domain.

7. Start the installation menu again and click [Setting IT Security (File server/domain control-
ler use)] to start the IT Security Tool.

Click [Setup].

Select the security model and the user management type you want to change to.
The rest of steps are the same as the procedure for the first time setup.

For more information about how to start the installation menu, refer to:
B3.4, “Installing the ProSafe-RS Software” on page B3-54
For more information about first time setup of IT security settings on a file server, refer to:
B5.1, “Setting Up a Computer that Serves Only as a File Server” on page B5-2
For more information about first time setup of IT security settings on the domain controller, refer to:
B2.3, “Configuring Security Settings for the Domain Controller” on page B2-5
For more information about restoring the IT security settings on the file server or domain controller, refer to:

C8.3.2, “Procedure for a File Server or Domain Controller” on page C8-16

When Changing from Standard Model (Standalone Management) to
Standard Model (Domain/Combination Management) on a File Server

For this change, you need to save the security settings after the file server computer joined a
domain because the security settings are changed by joining the domain. Follow these steps
to make the change:

1. Log on as an administrative user who belongs to the Administrators and PSF_MAINTE-
NANCE groups of the local computer.

Start the installation menu from the ProSafe-RS software medium.
Click [Setting IT Security (File server/domain controller use)] to start the IT Security Tool.

Restore the initial security settings saved (while the computer is not a member of a do-
main) before you fist time used the IT Security Tool to setup security.

After restarting, add the computer to the domain.
Log on as the same administrative user you previously logged on in step 1.

Start the installation menu and click [Setting IT Security (File server/domain controller
use)].
The IT Security Tool starts.

8. Click [Save].
9. Save the security settings as the initial settings right after it joined a domain.
10. On the IT Security Tool's menu, click [Setup].

11. Select the security model and user management type for the file server, and run the set-
up.

12. After applying the security settings, restart the computer.
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® When Changing from Standard Model (Domain/Combination Management)
to Standard Model (Standalone Management) on a File Server

For this change, the timing of removal from the domain is different from the basic procedure.

1.

© © N o O

Log on as an administrative user who belongs to the Administrators and PSF_MAINTE-
NANCE_CTL groups of the local computer.

Start the installation menu from the ProSafe-RS software medium.
Click [Setting IT Security (File server/domain controller use)] to start the IT Security Tool.

Click [Restore] to restore the initial security settings that were saved (right after the com-
puter joined a domain) before the IT Security Tool was first used to setup security.

Restart the computer.

Log on as the same administrative user you previously logged on in step 1.

Start the installation menu from the ProSafe-RS software medium.

Click [Setting IT Security (File server/domain controller use] to start the IT Security Tool.

Click [Setup], select Standard model and Standalone management for the file server, and
run the setup.

10. After applying the security settings, restart the computer.

1.

Remove the computer from the domain.
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C8.2 Saving the IT Security Settings

You can save the security settings on the local computer using the Save function.

The saved IT security settings can be restored by using the Restore function of the IT Securi-
ty Tool as necessary.

B User Who Performs Saving

When performing saving, log on as a user who belongs to the groups shown in the following
table.

Table C8.2-1 Groups to Which the User Who Saves the Security Settings Belongs

Currently applied security model and user management type
Standard model

Legacy model

Standalone type Domain/Combination type
Administrators and PSF_MAINTE-
Administrators of the lo- | Administrators and PSF_MAINTE- NANCE_LCL of the local computer
cal computer NANCE of the local computer Domain Admins and PSE MAINTE-
NANCE of the domain

B Regarding the Files that Hold the Saved Security Settings

Saving the security settings creates two files with extensions of .hed and .csf.
When restoring the saved security settings, both files are required.

IM 32Q01C50-31E 4th Edition : Jan.30,2015-00



<C8.2 Saving the IT Security Settings> C8-9

C8.2.1 Procedure for SENG PC

This section describes the procedure for saving the security settings on an SENG PC.

B Saving Procedure

1.  From the Start menu, click [YOKOGAWA Security] > [IT Security Tool].
The IT Security Tool starts.

2. Click [Save].
The Specify destination page appears.

IT Security Tool - Save
Specify destination
Destination D
Distinguished Name
Support Product
Support 05: [C] Windows 7
[] Windows Server 2008 R2
[7] Windows Server 2008
[] Windows Vista
[] Windows Server 2003 R2
[] Windows Server 2003
[T Windows XP
File Version:
i Mezt ] [ Cancel

Figure C8.2.1-1 Specify Destination

3. Specify the destination folder and enter other required settings.
The Distinguished Name and File Version are omissible.

4. Click [Next].
The Type default account password page appears.
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IT Security Tool - Save

Type default account password

Type password

Retype password:

o J[ v ] [ s

Figure C8.2.1-2 Type Default Account Password

5. Enter the password for use as the initial account password and click [Next].

TIP

This password will be used to recover the saved accounts. If the saved accounts are not found on the com-
puter when you recover the accounts, new accounts are created. All the created accounts will be assigned
with a same password.

If password policy is set and the account password does not meet the password policy, an error will occur
when recovering an account.

You will be prompted to change the password when log on this account next time.

The page for entering the password for use as the encryption key of the saved data ap-
pears.
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IT Security Tool - Save

Type password (Encryption Key)

Type password (Encryption Key):

Retype password (Encryption Key):

Figure C8.2.1-3 Type Password (Encryption Key)

6. Enter the Encryption Key and then click [Next].
Saving of the security settings starts.

ﬂ IMPORTANT

« If this password (encryption key) is lost, the saved security settings cannot be restored.
The password (encryption key) must be carefully kept by the customer.

* The password (encryption key) must be at least one character.

* The password can consist of upper-case and lower-case alphanumeric characters and
the following symbols: "~ 1@ #$ % & *() _+-={}|\:“;'<>7?,./

Double-byte characters cannot be used.

7. When the saving is completed, click [Finish].
If the saving failed, the details of the failure are displayed.

8. On the IT Security Tool menu, click [Close].

AN\ MPORTANT
If any save failures are displayed, contact YOKOGAWA Service.

IM 32Q01C50-31E 4th Edition : Jan.30,2015-00



<C8.2 Saving the IT Security Settings> C8-12

C8.2.2 Procedure for a File Server or Domain Controller

To save the IT security settings on a computer that serves only as a file server or a domain
controller computer, start the installation menu from the ProSafe-RS software medium and
click [Setting IT Security (File server/domain controller use)] to start the IT Security Tool. The
rest of steps are the same as the procedure for an SENG PC.

SEE

ALso For more information about how to start the installation menu, refer to:

B3.4, “Installing the ProSafe-RS Software” on page B3-54
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C8.3 Restoring the IT Security Settings

You can restore the security settings of a local computer that were saved by using the Save
function.

B Preparation for Restoration

According to the user management type of the security settings to be restored, the computer
may be required to join a domain or removed from a domain. To restore to the Legacy mode
or Standard model with Standalone management, the computer needs to be removed from a
domain. To restore to the Standard model with Domain or Combination management, the
computer needs to join a domain.

B User Who Performs Restoring

Log on as a user who belongs to the groups shown in the following table.

Table C8.3-1 Groups to Which the User Who Restores the Security Settings Belongs

Security model and user management type to be restored to
Standard model

Legacy model

Standalone type Domain/Combination type
Administrators and PSF_MAINTE-
Administrators of the lo- | Administrators and PSF_MAINTE- NANCE_LCL of the local computer (*1)
cal computer NANCE of the local computer Domain Admins and PSF MAINTE-
NANCE of the domain

*1:  Log on as a user who belongs to these groups when the PSF_MAINTENANCE_LCL group does not exist on the local com-

puter (that is, when the security model and user management type set before restoration is Legacy model or Standard model
with Standalone management ).
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C8.3.1 Procedure for SENG PC

This section describes the procedure for restoring the security settings on an SENG PC.

B Restoring Procedure

1. Click [YOKOGAWA Security] > [IT Security Tool] from the Windows Start menu.
The IT Security Tool starts.

2. Click [Restore].
The Select Security Setting File page appears.

IT Security Tool - Restore
Select Security Setting File
Setting File D
Description of Setting File
Setting tem Description
i Mezt ] [ Cancel

Figure C8.3.1-1 Select Security Setting File

3. Click [...] next to the Setting File box.
The Open dialog box appears.

4. Select the file you want to use for restoration and then click [Open].

TIP

Of the files that were created when the security settings were saved, select the file with .hed extension.

A dialog box appears, prompting you to enter the password (encryption key) for reading
the selected file.

5. Enter the password (encryption key) that was set when the file was saved and click [OK].
If the selected file is restorable, the details are displayed in the Select Security Setting
File page.

6. Click [Next].
The Confirm Setting Information page appears.
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P

Confirm Setting Information

The setting contents are as follows.

Setting ftem

Creation of user/group

Description

Changing IT environment settings - Applying't...

Sets the Password Policy.

Creste the necessary users and groups.

Access control

Set issions on folders and files for each product

Access Control for DCOM (OPC) objects

Sets the COM authentication level and port range. Grants access p

Personal firewall tuning

Sets firewall policies.

Stop unnecessary Windows Services

Stop unnecessary Services

Changing IT environment settings - Applying t.

. | Set account lockout policy.

Changing IT environment settings - Applying t...

Set audit policy.

Local security

Sets the rights required to run products.

Changing IT environment settings - Security ...

Set security options.

Changing IT environment settings - Restrictio....

Disable Autorun.

Changing IT environment settings - Disabling ...

Disable NetBIOS over TCP/IP.

Changing IT environment settings - Applyingt...

Set read only on removable media. This function can not work on Wy

Shared Folders Set shared folders.

Edit Registry Edit registry.

4 n )
[ o J[ Mt ] [ Comn

Figure C8.3.1-2 Confirm Setting Information

TIP

Iltems displayed in the Confirm Setting Information page represent the items accessed when restoring the

saved security settings. Although the descriptions of these items are affirmative sentences, it doesn't mean
that all of these settings will be applied. Note that the status of whether each item is set to be applied or not is
not displayed on the screen.

7. Confirm the settings and click [Next].
When the setup process is complete, the Setup Completed page appears.

TIP

If there are any items that failed to be set, a list of failed items is displayed.

8. Select the check box for [Restart Now] and click [Finish].

9. Click [Close] to end the IT Security Tool.

ﬂ IMPORTANT

If any setup failures are displayed, contact YOKOGAWA Service.
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C8.3.2 Procedure for a File Server or Domain Controller

To restore the IT security settings on a computer that serves only as a file server or a domain
controller computer, start the installation menu from the ProSafe-RS software medium and
click [Setting IT Security (File server/domain controller use)] to start the IT Security Tool. The
rest of steps are the same as the procedure for an SENG PC.

SEE

ALso For more information about how to start the installation menu, refer to:

B3.4, “Installing the ProSafe-RS Software” on page B3-54
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C8.4 Changing the Security Setting File
Password

You can change the password (encryption key) for security setting files used by the IT Securi-
ty Tool.
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C8.4.1 Procedures for SENG PC

This section describes the procedure for changing the password (encryption key) for security

setting files on an SENG PC.

B Changing Procedure

1. Log on as a member of the PSF_MAINTENANCE group (or as an administrative user
when the Legacy model is applied), and click [YOKOGAWA Security] > [IT Security Tool]

TIP

from the Start menu.
The IT Security Tool starts.

2. Click [Change Password (Encryption Key)].
The Specify backup file of security page appears.

IT Security Tool - Change Password (Encryption Key)

Specify backup file of security

Apply Change to
@ Single File

() Multiple Files

Source: E]
Destination E]
[ Mex | [ Concel

Figure C8.4.1-1 Specify backup file of security

3. Select either of the Apply Change to options and set as follows:

* If you just want to change the encryption key of one file, select [Single File], and then
specify the source file and the name of the folder to which the file after conversion is

to be saved.

» If you want to change the encryption key of multiple files in a folder, select [Multiple
Files], and then specify the source file folder and the folder to which the files after

conversion are to be saved.

The encryption key for a pair of saved files (with .hed and .csf extensions) should be changed to the

same encryption key.

When [Single File] is selected, you can change only one file at a time. So, you need to do the operation

twice to change for both .hed file and .csf files.

When [Multiple Files] is selected, all the files in the specified source folder are changed together.

The files generated in the destination folder will have the same file names as those in the source folder.

Ensure that all the files in a folder have the same encryption key.
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4. Click [Next].

The Change Password (Encryption Key) page appears.

IT Security Tool - Change Passwerd (Encryption Key)

Change Password (Encryption Key)

Type old password (Encryption Key):

Type new password (Encryption Key):

Retype new password (Encryption Key):

[ ][ e ] [ cmes

Figure C8.4.1-2 Change Password (Encryption Key)

5. Enter the old and the new encryption keys and click [Next].

When the changing process is completed, the Changed Password (Encryption Key) page

appears.
6. Click [Finish].

Click [Close] on the IT Security Tool menu.
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C8.4.2 Procedure for a File Server or Domain Controller

This section describes the procedure for changing the password (encryption key) for security
setting files on a computer that serves only as a file server or a domain controller computer.

B Changing Procedure

1. Log on as a member of the PSF_MAINTENANCE group (or as an administrative user
when the Legacy model is applied).

2. Start the installation menu from the ProSafe-RS software medium, and click [Setting IT
Security (File server/domain controller use)] to start the IT Security Tool.
The rest of steps are the same as the procedure for an SENG PC.

SEE _ _ . .
ALso For more information about how to start the installation menu, refer to:

B3.4, “Installing the ProSafe-RS Software” on page B3-54
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C9. Troubleshooting

This section describes the causes of and remedies for problems that may occur.
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C9.1 Windows Related Troubleshooting

This section describes how to handle problems related to Windows.

B Note on User Account Control

If you log on as a non-administrative user and try to start the installer, the following dialog box
appears. Click [No] and log on again as an administrative user, and then start the installer
again.

) Do you want to allow the following program to make

&/ changes to this computer?

@ Program name:  Yokogawa Vnet Driver setup command
Verified publisher: Yokogawa Eectric Corporation
File origin: Hard drive on this computer

To continue, type an administrator password, and then click Yes.
—

MAINTENANCE

Password

(%) Show details

Figure C9.1-1 User Account Control Dialog Box (When Logged on as a Non-administrative User)

B The System Locks Up
Contact YOKOGAWA service.

B Computer Operation Becomes Unstable

If the operation of the computer that was working normally has become unstable, do the task
described below.

® Cause

Incompatible software was installed.

® Remedy

Uninstall the incompatible software you have installed.
SEE

ALso For more information about software that can coexist with ProSafe-RS, refer to:

“®@ Software that can Coexist with ProSafe-RS” on page A3-4
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C9.2 Troubleshooting Related to Network

This section describes how to handle problems related to the network.
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C9.2.1 Precaution on Network Cable Connection

On Windows 7 or Windows Server 2008 R2, the Set Network Location dialog box may appear
when you connect the cables for network connection. If the dialog box appears, select [Public
network].

Select a location for the 'Network’ network

This computer is connected to a network, Windows will autemnatically apply the correct
network settings based on the network's location.

Home network
m | I all the computers on this network are at your home, and you recognize them,
% this is a trusted home network. Don't choose this for public places such as

coffee shops or airports.

Work network

| If all the computers on this network are at your workplace, and you recognize
* them, this is a trusted work network. Don't choose this for public places such as
coffee shops or airports.

Mublic network
' If you don't recognize all the computers on the network (for example, you're in

a coffee shop or airpert, or you have mobile broadband], thisis a public
network and is not trusted.

|| Treat all future networks that I connect to as public, and don't ask me again.
Help me choose

Figure C9.2.1-1 Set Network Location Dialog Box

TIP On Windows Vista or Windows Server 2008, select [Public location].
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C9.2.2 Problems Related to Installation and Deletion of
Drivers

This section provides troubleshooting related to the installation and deletion of network driv-
ers.

ﬂ IMPORTANT

Some operations require administrative rights, and a User Account Control dialog box may
appear when you try to do such operations. You can continue the operation by clicking [Con-
tinue] as long as you have logged on as a user with administrative rights.

B Confirming Installation Result

Check if the network driver is properly installed. If the driver does not appear on Device Man-
ager, you need to install the driver again.

® Control Bus Driver

When the driver is added, “Yokogawa Vnet Adapter” appears under Network Adapters on De-
vice Manager.

If the driver does not start successfully, the “I” symbol appears next to the network adapter
icon.

Follow these steps to display Device Manger:

1. Log on as an administrative user.

2. From the Start menu, select [Control Panel] > [System and Security] > [Device Manager].

TIP

If you are using Windows Vista or Windows Server 2008, select [Control Panel] > [System and Maintenance]
> [System] > [Device Manager].
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TIP

__HT Device Manac

il e B

Eile . View
e | DEIHE & FRS

8 Computer

> e Disk drives

» & Display adapters

> ¢4 DVD/CD-ROM drives

> - Floppy disk drives

b hH Floppy drive controllers

{5 Human Interface Devices

> G IDE ATA/ATAPI controllers

b & Keyboards

b n Mice and other pointing devices

& Monitors

4.8 Network adapters

f Broadcom NetXtreme 57:ox Gigabit Controller
i ]
» B Portable Devices

> 7§ Ports (COM & LPT)

B Processors

b % Sound, video and game controllers
> {8 System devices

- i Universal Senal Bus controllers

Figure C9.2.2-1 Adapter Driver Added Properly

You can check whether the protocol driver is installed properly in this way: from the [View]
menu of Device Manager, enable [Show hidden devices] to display “Yokogawa Vnet Protocol”

driver under Non-Plug and Play Drivers. If the driver is not working properly, the
appears next to the Non-Plug and Play Drivers icon.

symbol

If the “Yokogawa Vnet Protocol” driver is not displayed immediately after it is installed, perform the following.

* For Windows 7 or Windows Server 2008 R2

Restart the computer.

» For Windows Vista or Windows Server 2008
From the [Action] menu, select [Scan for hardware changes].
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e m O Hm & %

4 - %| Non-Plug and Play Drivers

-

Ancillary Function Driver for Winsock

Beep

Bitlocker Drive Encryption Filter Driver

CNG

Commen Log (CLFS)

Disk Virtual Machine Bus Acceleration Filter Driver

| Dynamic Violume Manager

Hardware Policy Driver

;| HTTP

Kernel Mode Driver Frameworks senice

KSecDD

KsecPkg

LDDM Graphics Subsystem

Link-Layer Topology Discovery Mapper 1'O Driver
Link-Layer Topology Discovery Responder
Mount Point Manager

msisadrs

| NDIS System Driver
MNDPromy

NETBT

MNetlO Legacy TDI Support Driver

NSI proxy service driver.

Mull

Offline Files Driver

PEAUTH

Performance Counters for Windows Driver
QoS Packet Scheduler

RDP Encoder Mirror Driver

RDPCDD

Reflector Display Drmver used to gain access to graphics data

Remate Access IPvE ARP Driver

Security Driver

Security Processor Loader Driver

Storage volumes

System Attribute Cache

TCP/TP Protocol Driver

TCP/IP Registry Compatibility

User Mode Driver Frameworks Platform Driver

| VgaSave
| WFP Lightweight Filter

Mnd_uw; Fir_cwall- Mhpfhltinn Driver

Yokogawa Vnet Protocol |

Figure C9.2.2-2 Protocol Driver Added Properly

® Vnet/IP Open Communication Driver

When the driver is added, “Vnet/IP Open Communication Driver (BUS2)” appears in Network
Adapters in Device Manager.

If the driver does not start successfully, the “I” symbol appears next to the network adapter

icon.

Follow these steps to display Device Manger:

1. Log on as an administrative user.

2. From the Start menu, select [Control Panel] > [System and Security] > [Device Manager].
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TIP

If you are using Windows Vista or Windows Server 2008, select [Control Panel] > [System and Maintenance]
> [System] > [Device Manager].

Eile  Action  Miew Help
es 2D BRSNS

& Computer Management (Locall [ « 2 HIS1349 Actions
a §} System Tools 1% Cornputer : =
(@ Task Scheculer i Diiske drives

(8] Event Viewer Ko Display adapters More Actions ;

. G Shared Folders A} DVD/CD-ROM drives
& Local Users and Groups ai Hurman Interface Devices

» (A Performance @ IDE ATA/ATAPI controllers
& Device Manager - = Keyboards

» % Storage Al Mice and other pointing devices
i=f Disk Management & Monitors
By Services and Applications 4 &F Network adapters

¥} Broadcorn MetXtreme 5Txx Gigabit Controlber
‘&* Vnet/IP Open Communication Driver (BUSZ)
& Yokogawa Vinet Adapter
a [ Other devices
ou Ethemet Controller
L PCl Device
- Portable Devices
. ¥ Ports (COM & LPT)
. B Processors
& Sound, video and game controlliers
18 Systern devices
# Universal Serial Bus controllers

Figure C9.2.2-3 Adapter Driver Added Properly

B Control Bus Driver is Successfully Installed but Does Not Start

The control bus driver may not start normally due to wrong connection of the bus cables or
mistakes in address setting. In this case, VLNIC errors are recorded in the System log of
Event Viewer.
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[Fic scin ven top
«=» @ aE

& Computer Management (Local [} ..o/ Date and Time Source EventID TaskCategory ~ | | Actions
a |} System Tools - Symtem
p @TaskScheduler ! Error 2008/02/05 16:30:07 VLNIC 5005 None yste
4 [ Event Viewer oErrur 2008/02/05 16:30:07 VLNIC 5005 None @& Open Saved Log...
b [ Custom Views (@ nformation 2008/02/05 16:30:07 bSTnd60x 15 None | create Custom Views.
[p=! Information 2008/02/05 16:30:03 FilterManager 6 None )
4 [ Windows Logs @ e
5] Application ||| @ nformation 2008/02/0516:3019 EventLog 6013 None Impost Cistom Viel
7] Security (D) Information 2008/02/05 16:30:19 Eventlog 6005 None Clear Log...
] Setup @In!urmalion 2008/02/05 16:30:19 Eventlog 6009 None ¥ Filter Current Log...
Q System @Infurmation 2008/02/05 16:28:53 Eventlog 6006 None D Properties
5] Forwarded Event eror 2008/02/05 16:28:53 Directory-Se... 12291 None .
» B Applications and Se| || &\ Warning 2008/02/05 16:28:52 Time-Service 134 None m Find...
ipti @ 2008/02/05 16:28:50 USER32 1074 None Jed SaveEvents As...
b @l Shared Folders /i, Waming 2008/02/05 16:28:46 Time-Service 134 None View
b 88 Local Users and Groups||f 4\ Warning 2008/02/05 16:28:44 Time-Service 134 None = 8
» @ Reliability and (G Refresh
&j Device Manager Event 5005, VLNIC x Help
a Storage *'—l
9 Disk Management General | Details Event 5005, VLNIC
b iy Services and Applications o = T = I T [Z) Event Properties
‘'okogawa Vnet Adapter : Has encountered an internal error and has failed. @ Attach Task To This Eve
5y Copy
Log Name: System frd Save Selected Events...
Source: VLNIC Logged: 2008/02/05 16:30:07 (G Refresh
Event ID: 5005 Task Category: None Help
Level: Error Keywords: Classic
User: N/A Computer: root-PC
OpCode:
M Event Log Online Help
< m | »
Figure C9.2.2-4 Event Viewer Recording VLNIC Errors (System)
1. Double-click a VLNIC error.
The Event Properties dialog box appears.
Select “Friendly View” Error code

General Details

Binary data:

In Words

0008:

In Bytes

0000: 00080000
00000000
0010: 0O00O000O0OQ

Friendly View ) XML View

00380002
00000000
00000000 00000100

00 02 00

00000000 c0O0013ED
00000000 Q0000000

00010R00

{118

Figure C9.2.2-5 Event Properties

2. Look up the error code in the following table. If the problem is caused by the bus configu-
ration and/or address setting, make sure that the settings are correctly made and shut
down the computer. Then start up the computer again.

Table C9.2.2-1 Error Codes Generated when Starting the Driver

Code (*1)

Meaning

000101**

RAM parity error (failure of VF702/VF701/VI702/V1701 card)

Continues on the next page
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Table C9.2.2-1 Error Codes Generated when Starting the Driver (Table continued)

Code (*1) Meaning
000102** RAM read/write error (failure of VF702/VF701/V1702/V1701 card)
000109** Address overlap error
00010a** Bus configuration error (wrong bus connector connection)
00010b** Dip switch station number parity error
00010c** Dip switch domain number parity error
00010d** Inappropriate dip switch station number setting
00020013 JI[IIigaI) station number (may be detected in the case of bus connector connection mis-
akes

*1:  In the code, a 2-digit number 00 is displayed at the position of ** for VF702/VF701 while others for VI702/VI701.

If the driver still does not start, other possible causes may be a failure of the control bus inter-
face card or Vnet/IP interface card, or conflicts with other devices.

Replace the control bus interface card or Vnet/IP interface card, or remove the other devices
from the computer.

B Duplicate Instances of the Installer

You cannot start two instances of the installer. If you start a second instance, a warning mes-
sage appears. Click [OK] and terminate the installer you started later.

The processing of the installer started first continues.

B Error Message is Displayed during Network Driver Installation — 1

If an error message is displayed when you click [Don't Install] in the Windows Security dialog
box that appears during installation of a network driver, perform the following tasks.

Would you like to install this device software?

=~ MName: Yokogawa Network adapters
5’ Publisher: Yokogawa Electric Corporation

[] Always trust software from "Yokogawa Electric [ nstail | [ Doptinstall |
Corporation”,
@ You should only install driver software from publishers you trust. How can | decide which device

software is safe to install?

Figure C9.2.2-6 Windows Security Dialog Box (for Network Adapter)

i UpdateDriverForPlugAndPlayDevices failure
[PCHVEN_1281 &DEV_00038SUBSYS_00141281] [0x2]

Figure C9.2.2-7 Error Message (for Network Adapter)
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® Control Bus Driver
1. After restarting the computer, click [Control Bus Drier] on the installation menu.
2. If the control bus driver can be deleted, delete it and then restart the computer.

3. Install the control bus driver again.

® Vnet/IP Open Communication Driver

Start the installer again.

B Error Message is Displayed during Network Driver Installation — 2

If an error message is displayed when you did not click [Do not install] in the Windows Securi-
ty dialog box (for confirming installation of the network protocol or network adapter) that ap-
pears during installation of a network driver, perform the following tasks.

® Control Bus Driver
1. After restarting the computer, click [Control Bus Driver] on the installation menu.
2. Perform either of the following operations:
» If the control bus driver can be deleted, delete it and then install the driver again.

» If the control bus driver cannot be deleted, restart the computer and install the driver
again.

® Vnet/IP Open Communication Driver
1. Start the installation menu again and click [Vnet/IP Open Communication Driver].
2. Perform either of the following operations:

« If the driver can be deleted, delete it and restart the computer. Then, install the driver
again.

» If the driver cannot be deleted, restart the computer and install the driver again.

B Error Message is Displayed during Network Driver Installation — 3

Previously functioning Ethernet communications may fail, generating an error message.

® Cause

* Hardware, such as the Ethernet adapter card and Ethernet cable, is not connected prop-
erly.

* The network binding is not correctly set.

* The TCP/IP communication settings are not correct (IP address, subnet mask, etc.)

® Remedy
* Check the hardware, Ethernet adapter card, and the Ethernet cable.

* In Control Panel, check the “Network and Dial-up Connections” settings.
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B Restarted the Computer After Deleting the Driver without Removing
the Control Bus Interface Card or Vnet/IP Open Interface Card from
the Computer

The actions you should take are described for the control bus driver and for the Vnet/IP open
communication driver.
® Control Bus Driver

If you restart the computer after deleting the control bus driver without removing the control
bus interface card from the computer, Windows judges that the control bus interface card is a
newly added device and displays the following dialog box.

+—| Found New Hardware

Windows needs to install driver software for your Network
Controller

@ Locate and install driver software (recommended)
Windows will guide you through the process of installing driver software
for your device.

. 9 Ask me again later
: Windows will ask again the next time you plug in your device or log on.

@ Don't show this message again for this device
Your device will not function until you install driver software.

Figure C9.2.2-8 Found New Hardware Dialog Box

Click [Ask me again later] here. Then, if you do not install the control bus driver, shut down
the computer and remove the control bus interface card.
® Vnet/IP Open Communication Driver

If you restart the computer after deleting the Vnet/IP open communication driver without re-
moving the Vnet/IP interface card from the computer, Windows judges that the Vnet/IP inter-
face card is a newly added device and prompts you to install the driver for it.

In this case, ignore the prompting message and do not install the driver.
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D. Connection with Other Products

ProSafe-RS can be connected with YOKOGAWA products, such as CENTUM VP, PRM, and
Exaquantum.
When connecting to these products, you may need to change the IT security settings.

This section describes the information and procedures on how to connect various products af-
ter installation.
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D1.

ﬂ IMPORTANT

Connecting YOKOGAWA products

This section describes the settings that are required to connect YOKOGAWA products.

For each connection case, an integration code is assigned. You must perform the tasks that
are required for the corresponding integration code of your connection case.

* Ensure that the security model and the user management type of the products that you
are connecting are the same.

» If the Strengthened model is applied to the products that you want to connect, contact

YOKOGAWA.

EE . . . .
ALso For more information about security models, user management types, users and groups, and security set-

B Integration code

TIP

tings, refer to:

1., “Overview” in ProSafe-RS Security Guide (IM 32Q01C70-31E)

The format of the integration code is as follows:

(Package code 1) - (Package code 2) - (Integration type) - (Revision number)

The following table describes the elements of an integration code.

Table D1-1 Integration code elements

Element

Description

Package code

The code that is assigned to a software package that can be installed independ-
ently on a computer.

First package code is the package code of product 1, and Second package code is
the package code of product 2.

Integration type

The connection setup of various products. The possible values are:

* 01: When products are installed and operated on the same computer, and they
cannot communicate or share files with each other.

* 02: When products are installed and operated on separate computers, and they
can communicate or share files with each other.

* 03: When products are installed and operated either on the same computer or
on separate computers, and they can function together by communicating or
sharing files with each other.

Revision number

The version or revision number of the products that you want to connect.

When the required connection procedures change on release of new versions or
revisions, this revision number is incremented.

The revision number can be from 01 to 99.

You cannot install two products that have integration type 02 on the same computer.
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ﬂ IMPORTANT

In the user's manuals of a product, the settings that are required to connect with other prod-
ucts are explained. However, information about the settings for connection that is provided in
the user's manuals may be inconsistent between the connected products. The reason is that
different products are released at different timings. To get the latest information, refer to the
user's manuals of both products to check the product version number and the revision num-
ber of the integration code for their combination, and use the most recent setting procedure.

® Package codes

The following table describes the package codes of various YOKOGAWA products.

Table D1-2 Package codes

Package code Product Package
0101 CENTUM VP CENTUM VP Standard Operation and Monitoring Function (*1)
0102 CENTUM VP System Builder Function
0108 CENTUM VP Report Package
0153 CENTUM VP SOE Viewer Package
0196 CENTUM VP Project Database
0201 ProSafe-RS Safety System Generation and Maintenance Function Package
0202 ProSafe-RS SOE OPC Interface Package
0203 ProSafe-RS CENTUM VP/CS 3000 Integration Engineering Package
0204 ProSafe-RS FAST/TOOLS Integration Engineering Package
0251 ProSafe-RS SOE Viewer Package
0301 PRM Plant Resource Manager Field Communications Server
0302 PRM Plant Resource Manager Server
0351 PRM Plant Resource Manager DeviceViewer
0401 Exaopc Exaopc OPC Interface Package
0801 Exaquantum PIMS Server
0851 Exaquantum Explorer Client
1202 STARDOM STARDOM FCN/FCJ OPC Server

*1:  As an optional function for this package, Exaopc OPC Interface Package (for HIS) is available. Consolidated Alarm Manage-
ment Function (CAMS for HIS) is included in Standard Operation and Monitoring Function.
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D1.1 CENTUM VP and ProSafe-RS

This section describes the settings when connecting CENTUM VP and ProSafe-RS.
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D1.1.1 CENTUM VP Standard Operation and Monitoring
Function and ProSafe-RS Safety System Generation
and Maintenance Function Package

Connecting CENTUM VP Standard Operation and Monitoring Function and ProSafe-RS Safe-
ty System Generation and Maintenance Function Package or SOE Viewer Package enables
historical information of CENTUM VP HIS to be viewed on ProSafe-RS SOE Viewer.

B Viewing Historical Information of CENTUM VP on ProSafe-RS SOE
Viewer

The following table shows the connection information. For required procedures for connec-
tion, read the descriptions that follow the table.

TIP

You can also use the same procedures to view the SOE event messages of ProSafe-RS on the CENTUM
SOE Viewer.

Table D1.1.1-1 Connection information

Integration code | 0101-0201-03-02
0101-0251-03-02
0153-0201-03-02

Product 1 Standard Operation and Monitoring Function of CENTUM VP R5.03
SOE Viewer Package of CENTUM VP R5.03
Product 2 Safety System Generation and Maintenance Function Package of ProSafe-RS R3.01 or
later
SOE Viewer Package of ProSafe-RS R3.01 or later
Security model Legacy model Standard model
User manage- - Standalone management | Domain/Combination management
ment type
Required proce- | None Refer to "e When the Standard model is applied.”
dures

® When the Standard model is applied

Add the user account for using ProSafe-RS SOE Viewer to the CTM_OPERATOR and
PSF_OPERATOR groups.

For Standalone management, perform this setting on the computer where ProSafe-RS SOE
Viewer is used. For Domain or Combination management, perform this setting on the domain
controller.

SEE

ALso For more information about how to create user accounts and add them to groups in Domain or Combination
management, refer to:
B2.4, “Creating Domain Users” on page B2-9

For more information about how to create user accounts and add them to groups in Standalone management,
refer to:

B3.7.1, “When the Standard Model with Standalone Management Security Settings are Applied” on page
B3-69
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D1.1.2 CENTUM VP Standard Operation and Monitoring

Function and ProSafe-RS SOE OPC Interface
Package

This section explains the required settings when Exaopc OPC Interface Package (for HIS)
(LHS2411) of CENTUM VP and SOE OPC Interface Package (CHS2200) of ProSafe-RS are
installed on the same computer.

If the computer installed with both LHS2411 and CHS2200 comes under either of the follow-
ing cases, perform all the procedures explained for each case.

* The computer installed with LHS2411 and CHS2200 is designated as the OPC server for
OPC communication.

*  The computer installed with LHS2411 and CHS2200 uses OPC client services.

* In a Domain management or Combination management system, the computer installed
with LHS2411 and CHS2200 is designated as the OPC server on an OPC client computer
that is not a member of the domain.

B When the computer installed with LHS2411 and CHS2200 is
designated as the OPC server to communicate with

SEE

ALSO

The following table shows the connection information. For required procedures for connec-
tion, read the descriptions that follow the table.

Table D1.1.2-1 Connection information

Integration code | 0101-0202-01-01
Product 1 Standard Operation and Monitoring Function of CENTUM VP R5.03
Product 2 SOE OPC Interface Package of ProSafe-RS R3.01 or later
Security model Legacy model Standard model
User manage- - Standalone management | Domain/Combination management
ment type
cI?equired proce- |None Refer to "e When the Standard model is applied."
ures

When the Standard model is applied

On the OPC server computer, add the user account for using OPC client services on OPC
client computers to the CTM_OPC and PSF_OPC groups.

For Domain or Combination management, perform this setting on the domain controller. For
Standalone management, create on the OPC server computer a user account with the same
name as the local user who uses OPC client services on the OPC client computer and then
add the user account to the CTM_OPC and PSF_OPC groups.

For more information about how to create user accounts and add them to groups in Domain or Combination
management, refer to:

B2.4, “Creating Domain Users” on page B2-9

For more information about how to create user accounts and add them to groups in Standalone management,
refer to:

B3.7.1, “When the Standard Model with Standalone Management Security Settings are Applied” on page
B3-69

Users who use OPC client services

The following table shows the users who use OPC client services:
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Table D1.1.2-2 Users who use OPC client services

OPC client service User
Report Package (LHS6530) User who logged on to Windows

Access Administrator Package (FDA:21 CFR Part 11 | User who logged on to Windows
compliant) (LHS5170)

OPC client other than CENTUM VP product (*1) Users who use OPC client services

*1:  Functions created using CENTUM Data Access Library (LHS2412) are also included.

B When the computer installed with LHS2411 and CHS2200 uses OPC
client services

SEE
ALSO

The following table shows the connection information. For required procedures for connec-
tion, read the descriptions that follow the table.

Table D1.1.2-3 Connection information

Integration code | 0101-0202-01-01
Product 1 Standard Operation and Monitoring Function of CENTUM VP R5.03
Product 2 SOE OPC Interface Package of ProSafe-RS R3.01 or later
Security model Legacy model Standard model
User manage- - Standalone management | Domain/Combination management
ment type
(Ij?equired proce- |None Refer to "e When the Standard model is applied."
ures

When the Standard model is applied
Add the user account for using OPC client services to the CTM_OPC and PSF_OPC groups.

For Standalone management, perform this setting on OPC client computers. For Domain or
Combination management, perform this setting on the domain controller.

For more information about how to create user accounts and add them to groups in Domain or Combination
management, refer to:

B2.4, “Creating Domain Users” on page B2-9

For more information about how to create user accounts and add them to groups in Standalone management,
refer to:

B3.7.1, “When the Standard Model with Standalone Management Security Settings are Applied” on page
B3-69

Users who use OPC client services

The following table shows the users who use OPC client services:

Table D1.1.2-4 Users who use OPC client services

OPC client service User
Report Package (LHS6530) User who logged on to Windows

Access Administrator Package (FDA:21 CFR Part 11 | User who logged on to Windows
compliant) (LHS5170)

FCS Data Setting/Acquisition Package (PICOT) User who logged on to Windows
(LHS6710)

Continues on the next page
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Table D1.1.2-4 Users who use OPC client services (Table continued)

OPC client service User
Consolidated Alarm Management Function (CAMS User that was specified when setting up the OPC
for HIS) A&E server connection
OPC client other than CENTUM VP product (*1) Users Who Use OPC Client Service

*1:  Functions created using CENTUM Data Access Library (LHS2412) are also included.

When FCS Data Setting/Acquisition Package (PICOT) is used

If FCS Data Setting/Acquisition Package (PICOT) (LHS6710) and HIS type single sign on are
used, also perform the following setting:

For Standalone manage- On the computer running the package, add OFFUSER to the
ment: PSF_OPC group.

For Domain or Combination  On the computer running the package, add OFFUSER to the
management: PSF_OPC_LCL group.

B When the computer installed with LHS2411 and CHS2200 is
designated as the OPC server to communicate with on the OPC
client computer that is not a member of the domain

SEE
ALSO

The following table shows the connection information for the case where Domain or Combina-
tion management is applied and the computer installed with LHS2411 and CHS2200 is desig-
nated as the OPC server on the OPC client computer that is not a member of the domain. For
required procedures for connection, read the descriptions that follow the table.

Table D1.1.2-5 Connection information

Integration code 0101-0202-03-02

Product 1 Standard Operation and Monitoring Function of CENTUM VP R5.03
Product 2 SOE OPC Interface Package of ProSafe-RS R3.01 or later
Security model Standard model

User management type | Domain/Combination management

Required procedures Refer to "e Required procedures for connection."

Required procedures for connection

On the OPC server computer, create a user account with the same name as the local user
who performs OPC communication on the OPC client computer, and then add the user ac-
count to the CTM_OPC_LCL and PSF_OPC_LCL groups.

For more information about how to create user accounts and add them to groups in Standalone management,
refer to:

B3.7.1, “When the Standard Model with Standalone Management Security Settings are Applied” on page
B3-69

For more information about how to create user accounts and add them to groups in Domain or Combination
management, refer to:

B2.4, “Creating Domain Users” on page B2-9

Local Users Who Use OPC Client Service

The following table shows the local users who use OPC client services:
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Table D1.1.2-6 Local Users Who Use OPC Client Service

OPC client service User
Report Package (LHS6530) User who logged on to Windows
OPC client other than CENTUM VP product (*1) Users Who Use OPC Client Service

*1:  Functions created using CENTUM Data Access Library (LHS2412) are also included.
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D1.1.3

CENTUM VP System Builder Function and ProSafe-
RS CENTUM VP/CS 3000 Integration Engineering
Package

By using ProSafe-RS CENTUM VP/CS 3000 Integration Engineering Package, you can build
an integrated system of CENTUM VP and ProSafe-RS.

B Building a system by integrating CENTUM VP and ProSafe-RS

The following table shows the connection information. For required procedures for connec-
tion, read the descriptions that follow the table.

Table D1.1.3-1 Connection information

Integration code | 0102-0203-03-02

0196-0203-03-02

Product 1 System Builder Function of CENTUM VP R5.03
Project Database of CENTUM VP R5.03
Product 2 CENTUM VP/CS 3000 Integration Engineering Package of ProSafe-RS R3.01 or later
Security model Legacy model Standard model
User manage- - Standalone manage- Domain/Combination management
ment type ment
Required proce- | None Refer to "e When the Standard model is applied.”
dures

® When the Standard model is applied

When CENTUM VP project is placed on a computer where SCS Manager is used:

Add the user account for using SCS Manager of ProSafe-RS to the CTM_ENGINEER
and PSF_ENGINEER groups.

For Standalone management, perform this setting on the computer where SCS Manager
is used. For Domain or Combination management, perform this setting on the domain
controller.

When CENTUM VP project is placed on a computer where SCS Manager is not used:

For Standalone management, create a user account with the same name as the user
who uses SCS Manager on the computer where the CENTUM VP project is placed and
then add the user account to the CTM_ENGINEER group.

For Domain or Combination management, add the user account for using SCS Manager
to the CTM_ENGINEER group on the domain controller.

SEE

ALso For more information about how to create user accounts and add them to groups in Domain or Combination
management, refer to:

B2.4, “Creating Domain Users” on page B2-9

For more information about how to create user accounts and add them to groups in Standalone management,
refer to:

B3.7.1, “When the Standard Model with Standalone Management Security Settings are Applied” on page
B3-69
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D1.1.4 CENTUM VP System Builder Function and ProSafe-
RS Safety System Generation and Maintenance
Function Package

By connecting CENTUM VP System Builder Function and ProSafe-RS Safety System Gener-
ation and Maintenance Function Package, you can perform simulation tests of SCS using
SCS simulator of ProSafe-RS.

B Enabling SCS simulation tests using SCS simulator

The following table shows the connection information. For required procedures for connec-
tion, read the descriptions that follow the table.

Table D1.1.4-1 Connection information

Integration code | 0102-0201-03-02
Product 1 System Builder Function of CENTUM VP R5.03
Product 2 IS'i\fety System Generation and Maintenance Function Package of ProSafe-RS R3.01 or
ater
Security model Legacy model Standard model
User manage- - Standalone management Domain/Combination management
ment type
dRequired proce- |None Refer to "e When the Standard model is applied."
ures

® When the Standard model is applied

Add all the user accounts for using SCS Manager of ProSafe-RS or System View of CENTUM
VP to the CTM_ENGINEER and PSF_ENGINEER groups.

For Standalone management, perform this setting on the computer where SCS Manager of
ProSafe-RS and System View are used. For Domain or Combination management, perform
this setting on the domain controller.

SEE

ALso For more information about how to create user accounts and add them to groups in Domain or Combination
management, refer to:

B2.4, “Creating Domain Users” on page B2-9

For more information about how to create user accounts and add them to groups in Standalone management,
refer to:

B3.7.1, “When the Standard Model with Standalone Management Security Settings are Applied” on page
B3-69
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D1.1.5 Required Settings when Integrating with CENTUM
VP R4.01 to R4.03

The same settings are required as those for integrating with CENTUM VP 5.01 or later. How-
ever, the security configuration must be done separately: use the Security Setting Utility for
CENTUM VP and the IT Security Tool for ProSafe-RS. If ProSafe-RS is installed on the same
computer where CENTUM VP is installed, use the Security Setting Utility first and then use
the IT Security Tool of ProSafe-RS to configure security settings. Next, change the authenti-
cation level of COM from "Connect" to "None." Then, make the following settings on ProSafe-
RS and CENTUM.

SEE

ALso For more information about how to change the authentication level of COM, refer to:

“e DCOM setting procedure” in “m Settings for the legacy model” in A3.2, “Settings of the OPC client” in
Open Interfaces (IM 32Q05B10-31E)

B Settings on ProSafe-RS
Make the same settings as when integrating ProSafe-RS with CENTUM VP 5.01.

B Settings on CENTUM
Make the same settings as when integrating ProSafe-RS with CENTUM VP 5.01.

B Settings on a File Server

If you place project data and operation history management databases of ProSafe-RS on a
file server computer storing CENTUM VP project data, set the share name for the ProSafe-RS
database folder on the file server computer, and then run the IT Security Tool of ProSafe-RS.

B Coexisting with Exaopc OPC Interface Package (for HIS)

When CENTUM VP and ProSafe-RS are operating in a domain environment, set as follows:
* Add the CTM_PROCESS user to the PSF_OPC_LCL group.

» If the security model is the Standard model, add the PSF_PROCESS user to the
CTM_OPC_LCL group. If the security model is the Legacy model, add the EXAUSER
user to the CTM_OPC_LCL group.

When CENTUM VP and ProSafe-RS are operating in a workgroup environment, set as fol-
lows:

* Add the CTM_PROCESS user to the PSF_OPC group.

« If the security model is the Standard model, add the PSF_PROCESS user to the
CTM_OPC group. If the security model is the Legacy model, add the EXAUSER user to
the CTM_OPC group.

SEE

ALso For more information about the share name of the ProSafe-RS database folder, refer to:

“@ Procedure 2: Create and Set Up the Shared Folders” on page B5-3
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D1.1.6 Required Settings when Integrating with CS 3000
R3.06 to R3.09

If you integrate ProSafe-RS with CS 3000, computer security cannot be reinforced. You can-
not install both CENTUM and ProSafe-RS on the same computer either. Make the following
settings.

* Select the Legacy model when you run the IT Security Tool.

Create a CENTUM user account (account name: CENTUM) on ProSafe-RS and set the
same password as the CENTUM account on the CENTUM side.
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D1.2 ProSafe-RS and PRM

This section describes the settings when connecting ProSafe-RS and PRM.

TIP

PRM client and ProSafe-RS software can be installed on the same computer; however, special setting is not
required because they do not work in collaboration.
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D1.2.1

SOE OPC Interface Package and PRM Server

Connecting ProSafe-RS and the PRM Server enables PRM to retrieve messages from Pro-
Safe-RS. To perform OPC communication with PRM, the SOE OPC Interface Package
(CHS2200) is required. No setting is required on the PRM Server.

TIP

PRM server and ProSafe-RS cannot be installed on the same computer.

B Enabling PRM to retrieve messages from ProSafe-RS

The following table shows the connection information. For required procedures for connec-
tion, read the descriptions that follow the table.

Table D1.2.1-1 Connection information

Integration code | 0202-0302-02-02

Product 1 SOE OPC Interface Package of ProSafe-RS R3.01 or later

Product 2 Plant Resource Manager Server of PRM R3.10 or later

Security model Legacy model Standard model

User manage- - Standalone management | Domain/Combination manage-

ment type ment

Required proce- | Refer to "e When the Refer to "e Setting the logon type with Standard model", "o

dures Legacy model is ap- Granting remote access permission with Standard model", "e
plied." Creating PRM-related internal user accounts with Standard

model".

® When the Legacy model is applied

1.
2.

Log on by using a user account with administrative rights.

From the Start menu, select [All Programs] > [YOKOGAWA ProSafe] > [SOE OPC Pa-
rameter Setting].
The SOE OPC Interface Settings dialog box appears.

In the OPC Security Settings section, click [Edit].
The Select Logon Type dialog box appears.

Select [Automatically logon the designated user for connecting OPC server.] and select
[Default user of R2.03 and earlier versions], and then click [OK].

® Setting the logon type with Standard model

1.

Log on to the SENG as a member of the PSF_ENGINEER or PSF_ENGINEER_LCL
group.
From the Start menu, select [All Programs] > [YOKOGAWA ProSafe] > [SOE OPC Pa-

rameter Setting].
The SOE OPC Interface Settings dialog box appears.

In the OPC Security Settings section, click [Edit].
The Select Logon Type dialog box appears.

Select [Automatically logon the designated user for connecting OPC server.] and select
[Default user of R2.03 and earlier versions], and then click [OK].

® Granting remote access permission with Standard model

1.
2.

Log on to the SENG as a user with administrative rights.

In the search box displayed at the bottom of the Start menu, enter "dcomcnfg.exe" and hit
the [Enter] key.
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TIP

If a User Account Control dialog box appears, click [Yes].

On Windows Vista or Windows Server 2008, click [Continue].

5.

The component service window appears.

Double-click the [Computer] icon; then right-click the [My Computer] icon that appears,
and select [Properties].

In the Properties dialog box of My Computer, click the COM Security tab, and then click
[Edit Limits] in the Access Permission section.

Grant the remote access permission to ANONYMOUS LOGON, and click [OK].

® Creating PRM-related internal user accounts with Standard model

1.
2.

Log on to the SENG as a user with administrative rights.

To run the PRM internal account creation tool, double-click the following file in the PRM
software medium:

(DVD drive) : \PRM\SecuritySettingUtility\CreatelInternalUserAccount.exe

Two user accounts, PRM_PROCESS and PRM_PROCESS2, are created.

Confirm that the created users are members of the following user group:
PSF_OPC when Standalone management is applied.

PSF_OPC_LCL when Domain management is applied.
PSF_OPC or PSF_OPC_LCL when Combination management is applied.

B Collaborating with a PRM Server of R3.03 to R3.05

To enable collaboration with a PRM server when the security model is the Standard model,
perform the same procedures as those for connection with PRM R3.10 or later.

B Collaborating with a PRM Server of R3.02

To enable collaboration with a PRM server when the security model is the Standard model,
perform the following procedure. Then, set the logon type and grant remote access permis-
sion by using the same procedures as those for connection with PRM R3.10 or later.

® Procedure For Standalone Management

1.

2.

On the SENG running the SOE OPC Interface package, create the program user of PRM.
The user name and password should be as follows.
User name: PRMUSER

Password: PRMUSER
Add the program user you have created to the PSF_OPC group.

® Procedure For Domain Management or Combination Management

1.

On the SENG running the SOE OPC Interface package, create the program user of PRM.
The user name and password should be as follows.
User name: PRMUSER

Password: PRMUSER

2. Add the program user you have created to the PSF_OPC_LCL group.
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D1.3 ProSafe-RS and Exaquantum

This section describes the settings when connecting ProSafe-RS and Exaquantum.
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ProSafe-RS SOE OPC Interface Package and
Exaquantum PIMS Server

Connecting the CHS2200 SOE OPC Interface Package and Exaquantum PIMS Server ena-
bles the Exaquantum PIMS Server to collect SOE data from SCS through the OPC interface.

D1.3.1

B Enabling Exaquantum to collect SOE data from SCS

To use Exaquantum PIMS Server as an OPC client and perform OPC communication with an
SENG running the SOE OPC Interface Package, you need to perform the settings described
below.

The following table shows the connection information. For required procedures for connec-
tion, read the descriptions that follow the table. The logon type setting on the SENG and the
setting to use Exaquantum as an OPC client are mandatory in all cases.

IMPORTANT

As a basic rule, the security model and user management type must be consistent in the
products to be connected. However, ProSafe-RS and Exaquantum can be connected even if
different security model or user management type is applied.

Table D1.3.1-1 Connection information: ProSafe-RS SOE OPC Interface Package and Exaquantum
R2.60 or later

0202-0801-02-01
SOE OPC Interface Package of ProSafe-RS R3.01 or later

PIMS server of Exaquantum R2.60 or later

Integration code
Product 1
Product 2

Security model Legacy model Standard model

User manage- -
ment type

Standalone management | Domain/Combination manage-

ment

Required proce-
dures

Refer to "e Setting the
logon type" and "e
When the Legacy model
is applied to both prod-
ucts."

Refer to "e Setting the logon type" and "e When the Standard
model is applied to both products."

Table D1.3.1-2 Connection information: Different security model - Case 1
0202-0801-02-01

SOE OPC Interface Package of ProSafe-RS R3.01 or later
PIMS server of Exaquantum R2.60 or later

Standard model (ProSafe-RS)
Legacy model (Exaquantum)

Integration code
Product 1
Product 2

Security model

User manage-
ment type of Pro-
Safe-RS

Standalone management Domain/Combination management

Required proce-
dures

Refer to "e Setting the logon type" and "e When the Standard model is applied to Pro-
Safe-RS and the Legacy model to Exaquantum.”

Table D1.3.1-3 Connection information: Different security model - Case 2

Integration code

0202-0801-02-01

Product 1

SOE OPC Interface Package of ProSafe-RS R3.01 or later

Continues on the next page

IM 32Q01C50-31E 4th Edition : Jan.30,2015-00



D1-18

<D1.3 ProSafe-RS and Exaquantum>

SEE

Table D1.3.1-3 Connection information: Different security model - Case 2 (Table continued)

Product 2

PIMS server of Exaquantum R2.60 or later

Security model

Legacy model (ProSafe-RS)
Standard model (Exaquantum)

User manage-
ment type of Exa-
quantum

Standalone management Domain/Combination management

Required proce-
dures

Refer to "e Setting the logon type" and "e When the Legacy model is applied to Pro-
Safe-RS and the Standard model to Exaquantum.”

Table D1.3.1-4 Connection information: Legacy model applied ProSafe-RS and Exaquantum version

earlier than R2.60

Integration code

0202-0801-02-02

Product 1

SOE OPC Interface Package of ProSafe-RS R3.01 or later

Product 2

PIMS server of Exaquantum R2.20 or later but earlier than R2.60

Security model

Legacy model (ProSafe-RS)
- (Exaquantum)

User manage-
ment type

Required proce-
dures

Refer to "e Setting the logon type" and "e When the Legacy model is applied to both
products."

Table D1.3.1-5 Connection information: Standard model applied ProSafe-RS and Exaquantum version

earlier than R2.60

Integration code

0202-0801-02-02

Product 1

SOE OPC Interface Package of ProSafe-RS R3.01 or later

Product 2

PIMS server of Exaquantum R2.20 or later but earlier than R2.60

Security model

Standard model (ProSafe-RS)
- (Exaquantum)

User manage-
ment type of Pro-
Safe-RS

Standalone management Domain/Combination management

Required proce-
dures

Refer to "e Setting the logon type" and "e When the Standard model is applied to Pro-
Safe-RS and the Legacy model to Exaquantum.”

ALso For more information about the details on setting up an OPC client, refer to:

A3., “Setup for using the OPC client” in Open Interfaces (IM 32Q05B10-31E)

® Setting the Logon Type

To connect Exaquantum with an SENG (OPC server) running the SOE OPC interface pack-
age of ProSafe-RS R3.01.00 or later, you need to set the logon type on the SENG before-
hand. After performing this setting, perform the required setting on Exaquantum.

1. Log in to the system as a user belonging to PSF_ENGINEER or PSF_ENGINEER_LCL.

2. From the Start menu, select [All Programs] > [YOKOGAWA ProSafe] > [SOE OPC Pa-
rameter Setting].
The SOE OPC Interface Settings dialog box appears.

3. Click the [Edit] in [OPC Security Settings].
A dialog box where you can select a type of logon to the OPC server appears.
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=)

9 Logon transaction is required for connecting OPC server,

&+ ‘atomatically logon the designated user for connecting OPC server, |

" Designated user

User name I

Password I

Confitm Password I

% Default user of R2.03 and earlier versions

o]

Figure D1.3.1-1 Select Logon Dialog Box

4. Select [Automatically logon the designated user for connecting OPC server.] and then
[Default user of R2.03 and earlier versions], and click [OK].

® When the Legacy model is applied to both products
1. Set the logon type on the SENG.
2. Add an Exaquantum program user on the SENG.

TIP

The name and the password of the Exaquantum program user should be as follows:
User name: Quantumuser (default user name, changeable with a supplied tool)

Password: quantumuser (default password, changeable with a supplied tool)

3. Onthe SENG, create the same user account as the logon user account for running Exa-
quantum.

4. On the SENG and the computer installed with Exaquantum, perform the setting for using
Exaquantum as an OPC client.

® When the Standard model is applied to both products
1. Set the logon type on the SENG.

2. Configure the DCOM settings on the SENG. Refer to the user's manual "Open Interfaces"
for the procedure.

3. Onthe SENG, create QTM_PROCESS, which is the Exaquantum program user account.

a. Insert the Exaquantum software medium and start the command prompt window,
then move to the following folder.
(Drive):\Tools

b. Run the following command.
CreateQTMProcess.exe

The QTM_PROCESS user account is created.

4. Add the QTM_PROCESS user you have created to the following user group on the
SENG.
* In the case of standalone management or when combination management is applied

on some computers: PSF_OPC

* In the case of domain management or when combination management is applied on
all computers: PSF_OPC_LCL
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SEE

On the SENG, create the same user account as the logon user account for running Exa-
quantum and add the created user account to the PSF_OPC group.

On the computer installed with Exaquantum, create the PSF_PROCESS user account.

a. Insert the ProSafe-RS software medium and start the command prompt window, then

move to the following folder.
(Drive):\ProSafe-RS\SECURITY

b. Run the following command.
ProSafe.Security.CreateProSafeProcess.exe

The PSF_PROCESS user account is created.

Add the PSF_PROCESS user you have created to the following user group on the com-

puter installed with Exaquantum.

* In the case of standalone management or when combination management is applied
on some computers: QTM_OPC

* In the case of domain management or when combination management is applied on
all computers: QTM_OPC_LCL

On the SENG and the computer installed with Exaquantum, perform the setting for using
Exaquantum as an OPC client.

ALso For more information about configuring the DCOM settings, refer to:

“m DCOM settings” in A2.2, “Overview of product security settings” in Open Interfaces (IM
32Q05B10-31E)

® When the Standard model is applied to ProSafe-RS and the Legacy model

TIP

1.
2.

3.

to Exaquantum

Set the logon type on the SENG.

Configure the DCOM settings on the SENG. Refer to the user's manual "Open Interfaces"
for the procedure.

Add an Exaquantum program user on the SENG.

The name and the password of the Exaquantum program user should be as follows:

User name: Quantumuser (default user name, changeable with a supplied tool)

Password: quantumuser (default password, changeable with a supplied tool)

4. Add the Quantumuser user you have created to the following user group on the SENG.

* In the case of standalone management or when combination management is applied
on some computers: PSF_OPC

* In the case of domain management or when combination management is applied on
all computers: PSF_OPC _LCL

On the SENG, create the same user account as the logon user account for running Exa-
quantum and add the created user account to the PSF_OPC group.

On the computer installed with Exaquantum, create the PSF_PROCESS user account.

a. Insert the ProSafe-RS software medium and start the command prompt window, then

move to the following folder.
(Drive):\ProSafe-RS\SECURITY

b. Run the following command.
ProSafe.Security.CreateProSafeProcess.exe

The PSF_PROCESS user account is created.
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7.

On the SENG and the computer installed with Exaquantum, perform the setting for using
Exaquantum as an OPC client.

ALES(E) For more information about configuring the DCOM settings, refer to:

“m DCOM settings” in A2.2, “Overview of product security settings” in Open Interfaces (IM
32Q05B10-31E)

® When the Legacy model is applied to ProSafe-RS and the Standard model

1.
2.

to Exaquantum

Set the logon type on the SENG.
On the SENG, create QTM_PROCESS, which is the Exaquantum program user account.

a. Insert the Exaquantum software medium and start the command prompt window,
then move to the following folder.
(Drive):\Tools

b. Run the following command.
CreateQTMProcess.exe

The QTM_PROCESS user account is created.

On the SENG, create the same user account as the logon user account for running Exa-
quantum.

On the computer installed with Exaquantum, create the EXAUSER user account. The
password should also be EXAUSER.

Add the EXAUSER user you have created to the following user group on the computer

installed with Exaquantum.

* In the case of standalone management or when combination management is applied
on some computers: QTM_OPC

* In the case of domain management or when combination management is applied on
all computers: QTM_OPC_LCL

On the SENG and the computer installed with Exaquantum, perform the setting for using
Exaquantum as an OPC client.
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Appendix 1. Setting Switches

You can set the domain number and station number by configuring the setting switches on the
printed circuit board of the control bus interface card and Vnet/IP interface card.

B Domain Numbers and DIP Switch Positions

The following table lists the domain numbers and corresponding setting switch positions for
the control bus interface card and Vnet/IP interface card. Set the DIP switches as shown in
the table to adjust to the required domain number.

Table Appendix 1-1 Domain Numbers and DIP Switch Positions

Domain number DIP switch bit number

1 2 3 4 5 6 7 8
1 0 0 0 0 0 0 0 1
2 0 0 0 0 0 0 1 0
3 1 0 0 0 0 0 1 1
4 0 0 0 0 0 1 0 0
5 1 0 0 0 0 1 0 1
6 1 0 0 0 0 1 1 0
7 0 0 0 0 0 1 1 1
8 0 0 0 0 1 0 0 0
9 1 0 0 0 1 0 0 1
10 1 0 0 0 1 0 1 0
1" 0 0 0 0 1 0 1 1
12 1 0 0 0 1 1 0 0
13 0 0 0 0 1 1 0 1
14 0 0 0 0 1 1 1 0
15 1 0 0 0 1 1 1 1
16 0 0 0 1 0 0 0 0
17 1 0 0 1 0 0 0 1
18 1 0 0 1 0 0 1 0
19 0 0 0 1 0 0 1 1
20 1 0 0 1 0 1 0 0
21 0 0 0 1 0 1 0 1
22 0 0 0 1 0 1 1 0
23 1 0 0 1 0 1 1 1
24 1 0 0 1 1 0 0 0
25 0 0 0 1 1 0 0 1
26 0 0 0 1 1 0 1 0
27 1 0 0 1 1 0 1 1
28 0 0 0 1 1 1 0 0
29 1 0 0 1 1 1 0 1
30 1 0 0 1 1 1 1 0
31 0 0 0 1 1 1 1 1
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B Station Numbers and DIP Switch Positions

The following table lists the station numbers and corresponding setting switch positions for
the control bus interface card and Vnet/IP interface card. Set the DIP switches as shown in

the table to adjust to the required station number.

Table Appendix 1-2 Station Numbers and DIP Switch Positions

Station number

DIP switch bit number
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Table Appendix 1-2 Station Numbers and DIP Switch Positions (Table continued)

Station number

DIP switch bit number

1 2 3 | 4 | 5 | s 7 8
60 1 0 1 1 1 1 0 0
61 0 0 1 1 1 1 0 1
62 0 0 1 1 1 1 1 0
63 1 0 1 1 1 1 1 1
64 0 1 0 0 0 0 0 0
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Appendix 2. Procedure for Erasing VI702
Internal Settings

If you intend to use a V1702 card used in another system for a system configured with Pro-
Safe-RS only, delete the settings within the card using the following procedure.

1.
2.

Turn off the power of the computer. For safety, remove the power plug from the outlet.
Set the DIP switches (SW1) for the domain number on the V1702 as follows:

Table Appendix 2-1 Setting of DIP Switches for Domain Number Setting (SW1)

Bit 1 Bit 2 Bit 3 Bit 4 Bit 5 Bit 6 Bit 7 Bit 8
1 1 0 0 0 0 0 1
Parity MSB LSB

3. Set the DIP switches (SW2) for the station number on the VI702 as follows:

Table Appendix 2-2 Setting of DIP Switches for Station Number Setting (SW2)

Bit 1 Bit 2 Bit 3 Bit 4 Bit 5 Bit 6 Bit 7 Bit 8
0 0 0 0 0 0 0 1
Parity MSB LSB

4. Check that Bit 1 through Bit 4 of the DIP switches (SW4) for the Action Mode are all set to
the off position on the VI702.

5. Remove the cover of the computer.

6. Insert the VI702 in the corresponding slot and fix the card.

7. Put back the cover of the computer.

8. Do not connect the cable to either BUS1 or BUS2.

9. Put back the power cord of the computer.

10. Start the computer, and then go to BIOS setting panel instead of starting Windows. If the
Windows started, it is necessary to shutdown and switch off the computer, and start the
computer for BIOS setting again.

11. Wait for about a minute after BIOS setting panel appears.

12. Turn off the power of the computer. For safety, remove the power plug from the outlet.

13. Remove the VI702 from the slot.

SEE

ALso For more information about how to display the BIOS setting window, refer to:

The manual of the computer
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Appendix 3. Antistatic Precautions When
Handling Hardware

When doing maintenance work, take the following precautions to avoid electrostatic problems.

*  When storing or carrying parts for maintenance, put them in an antistatic bag. (When
shipped, they are placed in an antistatic bag labeled with cautions against electrostatic
problems.)

*  Wear a wrist strap with a 1M ohm grounding resistor then ground the wrist strap.

»  When working on the bench, place the parts on a conductive sheet grounded viaa 1 M
ohm resistor and wear wrist strap. Keep static-chargeable plastic materials away from the
parts.

* Never touch the parts with bare hands, without using a wrist strap and a conductive
sheet.

Conductive sheet

‘ £ Grounding resistance ‘
T of 1 M ohm

Wrist strap

= When working with a product with battery on
Connect the wrist strap to the grounding terminal or a conductive sheet, set the battery ON/OFF
unpainted part of the frame (grounded). switch to the OFF position or remove the battery.

Figure Appendix 3-1 Using a Wrist Strap

The wrist strap and conductive sheet are available from YOKOGAWA sales agents.
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Appendix 4. Compatibility between
Revisions and Cautionary
Notes for Upgrading

ﬂ IMPORTANT

* |tis necessary to contact Yokogawa service agent before performing any operation ex-
plained in this chapter.

* Be sure to take a backup of the whole project before upgrading ProSafe-RS.

This section provides the compatibility information for earlier versions of ProSafe-RS software
released in the past and the cautionary notes for upgrading that were published at the time of
each release. The purpose of this section is to enable users to confirm the procedures for us-
ing the new features supported in each release. This section provides important descriptions
of SCS specifications as compatibility information, enabling users to confirm the specifications
in earlier versions.

When you upgrade ProSafe-RS, install only the software of the release number you want to
use. However, for the required procedures after the installation, read the cautionary notes for
upgrading for all release numbers between the release number of the software currently in-
stalled on your computer and the release number of the software you want to use.

Information on the following upgrading is provided:

* Upgrading the software with a release number older than R1.01.30 to R1.01.30.
* Upgrading the software of R1.01.30 to R1.01.40/R1.01.50.

* Upgrading the software of R1.01.30/R1.01.40/R1.01.50 to R1.02.
* Upgrading the software of R1.02 to R1.03

* Upgrading the software of R1.03 to R2.01

* Upgrading the software of R2.01 to R2.02

* Upgrading the software of R2.02 to R2.03

» Upgrading the software of R2.03 to R3.01

* Upgrading the software of R3.01 to R3.02

* Upgrading the software of R3.02.00 to R3.02.10

IM 32Q01C50-31E 4th Edition : Jan.30,2015-00



<Appendix 4.1 Upgrading to R1.01.30 > App.4-2

Appendix 4.1 Upgrading to R1.01.30

The cautionary notes for upgrading the ProSafe-RS from an earlier version to R1.01.30 will be
explained below.

ﬂ IMPORTANT

When subsystem communication or SYS_SEC_CTL FB are applied while ProSafe-RS

R1.01.30 is integrated with CS 3000, the release number of CS 3000 software must be R3.07
or later.

eV net Driver

Install the V net driver included in the CD-ROM of ProSafe-RS software. However, for the

HIS with the CS 3000 software R3.07 environment, installation of the driver is not nee-
ded.

B Software Revisions
Software revision information in release R1.01.30 and in the earlier releases is as follows:
Software Release R1.01.00
* SENG software release number: R1.01.00
+ SCS system program release number: R1.01.00
Software Release R1.01.10
* SENG software release number: R1.01.10
« SCS system program release number: R1.01.00
Software Release R1.01.30
* SENG software release number: R1.01.30

+ SCS system program release number: R1.01.30

® Inter-SCS Safety Communication

The release numbers of the SCS system programs on SCSs communicating with each other
using the Inter-SCS safety communication function must be the same.

B Procedures for Upgrading

When using the added and upgraded features of R1.01.30, install the ProSafe-RS R1.01.30
or later version of software to SENG and open existing SCS projects. Then the following new
features of R1.01.30 are applicable.

+ SCS information Dialog box
+ Saves and downloads the operation marks

* Locks user-defined FB parameters

SEE

ALso For more information about cautionary notes for opening existing SCS projects, refer to:

“® Procedure A: Opening SCS Projects” on page C4-6
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B Cautions on Using Added and Upgraded Features

SEE
ALSO

A

In order to use the added and upgraded features of R1.01.30, it may be required to perform
offline downloading to the SCS. The related procedures are as follows.

For more information about detailed procedures after the upgrade, refer to:
“®@ Procedure B: Master Database Offline Download” on page C4-6

“@® Procedure C: Creating New SCS Project and Offline Download” on page C4-7

Subsystem Communication (Modbus Communication Package)

When performing the engineering works to apply the Modbus communication package (for
ALR111, ALR121) on SCS, “Procedure C” should be performed on R1.01.30 or later version
SENG. On the SCS State Management Window of SCS maintenance Support Tool and on
the SCS Status view of the CENTUM HIS that has been integrated with ProSafe-RS, the sta-
tus of “Comm. I/O Lock” will be displayed with [No] until the offline download is completed.

Using the FU/FB Added in R1.01.30

In order to use the added FU/FB of R1.01.30 such as SYS_SEC_CTL (for changing SCS se-
curity level), “Procedure C” should be performed on R1.01.30 or later version SENG.

Forcing (SCS Security Level 0)

From R1.01.30, when SCS security level is 0, the values of internal variables and FB parame-
ters can be changed without locking the variable or parameter. However, this change is not
valid if Procedure B is not performed on R1.01.30 or later version SENG.

I/0 Lock Window

In R1.01.30 version, the process of getting data from SCS and displaying them on 1/O Lock
window is changed. This change will become valid after Procedure B is performed on
R1.01.30 or later version SENG.

Inter-SCS Safety Communication

WARNING

After upgrading SENG to R1.01.30 or later version, for the first time offline download to an
SCS is performed while the SCS is running inter-SCS communication with other SCSs, the
Procedure B needs to be performed on R1.01.30 or later version SENG for all the communi-
cated SCSs. When offline download to the SCS that is running inter-SCS communication with
other SCSs, it is necessary to take measures on the other SCSs so as not to cause a nui-
sance tripping.

SCS Start Action when Applied with IRIG-B

In R1.01.30 version, the SCS start action is changed under the circumstance that the SCS is
applied with IRIG-B but the IRIG-B receiver is not connected. This change will become valid
after Procedure B is performed on R1.01.30 or later version SENG.

Handling Messages during SCS Start

In R1.01.30 version, how the SCS during start handles the SOE data and diagnostic messag-
es occurred before SCS stopped is changed. This change will become valid after Procedure
B is performed on R1.01.30 or later version SENG.
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ﬂ IMPORTANT

When the SCS is restarted by Master Database Offline Download, the Diagnostic Information
Window should be closed. If the window is not closed during offline download, it is necessary
to click [Update] button when the SCS start action is completed so as to display the diagnostic
information properly.

B Cautionary Notes for Executing Build after Upgrading SENG

If a user-defined FU satisfying the following conditions is created by an SENG in an earlier
version than R1.01.30 and the SENG is upgraded to R1.01.30 or later, the first Build execu-
tion after the upgrade will cause a Build Error message.

This is because the specification change made in the R1.01.30 to prevent the creation of the
user-defined FUs satisfied the following conditions.

® Conditions that Cause a Build Error
*  FB(s)is used in a user-defined FU.

» Variable(s) of global attributes is used in a user-defined FU.

® Workaround

If an FB or global variable(s) is used in a user-defined FU, change the user-defined FU to a
user-defined FB. An offline download is required after this change.

B Notes on Running Cross Reference Analyzer after Upgrading SENG

If a user-defined FU satisfying the following condition is created by an SENG in an earlier ver-
sion than R1.01.30 and the SENG is upgraded to R1.01.30 or later, the message “Instruction
Modified” appears at the execution of Cross Reference Analyzer after the initial Build execu-
tion.

® Condition for an “Instruction Modified” Notification

If local variable(s) is used in a user-defined FU.

® Background

The following specification change was made in R1.01.30.

Table Appendix 4.1-1 Specification Change

Before If local variable(s) is used in a user-defined FU, local variable(s) is not initialized
every time the user-defined FU is called.

After If local variable(s) is used in a user-defined FU, local variable(s) is initialized ev-
ery time the user-defined FU is called.

The value used for initialization is the initial value defined in Dictionary.

If initial value is not defined in the Dictionary, value will be initialized using the
following:

DINT type: 0

REAL type: 0.0

BOOL type: FALSE

TIME type: t#0s

Notes Local variables in a user-defined FU are initialized every time the user-defined

FU is called.
If local variables are used in a user-defined FU, set values to local variables in

advance.
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® Workaround

Check if the “Instruction Modified” message was caused by the specification change, and
modify the application logic if necessary.

B Cautions on Online Change Downloading after Upgrading SENG

After upgrading SENG from R1.01.10 to R1.01.30 or later version, the first time online down-
load will download all POUs to SCS. Therefore, when running build, a warning message for
locking all the outputs will be prompted.

For the later Online Change Download, it will download only the modified POU to SCS.

It is recommended to run offline download or online change download right after the upgrad-
ing. Thus, the Online Change Download for the later modifications can download only the
modified POU to SCS.

Follow the procedures below to perform either offline downloading or online change download
right after upgrading.

® Offline Download
1. Choose [Clean Project/Library] from [Project] menu.
2. Start [Build].

3. Run offline downloading.

® Online Change Download

1. Choose [Edit Project Description] from [Tools] menu and then click [OK] on the displayed
Project description dialog box.

Save the project.
Start [Build] (a warning message for locking all the outputs will be prompted).

Run Online Change Download.
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Appendix 4.2 Upgrading to R1.01.40/R1.01.50

In this section, the cautionary notes for upgrading to R1.01.40/R1.01.50 will be explained.
Moreover, for upgrading from a release older than R1.01.30 to R1.01.40/R1.01.50, it is neces-
sary to read the cautionary notes for upgrading to R1.01.30 together with this section.

B Software Revisions
Software revision information in release R1.01.40 is as follows:
*  SENG software release number: R1.01.40
+ SCS system program release number: R1.01.30
Software revision information in release R1.01.50 is as follows:
* SENG software release number: R1.01.50

+ SCS system program release number: R1.01.30

® |Inter-SCS Safety Communication

The release numbers of the SCS system programs on SCSs communicating with each other
using the Inter-SCS safety communication function must be the same.

B Procedures for Upgrading

For upgrading from R1.01.30 to a newer version, the ProSafe-RS software needs to be instal-
led into SENG. However, no specific operation is needed for applying the revised and added
features after the installation.

The SCS project and library created or edited in R1.01.30 will be unconditionally converted to
R1.01.40/R1.01.50 when they are first time opened after upgrading to R1.01.40/R1.01.50.
There will be no confirmation dialog box prompts for the conversion.

ﬂ IMPORTANT

When upgrading from a release older than R1.01.30 to R1.01.40/R1.01.50, the cautionary
notes for upgrading an earlier release to R1.01.30 should be referenced. It is necessary to
read all the cautionary notes and then perform the required operations accordingly.

B Note on Upgrading to R1.01.50

If a user-defined FB satisfying the following condition is created by an SENG in an earlier ver-
sion than R1.01.50 and if the SENG is upgraded to R1.01.50 or later and a Build is performed
without modification of the project data, there are cases where an offline download is re-
quired.

® Condition

With POU (program or user-defined FU /FB) created by FBD, if the output of an FU/FB is loo-
ped back to its own input parameter, a variable must be placed in the loop.
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OR

Figure Appendix 4.2-1 Example of Correct Loopback

If a user-defined FB ignoring this rule meets one of the following conditions, an offline down-
load is required.

(Condition 1)

If the “Generate symbols monitoring information” for the user-defined FB is OFF.

(Condition 2)

If the input of the loopback is the output from the FB. (B is FB in the following figure)

A
bO1 B

b03

b02

Figure Appendix 4.2-2 Example of Loopback Requiring an Offline Download

Background

With an SENG in an earlier version than R1.01.50, there are cases where no warning mes-
sage is output at a Build execution for a POU that does not follow the loopback rule.

With an SENG in R1.01.50 or later, the following warning message is always output at a Build
execution for a POU that does not follow the loopback rule.

“WARNING: Used of loop is not recommended.”

If this message appears for a POU after the SENG is upgraded to R1.01.50 or later, place a
variable in the loop.
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Appendix 4.3 Upgrading to R1.02

In this section, the cautionary notes for upgrading from R1.01.30, R1.01.40, or R1.01.50 to
R1.02 will be explained. Moreover, for upgrading from a release older than R1.01.30 to R1.02,

it is necessary to read the cautionary notes for upgrading to R1.01.30 together with this sec-
tion.

ﬂ IMPORTANT

In order to use the new features when the ProSafe-RS R1.02 is integrated with CS 3000, the
release number of the CS 3000 software must be R3.08 or later.

B Software Revisions
Software revision information in release R1.02 is as follows:

Software Release R1.02.xx (*1)
*  SENG software release number: R1.02.xx (*1)

» SCS system program release number: R1.02.xx (*1)

*1:  xx varies in accordance with the last two digits of the release number for the software released between R1.02.00 and
R1.03.00.

® Inter-SCS Safety Communication

The release number of the SCS system program on the Inter-SCS safety communication with
an “SCS in R1.02” must be R1.01.30 or later.

If Vnet/IP is used for route of the Inter-SCS safety communication, the system programs on
the SCSs must be in R1.02.

B Procedures for Upgrading

In order to use the added or modified features in the R1.02, install the R1.02 or later software
and open the existing “SCS Project”. This will allow you to use the following added/modified
features in R1.02.

+ Alarm Off
* Modified Online Change Download

SEE

ALso For more information about cautionary notes for opening existing SCS projects, refer to:

“® Procedure A: Opening SCS Projects” on page C4-6

® Cautionary Notes for Online Change Download after Upgrading the SENG
to R1.02 or Later

After upgrading an SENG to R1.02 or later and if you use the SENG for engineering the proj-
ect data created by an SENG in an earlier version than R1.02, execute “Build” first without
changing any parameter, then perform an online change download.

If you skip executing operation above and do the following, there are cases where unchanged
POUs (Program Organization Units) are downloaded to SCS in the online change download.

*  From the Dictionary View window of the SCS Manager, Add, Delete, Sort the named
global instances of FB used by POUs.

* Add or Delete an existing FU to/from POUs.
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TIP

* Inthe Link Architecture View window of the SCS Manager, Change the order of the user-
defined FU/FB.

The following warning message appears in the first “Build” execution after the SENG is upgraded to R1.02.

“WARNING: POUs indexes are modified for next on line change. Online change may download others

POUs in addition of the modified ones.”

B Cautionary Notes on Using New Features

SEE
ALSO

SEE

ALSO

Some steps are required before using the new features in the R1.02. The steps and caution-
ary notes for each feature are as follows.

For more information about detailed procedures after the upgrade, refer to:
“® Procedure B: Master Database Offline Download” on page C4-6
“@® Procedure C: Creating New SCS Project and Offline Download” on page C4-7

“@® Procedure D: Setting Definition Items for New Features and Offline Download” on page C4-8

Support for Vnet/IP

For engineering the SCS connected with Vnet/IP, follow the “Procedure C” on SENG in R1.02
or later.

Optical ESB Bus Repeater

For extending the ESB bus using an Optical ESB Bus Repeater, follow the “Procedure D” on
SENG in R1.02 or later. Set the parameters from the SCS tab on the SCS Constants Builder.

Using the New FBs in the R1.02
Before using the new FBs in the R1.02, follow the “Procedure C” on SENG in R1.02 or later.

Outputting Process Alarm Messages when AOF is Released

From the SCS Constants Builder window, you can specify to (or not to) output the suppressed
process alarm messages when the AOF is released.

This setting is applicable when the ProSafe-RS is integrated with CENTUM.
Follow the “Procedure D” on SENG in R1.02 or later.

Plant Hierarchy
For specifying Plant Hierarchy to the tag data operated and monitored on HIS when the Pro-
Safe-RS is integrated with CENTUM, follow the “Procedure B” on SENG in R1.02 or later.
Expansion of Alarm Processing Levels

When the ProSafe-RS is integrated with CENTUM, you can set the Alarm Processing Levels
(5 to 16) to the tag data operated and monitored on HIS.

Follow the “Procedure D” on SENG in R1.02 or later.

For more information about detailed procedures, refer to:
2.1, “Engineering on the SENG side” in Integration with CENTUM VP/CS 3000 (IM 32Q01E10-31E)
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® Newly Supported I/O Modules (SAI143-H, SAI533, SDV541)

In order to use the I/O Modules newly supported by the R1.02, you must follow the “Proce-
dure C” on SENG in R1.02 or later.
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Appendix 4.4 Upgrading to R1.03

I n this section, the cautionary notes for upgrading from R1.02 to R1.03 will be explained. Be-
fore you upgrade, read also the cautionary notes for the previous revisions issued after the
software version currently installed on your computer.

ﬂ IMPORTANT

In order to use the new features when the ProSafe-RS R1.03 is integrated with CS 3000, the
release number of the CENTUM CS 3000 software must be R3.08.50 or later.

B Software Revisions
Software revision information in release R1.03 is as follows:

Software Release R1.03.xx (*1)
*  SENG software release number: R1.03.xx (*1)

+ SCS system program release number: R1.03.xx (*1)

*1:  xx varies in accordance with the last two digits of the release number for the software which will be released after R1.03.00.

® Inter-SCS Safety Communication

The release number of the SCS system program to perform Inter-SCS safety communication
with an “SCS in R1.03” must be R1.01.30 or later.

If Vnet/IP is used for route of the Inter-SCS safety communication, the system programs on
the SCSs must be in R1.02 or later.

B Procedures for Upgrading

In order to use the added or modified features in the R1.03, install the R1.03 or later software
and open the existing “SCS Project”.

SEE

ALso For more information about cautionary notes for opening existing SCS projects, refer to:

“® Procedure A: Opening SCS Projects” on page C4-6

B Cautionary Notes on Using New and Modified Features

Some steps such as an offline download to SCS may be required before using the new fea-
tures in the R1.03 after the SENG software is upgraded to R1.03. The steps and cautionary
notes for each feature are the followings.

ALso For more information about detailed procedures after the upgrade, refer to:
* “® Procedure B: Master Database Offline Download” on page C4-6
“® Procedure C: Creating New SCS Project and Offline Download” on page C4-7

“@® Procedure D: Setting Definition Items for New Features and Offline Download” on page C4-8

® Test Function (i.e. SCS Simulator that Runs on a Computer) and Interface
for Plant Training

Before using the Test function (i.e. SCS simulator), you need to complete the “Procedure C.”
You cannot download the project created for SCS simulation tests to an actual SCS.

CS 3000 system must be upgraded to R3.08.50 or later.
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TIP

SEE
ALSO

TIP

New Input/Output Modules (SDV521, SDV531-L)

Before using the Input/Output modules newly supported by R1.03, you need to complete the
“Procedure C.”

New Optical ESB Bus Repeater Modules (SNT411/SNT511)

Before using the Optical ESB Bus Repeater Modules newly supported by R1.03, you need to
complete the “Procedure D.” You need to set parameters using the SCS Constants Builder
and I/O Parameter Builder.

For using SNT411/SNT511, SCP451 (processor module) which supports the SNT411/SNT511 needs to be
prepared. For further information, please contact our sales office.

For more information about setting parameters for Optical ESB Bus Repeater Modules, refer to:
“m SCS Tab” in 3.1.3, “SCS Constants Builder” in Engineering Reference (IM 32Q04B10-31E)

“m ltems Set for Nodes” in 4.4, “I/O Parameter Builder” in Engineering Reference (IM
32Q04B10-31E)

Using the New FBs in the R1.03
Before using the new FBs in the R1.03, follow the “Procedure C” on SENG in R1.03 or later.

For Using the Online Change Function for Input/Output Module Channels

Before using the Online change function for Input/Output module channels, you need to com-
plete the “Procedure B.”

SCS Link Transmission

Before using the SCS Link Transmission, you need to complete the “Procedure C.”
CS 3000 system must be upgraded to R3.08.50 or later.

If you use SCS Link Transmission on SCS-IP, you need to have the SCP451 which supports SCS Link Trans-
mission. If you use SCS Global Switch Communication via Vnet/IP, you may need to update the CPU module
of the FCS of CENTUM. For further information, please contact our sales office.

Grouping Override FB

Before using the Grouping override FB, you need to complete the “Procedure C.”
CS 3000 system must be upgraded to R3.08.50 or later.

Structured Text (ST)

For using the ST language in ProSafe-RS, you need to complete the “Procedure D. Use the
Multi-Language Editor to create application in ST.

Password FB

Before using the upgraded Password FB in R1.03, you need to complete the “Procedure B.”
CS 3000 system must be upgraded to R3.08.50 or later.

Enhanced CENTUM Integration for ANLG_S

Before using the enhanced CENTUM Integration in R1.03 for the ANLG_S block, you need to
complete the “Procedure C.”

CS 3000 system must be upgraded to R3.08.50 or later.
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B Notes on Upgrading SCS Project in R1.02 to R1.03 or Later

With the SCS project created in R1.02, no data status is attached to the PV of the mapping
block S ANLG_S for ANLG_S. But in R1.03 or later, a data status is attached to the PV of the
mapping block S_ANLG_S.

In R1.03 or later, if the status of IN terminal of ANLG_S FB for the mapping block S_ ANLG_S
turns BAD, the data status of PV for S_ANLG_S turns BAD (0x8000 0000). (Default in the
SCS Constants Builder)

Therefore, if the PV of S_ANLG_S is referred via FCS or OPC, the behavior may change be-
tween the SCS project created newly in R1.03 or later and the SCS project created in R1.02.

If you want the same behavior as that in R1.02, set [PV Status of S ANLG_S] in the SCS
Constants Builder to [NO].

B Notes on Enhanced Integrity Analyzer

TIP

Stricter Check of Recursive Call in POU

Before R1.03, there are cases where a POU containing recursively called FB and FU can be
downloaded to SCS. In R1.03 or later, an error is raised for a POU with recursive calls to pre-
vent its download to SCS.

The error detection depends on how the recursive call is implemented: during generation or
by Integrity Analyzer.

When upgrading to R1.03 or later, make sure that no recursive call is included in POU. If any,
change the logic to exclude the recursive call from the POU.

Before R1.03, this does not cause an error during Generation. Even if a Warning is displayed by Integrity An-
alyzer, a download to SCS is allowed after the Warning is acknowledged.

Notes on Comparison Operation (=, <>) on Floating-point Data

There are cases where comparison operation using "=" (equal) or "<>" (not equal) on floating-
point data does not produce expected results because a round-off error may result from re-
peated arithmetic operations.

In R1.03 or later, if accurate comparison operation (=, <>) on floating-point data is detected,
Integrity Analyzer displays a warning.

After upgrading to R1.03 or later, if accurate comparison operation (=, <>) on floating-point
data is detected, a warning is displayed after the upgrade.

If a warning appears, check if the program needs to be enhanced using “smaller than (<)’ or
“greater than (>).” If the result of the check is “no need to change program”, acknowledge the
warning that Integrity Analyzer displayed. This will enable a download of the program to SCS.

B Notes on Changed Password FB

If a wrong password for the Password FB is entered from HIS, the behavior in R1.03 or later
is as follows:
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Table Appendix 4.4-1 Change made to Password FB

Version Change in behavior if a wrong password is entered for Password FB

Before R1.03 In the operation to change MV in the Password FB, if user enters a wrong pass-
word, a system alarm is raised, and user has to undo the ‘change MV’ to the
previous value.

If a wrong password is entered, a diagnostic information message is displayed to
notify it.

Here, the changed MV value remains as is and an ANS+ or ANS- process alarm
is raised.

R1.03 or later If a wrong password is entered, an error message for the wrong password is dis-
played in the dialog box on HIS, and the MV value remains unchanged.

B Notice on the Variables Begin with Underscore Characters

From R1.03, the variable and the Defined Words begin with underscore character will be han-
dled differently by the system.

® Specification Prior to R1.03

Prior to R1.03, to start the variable or the Defined Words with underscore character is prohibi-
ted, however, if you started the variable or the Defined Words with underscore character, no
error would be indicated.

® Specification for R1.03 or Later

Since R1.03, the variable or Defined Words begin with underscore character can be used,
however, if they are identical with system reserved words, an error will be indicated. The sys-
tem reserved words are as follows.

+ System Reserved Words:
_AND, CALL, CALL_IEC _SFC _FB, END, GOTO, IF, NOT, PUSH_PAR, OR,
_POP_CSTK, PUSH_CSTK, RET, STEP, XOR
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Appendix 4.5 Upgrading to R2.01

The notices on version upgrading from R1.03 to R2.01 (R2.01.10 or later) will be explained in
this section. Before upgrading installation, the documents regarding the currently installed
ProSafe-RS software as well as the release notes for the previous upgrading installations
should be read first.

In this section, the procedure for upgrading from R2.01.00 to R2.01.10 will also be explained.
If R2.01.00 is installed in your computer, you need to upgrade the software to R2.01.10.

ﬂ IMPORTANT

*  When integrating ProSafe-RS and CENTUM VP, the new features added to ProSafe-RS
R2.01 are supported only in CENTUM VP R4.01 and later versions.

* If you plan to manage ProSafe-RS computers in Windows domain environment, the Win-

dows domain environment settings should be performed before performing the installa-
tion.

B Software Revisions

Software revision information in release R2.01 is as follows:

Software Release: R2.01.xx (*1)
»  SENG software release number: R2.01.xx (*2)

+ SCS system program release number: R2.01.xx (*2)

*1:  xx stands for the revisions after releasing R2.01.00
*2:  For R2.01.10, xx stands for 00

® Inter-SCS Safety Communication

The earlier version of SCS can performs inter-SCS safety communication with the SCS that
has R2.01 system program must be a version of R1.01.30 or later.

If the inter-SCS safety communication is routing Vnet/IP, the two version of system programs
in the SCSs should be standardized to R1.02 or a later version.

® Control bus Drivers

The control bus drivers installed on the computer should be upgraded to the version supplied
at R2.01 (R2.01.10).

The ProSafe-RS R2.01 control bus drivers are compatible with the control bus drivers provi-
ded in CENTUM VP R4.01.

B Basic Procedure of Upgrading Installation
When using the added or changed software features, the installation should be performed

and opening the existing SCS projects with the installed ProSafe-RS software of R2.01 or lat-
er version.

SEE

ALso For more information about cautionary notes for opening existing SCS projects, refer to:

“® Procedure A: Opening SCS Projects” on page C4-6
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B Procedure for Upgrading from R2.01.00 to R2.01.10

Carry out the following procedure to upgrade your system:

1. For a Windows Vista computer with no CENTUM VP software, install the Windows hotfix
program provided in the CD-ROM of R2.01.10.

Update the control bus drivers using the ProSafe-RS software CD-ROM of R2.01.10.

Without using the key code FD, carry out installation to upgrade from R2.01.00 to
R2.01.10. This installation should be done by following the procedure for revision upgrad-
ing (without package addition).

ﬂ IMPORTANT

If any software package should be added, install it only after you have upgraded the system
from R2.01.00 to R2.01.10.
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Appendix 4.6 Upgrading to R2.02

In this section, the cautionary notes for upgrading from R2.01 to R2.02 will be explained. Be-
fore you upgrade, read also the cautionary notes for the previous revisions issued after the
software version currently installed on your computer.

ﬂ IMPORTANT

*  When integrating ProSafe-RS and CENTUM VP, the new features added to ProSafe-RS
R2.01 are supported only in CENTUM VP R4.02 and later versions.

* If you plan to manage ProSafe-RS computers in Windows domain environment, the Win-
dows domain environment settings should be performed before performing the installa-
tion.

B Software Revisions
Software revision information in release R2.02 is as follows:

Software Release R2.02.xx (*1)
*  SENG software release number: R2.02.xx (*1)

+ SCS system program release number: R2.02.xx (*1)

*1:  xx varies in accordance with the last two digits of the release number for the software which will be released after R2.02.00.

® Inter-SCS Safety Communication

The release number of the SCS system program to perform Inter-SCS safety communication
with an “SCS in R2.02” must be R1.01.30 or later.

If Vnet/IP is used for route of the Inter-SCS safety communication, the system programs on
the SCSs must be in R1.02 or later.
® Control Bus Drivers

The control bus drivers installed on the computer should be upgraded to the version supplied
at R2.02.

B Procedures for Upgrading

In order to use the features added or modified in R2.02, install the R2.02 or later software and
open the existing “SCS Project”.

SEE

ALso For more information about cautionary notes for opening existing SCS projects, refer to:

“® Procedure A: Opening SCS Projects” on page C4-6
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Appendix 4.6.1 Cautionary Notes for Upgrading

B Procedure for Using New and Modified Features

SEE
ALSO

SEE
ALSO

After the SENG software has been upgraded to R2.02, some of the features added or modi-
fied in the R2.02 require further steps, such as offline downloading to SCS, before they can
be used. In the following, the steps are explained for each feature.

For more information about “Procedure B” and “Procedure C” that appear in this section, refer to:
“® Procedure B: Master Database Offline Download” on page C4-6

“@® Procedure C: Creating New SCS Project and Offline Download” on page C4-7

New I/0O Module (SDV526)
To use the I/0 module SDV526 newly supported in R2.02, you must perform “Procedure C.”

Behavior of AIO/DIO modules at Online Change Download

To enable online change downloading with the target AIO/DIO module kept running when you
have changed any settings of I/O Parameter Builder that require downloading to the AlO/DIO
module (IOM download), you must perform “Procedure B.” If not, the target AIO/DIO module
will be stopped as before.

For more information about the behaviors of AIO/DIO modules during online downloading with software be-
fore R2.02, refer to:

“@ Behavior of AIO/DIO Modules at Online Change Download” on page App.4-20

Showing the Results of the Last Analysis on Cross Reference Analyzer

To enable the function to show the results of the last analysis after you have upgraded SENG
to R2.02, you must once acknowledge the analysis results in Cross Reference Analyzer and
perform downloading to SCS.

B Notes on Online Change Download after Upgrading SENG

In R2.02, the problem that the FB for which you have specified a minus value for a label in a
CASE statement does not run properly (*1) has been fixed. Because of this, the behavior of
online change downloading after you have upgraded the SENG to R2.02 will be as follows.

After you have upgraded the SENG to R2.02, if you perform a build for a project created in a
version before R2.02 and execute online change downloading, all the FBs containing any
CASE statement in the ST language will be downloaded (*2) even if no changes have been
made to the logic. Once you rebuild a project of a version earlier than R2.02 on a R2.02 sys-
tem and execute online change downloading, FBs with no logic change will not be downloa-
ded in the subsequent online change downloading.

You can use the Database Validity Check Tool, as necessary, to find out which FBs will be
downloaded before you execute online change downloading.

In a revision before R2.02, FBs containing any CASE statement in which a minus value is
specified for a label do not run correctly, so they can be spotted and removed in the system
test. Therefore, no such FBs should exist in a project. However, if such FBs do exist, the FBs
may start to run normally after downloading.

To avoid such unexpected change in behavior, you should check the project to see if there
are any FBs containing a CASE statement in which a minus value is specified for a label.

» If any FBs using a minus value for a label of CASE statement are found, make sure that
the change in behavior does not cause any adverse effects on the system. (*3) (*4)
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+ If FBs using a minus value for a label of CASE statement are not found, all the FBs us-
ing CASE statements will be downloaded but the system behavior remains the same; so
you do not need to perform tests again.

*1:  If you specify a minus value for a label in a CASE statement in ST, an incorrect database which causes unexpected behavior
may be generated. In the following example, if variable1 is neither “1” nor “2”, “3” is always assigned to aaa.
CASE variable1 OF
1:aaa:=1;
2:aaa =2,
-1: aaa := 3; (* When the variable1 is neither 1 nor 2, this line is always executed.*)
-2:aaa = 4;
ELSE aaa :=5;
END_CASE;
*2:  In this case, Cross Reference Analyzer does not detect the difference of the FBs using CASE statements.
*3: In this case, Cross Reference Analyzer does not detect the difference of the FBs using a minus value for a label of CASE
statement.
*4:  To find the locations where CASE statements are used, open multiple STs in Multi-Language Editor and search for “CASE”.

B Enhanced Checking by Integrity Analyzer
® Checking for Multiple Writing to the Same Variable

Multiple writing to the same variable can reduce the program readability and end up down-
loading of programs that cause unintended behavior. Integrity Analyzer in R2.02 detects multi-
ple writing to the same variable and displays a warning message.

This warning message is not output with the revisions before R2.02, but it will be displayed
after you have upgraded to R2.02 when the program contains any multiple writing to the same
variable. If this warning message is displayed, examine the program to find out if you can
eliminate the multiple writing.

If you find that the multiple writing is necessary, acknowledge the results of analysis in Integri-
ty Analyzer and you can download the program to SCS without change. In this case, the pro-
gram can be used as a function allowed for safety application after verifying its validity in user
tests.

® Checking for Multiple Calls to the Same FB Instance

Multiple calls to the same function block (FB) instance can lead to an unexpected state in the
system and the program may not behave as intended. Integrity Analyzer in R2.02 detects
multiple calls to the same FB instance and displays a warning message.

This warning message is not output with the revisions before R2.02, but it will be displayed
after you have upgraded to R2.02 when the program contains multiple calls to the same FB
instance. If this warning message is displayed, examine the program to find out if you can
eliminate the multiple calls. If you find that the multiple calls are necessary, acknowledge the
results of analysis in Integrity Analyzer and you can download the program to SCS without
change. In this case, the program can be used as a function allowed for safety application af-
ter verifying its validity in user tests.

® Checking for Writing to Output Variable Status

I/O variable statuses (.status) are the data that reflect the actual statuses (normal/abnormal)
of /0O channels. Therefore, they should not be changed by user logic. Integrity Analyzer in
R2.02 detects writing to output variable statuses and raises an error.

In revisions before R2.02, no such error is raised. But this error will be raised after you have
upgraded to R2.02 when there is any program that writes to any output variable status. If an
error message is displayed, change the program to eliminate the writing to output variable
statuses.
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Appendix 4.6.2 Compatibility with Earlier Revisions

B Behavior of AIO/DIO Modules at Online Change Download

SEE
ALSO

TIP

When online change downloading is performed after you have changed any settings of /O
Parameter Builder that require downloading to I/O modules (IOM download), the target
AIO/DIO modules continue operation if the SCS system program revision is R2.02 or later
while the AIO/DIO modules are stopped with revisions earlier than R2.02.

This section explains the behaviors of AIO/DIO modules when the SCS system program revi-
sion is earlier than R2.02.

For more information about the setting items in 1/0O Parameter Builder that require IOM download, refer to:
A4 .4, “Items set for analog inputs” in Safety Control Station Reference (IM 32Q03B10-31E)
A4.5, “Items set for analog outputs” in Safety Control Station Reference (IM 32Q03B10-31E)
A4.6, “ltems set for discrete inputs” in Safety Control Station Reference (IM 32Q03B10-31E)
A4.7, “Items set for discrete outputs” in Safety Control Station Reference (IM 32Q03B10-31E)

Behavior of Input Modules

« At the time of online change, the data status of all channels of the target module become
BAD, and the diagnostic information message “IOM Fail” appears. The input signals of all
channels of the module are processed according to the [Input Processing at Fault] set-
tings.

* If on-demand HART communication with PRM is performed, the HART communication is
discontinued during the “IOM Fail” status.

*  On completion of online change download, the channels’ data automatically return to the
values input to the channels and all data statuses become GOOD.

« A diagnostic information message indicating that the input module has recovered to nor-
mal is output.

*  For dual-redundantly configured 1/0 modules, the odd-numbered module takes the con-
trol right.

If any setting items that require IOM download and the setting of [Input Processing at Fault] or [Input Value at
Fault] are changed online simultaneously, the input value will conform to the changed settings of [Input Pro-
cessing at Fault] and [Input Value at Fault].

Behavior of Output Modules

« At the time of online change, the data status of all channels of the target module be-
come BAD, and the diagnostic information message “IOM Fail” appears. The output val-
ues on all channels change to 0 if the target module is a discrete output module, and
change to the tight-shut output values (*1) if the target module is an analog output mod-
ule.

* If on-demand HART communication with PRM is performed, the HART communication
is discontinued during the “IOM Fail” status.

*  On completion of online change download, the data status of all channels become
GOOD, while the output values still remain 0 with a discrete output module or remain the
tight-shut output values with an analog output module.

« A diagnostic information message indicating that the output module has recovered to
normal is output.
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*  For dual-redundantly configured output modules, the odd-numbered module takes the
control right.

« If the user performs the output enable operation, outputs of the application logic are out-
put from the output module.

*1:  Atight-shut output value can be set for each channel using the I/O Parameter Builder.

B Changes in Multi-Language Editor Specifications

® Font and Font Color are Set for Each Project

In revisions earlier than R2.02, the font and font color shown in the function block diagram
(FBD) window of Multi-Language Editor are retained for each user of the computer.

From R2.02, the font and font color settings for FBD windows are retained for each project.
When a project is first opened in R2.02, the font and font color settings used by the user who
opened the project will be retained in the project.

® FBD Guidelines are Set for Each Project

In revisions earlier than R2.02, the guideline setting for the FBD window of Multi-Language
Editor is retained for each computer.

From R2.02, the guideline setting is retained for each project. The guideline setting when the
project is first opened in R2.02 will be retained in the project.
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Appendix 4.7 Upgrading to R2.03

In this section, the cautionary notes for upgrading from R2.02 to R2.03 are explained. Before
you upgrade, also read the cautionary notes for the previous revisions issued after the soft-
ware version currently installed on your computer.

ﬂ IMPORTANT

* In the case of system configuration integrating ProSafe-RS and CENTUM VP, it is possi-
ble to perform operation and monitoring of the newly added features of ProSafe-RS
R2.03 correctly by using CENTUM VP or R4.02 or later versions.

* Install the ProSafe-RS software version R2.03.00 after upgrading the control bus driver of
SENG using the CD-ROM of ProSafe-RS R2.03.59.

* Be sure to use the CD-ROM of R2.03.59 to install the software immediately after the in-
stallation of the R2.03.00 software.

« After the installation of R2.03.59 is complete, follow the precautions given in this section
and perform the tasks of upgrading the project data.

TIP

R2.03.80 includes the features of all minor release versions of R2.03.

ALso For more information about the behaviors of CENTUM that are related to the new features of ProSafe-RS
R2.03 when ProSafe-RS is integrated with CENTUM VP earlier than R4.02 or CS 3000, refer to:

Appendix 1., “Differences in limitations and specifications among software release numbers of
CENTUM” in Integration with CENTUM VP/CS 3000 (IM 32Q01E10-31E)

B Software Revisions
Software revision information in release R2.03 is as follows:

Software Release R2.03.xx (*1)
+  SENG software release number: R2.03.xx (*1)

« SCS system program release number: R2.03.xx (*1)

*1:  xxvaries in accordance with the last two digits of the release number for the software which will be released after R2.03.00.

® Inter-SCS Safety Communication

The release number of the SCS system program to perform Inter-SCS safety communication
with an “SCS in R2.03” must be R1.01.30 or later.

If Vnet/IP is used for route of the Inter-SCS safety communication, the system programs on
the SCSs must be in R1.02 or later.

® Control Bus Drivers
Install the enhanced control bus driver that is included in the R2.03.59 CD-ROM.

B Procedures for Upgrading

In order to use the features added or modified in R2.03, install the R2.03 or later software and
open the existing SCS project.
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SEE

ALso For more information about cautionary notes for opening existing SCS projects, refer to:

“® Procedure A: Opening SCS Projects” on page C4-6
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Appendix 4.7.1 Cautionary Notes for Upgrading

B Inconsistency Check of TCP/IP Settings

On a computer running Windows Vista SP2 or Windows Server 2008 SP2, run the TCP/IP In-
consistency Detect Tool after you have upgraded the SENG software to R2.03. If any incon-
sistency is detected in TCP/IP settings, run the TCP/IP Inconsistency Repair Tool and then
configure the TCP/IP settings again.

SEE

ALSO ror more information about The tools for detecting and repairing inconsistency in TCP/IP setting TCP/IP, refer
o:

“@ Procedure 6: Repair TCP/IP Settings” on page B3-52

B Procedure for Using New and Modified Features

After the SENG software has been upgraded to R2.03, some of the features added or modi-
fied in the R2.03 require further steps, such as offline downloading to SCS, before they can
be used. In the following, the steps are explained for each feature.

AI_ESE For more information about “Procedure B” through “Procedure F” that appear in this section, refer to:
“@ Procedure B: Master Database Offline Download” on page C4-6
» “® Procedure C: Creating New SCS Project and Offline Download” on page C4-7
“® Procedure E: Clean Project, Build, and Offline Download” on page C4-8

“@® Procedure F: Setting Definition Items for New Features, Clean Project, Build, and Offline Down-
load” on page C4-9

® New I/O Module (SDV53A)

To use the I/0O module SDV53A newly supported in R2.03, you need to perform “Procedure
(O

® New Function Blocks in R2.03
To use the new FBs in R2.03, such as SYS_SCANEXT (scan period extension indicator), you
need to perform “Procedure C” on an SENG of R2.03 or later.
® Online Change Download
From R2.03, the following changes can be made by online change download.
» Change the scan period
* Add or delete input/output modules
*+  Rename POUs
« Change the type and attributes of FB instances
» Change the definitions on SCS Constants Builder

To download these changes online, you need to perform “Procedure E” on an SENG of R2.03
or later.

SEE

ALso For more information about online changes to SCS with R2.02 or earlier system program, refer to:

‘@ Online Changeable Information” on page App.4-26
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® Inter-SCS Safety Communication Locking Functions

To use the functions for locking inter-SCS safety communication, you need to perform “Proce-
dure E” on an SENG of R2.03 or later. However, if you also want to use the new system FB of
SYS_FORCE_EB (inter-SCS safety communication forcing status management), you need to
perform “Procedure C.”

® Automatic IOM Download

To use automatic IOM download, you need to perform “Procedure F” on an SENG of R2.03 or
later. Use the SCS Constants Builder and set so as to enable the automatic IOM download.

® Automatic Scan Period Extension under High CPU Load

To use automatic scan period extension, you need to perform “Procedure F” on an SENG of
R2.03 or later. Use the SCS Constants Builder and set [Extend scan period automatically] to
“Yes”. However, if you also want to use the new system FB of SYS_SCANEXT (scan period
extension indicator), you need to perform “Procedure C.”

ﬂ IMPORTANT

If you use automatic scan period extension in a system that does not include SCS Mainte-
nance Support Tool on SENG or CENTUM HIS, you must perform “Procedure C” on an SENG
of R2.03 or later. This is because, in such a system, you need to use the SYS_SCANEXT FB
(scan period extension indicator) to detect whether the SCS is running with an automatically-
extended scan period.

® Specifying Behavior at Abnormal Calculation

To enable specification of the SCS behavior at abnormal calculation, you need to perform
“Procedure F” on an SENG of R2.03 or later. Use the SCS Constants Builder and specify the
behavior of the SCS at abnormal calculation. However, if you also want to use the new sys-
tem FB of SYS_CERR (computation error indicator), you need to perform “Procedure C.”

ﬂ IMPORTANT

If you want to specify the behavior of the SCS at abnormal calculation in a system that does
not include SCS Maintenance Support Tool on SENG or CENTUM HIS, you must perform
“Procedure C” on an SENG of R2.03 or later. This is because, in such a system, you need to
use the SYS_CERR FB (computation error indicator) to detect that the SCS is running even
after abnormal calculation has occurred.

® Improvement in SCS Software Performance

To improve the software performance of SCSP1 or SCSV, you need to perform “Procedure B”
on an SENG of R2.03 or later.

B Cautionary Note on Offline Download after Upgrading to R2.03.59

If you try to offline download an existing project immediately after upgrading the ProSafe-RS
software to R2.03, an error occurs. You need to run Clean Project and Build before offline
downloading the project.
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Appendix 4.7.2 Compatibility with Earlier Revisions

This section describes the specifications and cautionary notes of SCS with a system program
before R2.03 that are critical to safety as the information on compatibility. Read this section
when you use SCS with a system program before R2.03.

EE
ALso For more information about compatibility of software version R2.03.51 and earlier and SCS, refer to:

“B Specification Changes Made in SCS System Program Release Number R2.03.51” on page
App.4-31

M Inter-SCS Safety Communication

The Inter-SCS Communication Lock Window is not available.

For testing of inter-SCS safety communication and maintenance, internal variables should be
connected to the OUT of consumer inter-SCS safety communication FBs and the application
should read the values of these internal variables. During testing and maintenance, you need
to lock the connected variables as necessary.

B Online Changeable Information

The online changeable information in SCS with a system program before R2.03 is as follows.
® POU Information that is Changeable Online

Table Appendix 4.7.2-1 POU Information

Modification Online Change (*1)
Program User-Defined FB User-Defined FU

Adding/deleting variables Yes Yes (*2) Yes (*3)
Adding a variable to be named the same |No No No
as that of a deleted variable
Changing attributes of variables No No No
Adding/deleting I/O variables Yes - -
Adding/deleting FU Yes Yes Yes
Adding/deleting user-defined FU (*4) Yes Yes Yes
Adding/deleting FB instances Yes No -
Adding/deleting user-defined FB (*4) Yes No -
Adding a FB to be named the same In- No - -
stance as that of a deleted FB
Changing logic Yes Yes (*2) Yes (*2)
Creating/deleting programs Changing pro- | No (*5)
gram names

Creating/deleting user-defined Function No (*5)
Blocks Changing user-defined Function
Block hames

Creating/deleting user-defined Functions | No (*5)
Changing user-defined Function names

*1:  Yes: Changeable by online change download.
No: Offline download is required.
*2:  ltis not allowed to increase/decrease parameter values or change attributes. They cause an error when the database is
downloaded.
*3: An error occurs during downloading.
*4:  When user-defined FU/FB are added, they need to be tested. Pre-validated user-defined FU/FB do not need to be tested.
*5: Online change is only possible for local variables.
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® |/O Module Information that is Changeable Online

Table Appendix 4.7.2-2 1/0 Module Information

Modification Online Change (*1)
Adding nodes No
Deleting nodes No
Changing parameters of nodes Yes
Adding I/0 modules No
Deleting I/0O modules No
Changing redundant 1/O modules No
Changing parameters of I/O modules Yes
Changing parameters of channels Yes
Changing subsystem communication definitions Yes

Defining link between a variable and an idle channel |Yes

Deleting link between a channel and a variable Yes

Changing link between a channel and a variable Yes

tion definitions

Adding, changing or deleting subsystem communica- | Yes

Changing wiring of communication input/output FBs | Yes

*1:  Yes: Changeable by online change download.

No: Offline download is required.

® Constants and Network Information that are Changeable Online

Table Appendix 4.7.2-3 Constants and Network

Classification Modification Online Change (*1)

Configuration Name No
Password No (*2)

Resource Name No
Resource Number No
Scan period No
Number of variables permitted for | No
online
Size of temporary variables and No
constants area

Network IP address No
Station address No
Inter-SCS safety Communication | No
(Binding)

Optional ESB BUS Repeater Optional ESB BUS Repeater No
Max. extension distance No

*1:  No: Offline download is required.

*2:  Setting and changing passwords is ignored.

® Builder Definitions that are Changeable Online

The following table shows whether online change downloading is possible after you have
changed definitions using builders.
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Table Appendix 4.7.2-4 Online Change Download

Builders Online Change (*1)
SCS Constants Builder No
I/O Parameter Builder Yes
Communication I/O Builder Yes
SCS Link Transmission Builder Yes
Modbus Address Builder Yes
Tag Name Builder Yes
Alarm Priority Builder No
Alarm Processing Table Builder No

*1:

Yes: Changeable by online change download.
No: Offline download is required.

B Behaviors at Abnormal Calculation in Application Logic

If abnormal calculation occurs in the application logic of an SCS with a system program be-
fore R2.03, the SCS stops.

® About Behaviors of SCS at Abnormal Calculation

If an overflow or division by zero occurs in operations with REAL-type variables, or divi-
sion by zero in operations with integer-type variables, SCS stops.

When floating-point data is converted to a DINT number by the ANY_TO_DINT function,
if the resultant number exceeds the maximum or falls below the minimum integer values
(i.e. overflow occurs), the SCS stops.

For the input to ANY_TO_TIME, use a DINT type value in the range from 0 to 86400000.
If a value beyond this range is used, it cannot return a proper time. Note that when a real
number value greater than 4294967295 (the maximum number of the unsigned 32-bit in-
teger) or smaller than -2147483648 (the minimum number of the unsigned 32-bit integer)
is used, the SCS stops.

If access to the outside of an array occurs, the SCS stops.
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Appendix 4.8 Upgrading to Version R3.01

This section provides precautions to be made when upgrading the software version from
R2.03 to R3.01. Please read precautions at upgrading revision of the software release num-
ber currently installed on the computer or earlier as well before starting the tasks of version
upgrading to perform tasks required to upgrade each revision.

ﬂ IMPORTANT

In the case of system configuration integrating ProSafe-RS and CENTUM VP, it is possible to
perform operation and monitoring of the newly added features of ProSafe-RS R3.01 correctly
using CENTUM VP of R5.01 or later versions.

ALso For more information about the operations related to the functions newly added in the ProSafe-RS software
version R3.01 when ProSafe- RS is integrated with CENTUM VP or CS 3000 of R5.01 or earlier revisions,
refer to:

Appendix 1., “Differences in limitations and specifications among software release numbers of
CENTUM” in Integration with CENTUM VP/CS 3000 (IM 32Q01E10-31E)

B Software Revisions

The respective software release number of R3.01 is as follows:

Software Release R3.01.xx (*1)
*  SENG software release number: R3.01.xx (*1)

+ SCS system program release number: R3.01.xx (*1)

*1:  xx will be changed in accordance with the software revisions after the release of R3.01.00.

® Inter-SCS Safety Communication

The release number of the SCS system program of an SCS that performs Inter-SCS safety
communication with an SCS with system program version R2.0 must be of R1.01.30 or later.

If Vnet/IP is used for route of the Inter-SCS safety communication, the system programs on
the SCSs must be of R1.02 or later.

® Control Bus Drivers

The control bus drivers installed on the computer should be upgraded to the version supplied
in R3.01.

The control bus driver of ProSafe-RS R3.01 is compatible with the control bus driver supplied
with CENTUM VP R5.01.
B Basic Procedure of Revision Upgrading

In order to use the features added or modified, install the ProSafe-RS software R3.01 or later
and open the existing SCS project.

SEE

ALso For more information about cautionary notes for opening existing SCS projects, refer to:

“® Procedure A: Opening SCS Projects” on page C4-6

IM 32Q01C50-31E 4th Edition : Jan.30,2015-00



<Appendix 4.8 Upgrading to Version R3.01 > App4-30

Appendix 4.8.1 Cautionary Notes for Upgrading

B Procedure for Using New and Modified Features

SEE
ALSO

After the SENG software has been upgraded to R3.01, some of the features added or modi-
fied in the R3.01 require performing further tasks, such as offline downloading to SCS, before
they can be used. In the following, the steps are explained for each feature.

For more information about “Procedure B” and “Procedure C” that appear in this section, refer to:
“® Procedure B: Master Database Offline Download” on page C4-6

» “® Procedure C: Creating New SCS Project and Offline Download” on page C4-7

New I/O Modules (SAT145 and SAR145)

To use the Input Modules that are supported by the R3.01, you must follow the "Procedure C"
on SENG in R3.01 or later.

Support for Real Value Entry to ANLG1002D/ANLGVOTER

In order to enter real values to ANLG100O2D/ANLGVOTER, you need to perform “Procedure
B” on an SENG R3.01 or later.
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Appendix 4.8.2 Compatibility with Earlier Revisions

This section describes the specifications and precautions of SCS with a system program be-
fore R3.01 that are critical to safety as the information on compatibility. Please read this sec-
tion if you use SCS with a system program before R3.01.

B Function Block Parameters

The function block operation specifications have been changed in the SCS system program
release number R3.01.

® Support for Analog Input Modules for Thermocouple/RTD

In revisions earlier than R3.01, the following function blocks were able to handle normalization
data from 0 to 100% only with their parameters.

Table Appendix 4.8.2-1 Function Blocks whose Parameters were Changed in R3.01

Function block Parameter
ANLG1002D IN1, IN2, DEL, VAL, OUT
ANLGVOTER IN1, IN2, IN3, DEL, VAL, OUT
ANLG_S IN, HYS
ANLGI IN, HYS
VEL IN, VL, HYS

® ANLG1002D

Due to the specification changes of ANLG1002D parameters, the operations of VAL on SCS
are changed as shown in the following table.

Table Appendix 4.8.2-2 Specification of VAL
Earlier than R3.01 R3.01 or later

-25 to 125%. If you specify a value smaller than Specify as % or engineering units (no restrictions on
-25.0%, it is processed as -25.0%. If you specify a range in VAL).
value greater than 125%, it is processed as 125 %.

® ANLGVOTER

Due to the specification changes of ANLGVOTER parameters, the operations of VAL on SCS
are changed as shown in the following table.

Table Appendix 4.8.2-3 Specification of VAL
Earlier than R3.01 R3.01 or later

-25 to 125%. If you specify a value smaller than Specify as % or engineering units (no restrictions on
-25.0%, it is processed as -25.0%. If you specify a range in VAL).
value greater than 125%, it is processed as 125 %.

B Specification Changes Made in SCS System Program Release
Number R2.03.51

® Overview of Specification Changes

After the SCS system program release number R2.03.51, information on system time is no
longer used to diagnose delay in inter-SCS safety communication and SCS link transmission
safety communication. Specifically, there is no need to consider the gap in the system times
of related SCSs when determining the DLYT value.
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ﬂ IMPORTANT

In order to operate inter-SCS safety communication and SCS link transmission safety commu-
nication with the specification of R2.03.51 or later, upgrade the revision of all SCS system
programs that communicate each other to R2.03.51 or later. If either the revision of the trans-
mission or reception side has not been upgraded, the system operates with the method be-
fore the change, which uses the system time for diagnosis of delay. If the communication is
performed with the method before the change, take the gap in the system times among in-
volved SCSs as the DLYT value as in the past.

® Calculation Method of DLYT in Inter- SCS Safety Communication

How to calculate DLYT in inter-SCS safety communication in case of revisions earlier than
R2.03.51 is explained below.

Reception interval timeout value (OUTT) and inter-FB transmission delay timeout value
(DLYT) are used to set the timeout monitoring time of inter-SCS safety communication.

Temporary transmission delay errors can be detected by monitoring the communication with
OUTT. In addition, you can set DLYT to detect constant transmission delay errors.

DLYT detects not only transmission delay but also time gap among SCSs. For this reason,
determine the set value of DLYT taking generation of erroneous trips due to time gap into con-
sideration as well.

* Reception interval timeout value (OUTT)
An FB for communication on the consumer side (CONS_*) checks the interval of data re-
ception. If the data reception interval exceeds the reception interval timeout value
(OUTT), a communication error occurs and a failsafe value (VAL) is output.

» Transmission delay timeout value (DLYT)
DLYT checks the time from the time an FB for communication on the producer side
(PROD_*) transmits data to the time an FB for communication on the consumer side
(CONS_*) receives the data. This time interval is called inter-FB transmission delay time.
If the status where this interval exceeds the inter-FB transmission delay timeout value
(DLYT) of CONS_* continues for the time indicated by OUTT, a communication error oc-
curs and a failsafe value (VAL) is output.

The guidelines of timeout value settings are given in the following.
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Setting of Reception Interval Timeout Value (OUTT)

OUTT=(select the longer scan period of either the producer or the consumer) x 8 +
(Additional Delay)

Additional Delay
V net Delay

No BCV/CGW used: 0 s
Via BCV/CGW: the number of BCV used x 1 s +
the number of pairs of CGWs used x 2 s

Vnet/IP Delay
Within a Vnet/IP domain: 0 s

Between Vnet/IP domains (No wide area network):
0 s (Regardless of the number of L3SWes)

Between Vnet/IP domains (Wide area network):
1 s (Regardless of the number of L3SWes)

Vnet/IP — V net: V net delay + Vnet/IP delay + V net router delay (1 s)

V net(1) —Vnet/IP -V net(2): V net(1) delay +Vnet/IP delay + V net(2) delay +
Two V net routers’ delay (2 s)

Set 3 seconds to OUTT when the calculated OUTT is shorter than 3 seconds.

Setting of the Transmission Delay Timeout Value (DLYT)

1. In cases of Inter-SCS safety communications between:
- SCSs in the same domain
- SCSs synchronized with GPS time
- SCSPs synchronized with a Vnet/IP network time
- An SCSP synchronized with SNTP server and an SCSV synchronized with GPS time:

DLYT= (scan period of the producer) + (scan period of the consumer) + (Additional
Delay)
Additional Delay

V net Delay

No BCV/CGW used: 300 ms
Via BCV/CGW: the number of BCV used x 1.3 s +
the number of pairs of CGWs used x 2.3 s

Vnet/IP Delay
Within a Vnet/IP domain: 300 ms
Between Vnet/IP domains (No wide area network):
300 ms (Regardless of the number of L3SWes)
Between Vnet/IP domains (Wide area network):
1.3 s (Regardless of the number of L3SWes)
Vnet/IP — V net: V net delay + Vnet/IP delay + V net router delay (1.3 s)
V net(1) — Vnet/IP — V net(2): V net(1) delay + Vnet/IP delay + V net(2) delay +
Two V net routers’ delay (2.6 s)

Set 3 seconds to DLYT when the calculated DLYT is shorter than 3 seconds.

2. In case of Inter-SCS safety communications between SCSs synchronized with V net time
in SCS in different domains:
DLYT= (the number of BCV used) x5 s

3. If there are V net routers between SCSs synchronized with V net time in the Inter-SCS
safety communications,
DLYT= (BCV/number of V net router layers) x5 s
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ﬂ IMPORTANT

If you set 0 seconds to DLYT and bypass inter-FB transmission check, it is not possible to use
reception data of the given inter-SCS safety communication for the safety purpose.

* In both cases, set the value of OUTT as the DLYT value if OUTT is smaller than DLYT.

* The timeout value is used for calculating system reaction time.

® Precautions when Setting DLYT for Inter- SCS Safety Communication

Precautions to be followed when setting DLYT for inter-SCS safety communication in software
versions R2.03.51 or earlier are given below.

+ If IRIG-B time synchronization method is selected, be sure to take the time gap due to
failure of GPS and IRIG-B interface into consideration.

* Inthe case of SCSs connected to Vnet/IP, time gap due to the SNTP server must be tak-
en into consideration.

» Unify the time synchronization method among SCSs that perform inter- SCS safety com-
munication and determine the setting value such that erroneous trips do not occur due to
time gap among SCSs.

If you set DLYT among SCSs over multiple domains, the following points must also be
taken into consideration.

« If V net time synchronization method is selected, delay of up to 5 seconds in the first level
of BCV-V and 10 seconds in the second level may occur. It is recommended to select
IRIG-B time synchronization if it is found that the gap is outside the allowable range.

» If domains are connected via a gateway for broadband connection, it is recommended to
synchronize V net time of each domain within the allowable range or select IRIG-B time
synchronization.

® Precautions when Setting DLYT for SCS Link Transmission Safety
Communication

How to calculate DLYT of SCS link transmission safety communication for revisions R2.03.51
or earlier is explained below.

Reception interval timeout value (reception timeout, hereinafter referred to as OUTT) and in-
ter-SCS transmission delay timeout value (transmission timeout, hereinafter refer red to as
DLYT) are used to set the timeout monitoring time of SCS link transmission safety communi-
cation.

Temporary transmission delay errors can be detected by monitoring the communication with
OUTT. In addition, you can set DLYT to detect constant transmission delay errors.

DLYT detects not only transmission delay but also time gap among SCSs. For this reason,
determine the set value of DLYT taking generation of erroneous trips due to time gap into con-
sideration as well.

* Reception interval timeout value (OUTT)
It is valid only when the station on the transmission side is an SCS.

The reception interval refers to the time interval of receiving data by an SCS. Specify the
reception interval timeout value (OUTT) for each communication target. If normal data
cannot be received within the reception interval timeout value (OUTT), a communication
error occurs and a failsafe value is output.

* Inter-SCS transmission delay timeout value (DLYT)
It is valid only when the station on the transmission side is an SCS.
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Inter-SCS transmission delay time is the time duration from the time an SCS on the trans-
mission side sends data to the time an SCS on the reception side receives the data. If the
inter-SCS transmission delay timeout value exceeds the DLYT timeout value and the sta-
tus continue for the time specified by OUTT or longer, a communication error occurs and
a failsafe value is output.

The guidelines of timeout value settings are given in the following.

Setting of reception interval timeout value (OUTT)
OUTT = (Scan frequency on the transmission or reception side, whichever longer) X~ 8

If OUTT is 3 seconds or less, set 3 seconds.

Guidelines of setting value of transmission delay timeout value (DLYT)
If the time synchronization method employed is V net time synchronization or Vnet/IP
time synchronization, set 3 seconds for DLYT.

In the case of IRIG-B time synchronization, determine DLYT as follows:

DLYT = (Scan frequency on transmission side) + (Scan frequency on the reception side)
+ (Delay addition) + (Time gap addition)

Delay addition: 100 ms

Time gap addition: Determine the setting value so that erroneous trips do not occur due
to time gap.

If DLYT is 3 seconds or less, set 3 seconds.
If 0 seconds are set for DLYT, checking of transmission delay by DLYT is bypassed.
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Appendix 4.9 Upgrading to Version R3.02.00

This section provides cautionary notes for upgrading from R3.01 to R3.02.00. Before you up-
grade, also read the cautionary notes for upgrading to the previous versions that were issued
after the software version currently installed on your computer and perform the required tasks
for each upgrade.

ﬂ IMPORTANT

When integrating ProSafe-RS with CENTUM VP, it is recommended that the version of
CENTUM VP is R5.02.00 or later.

B Software Revisions

The respective software release number of R3.02 is as follows:

Software Release R3.02.xx (*1)
* SENG software release number: R3.02.xx (*1)

+ SCS system program release number: R3.02.xx (*1)

*1: xx will be changed in accordance with the software revisions after the release of R3.02.00.

Inter-SCS Safety Communication

The release number of the SCS system program of an SCS that performs Inter-SCS safety
communication with SCS with system program version R3.02 must be R1.01.30 or later.

If Vnet/IP is used for route of the Inter-SCS safety communication, the system programs on
the SCSs must be of R1.02 or later.

Control Bus Driver

You do not need to update the control bus driver if the control bus driver provided in R3.01 is
installed on the computer.

The control bus driver of ProSafe-RS R3.01 is compatible with the control bus driver provided
in CENTUM VP R5.01 and R5.02.

B Basic Procedure of Revision Upgrading

SEE

In order to use the features added or modified, install the ProSafe-RS software R3.02 or later
and open the existing SCS project.

When you open a password-protected SCS project, the security of the password is strength-
ened.

ALso For more information about cautionary notes for opening existing SCS projects, refer to:

“® Procedure A: Opening SCS Projects” on page C4-6
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Appendix 4.9.1 Cautionary Notes for Upgrading

B Procedure for Using New and Modified Features

SEE
ALSO

After the SENG software has been upgraded to R3.02.00, some of the features added or
modified in R3.02.00 require performing further tasks, such as offline downloading to SCS,
before they can be used. In the following, the steps are explained for each feature.

For more information about “Procedure B,” “Procedure C,” and "Procedure D" that appear in this section, re-
fer to:

“® Procedure B: Master Database Offline Download” on page C4-6
“® Procedure C: Creating New SCS Project and Offline Download” on page C4-7

“®@ Procedure D: Setting Definition Items for New Features and Offline Download” on page C4-8

Ethernet Communication Module (ALE111) and Modbus TCP Slave
Communication

To use the Ethernet communication module (ALE111) newly supported in R3.02 to perform
Modbus slave communication over the Modbus TCP protocol, you need to perform "Proce-
dure C" on an SENG of R3.02.00 or later.

Writing to a Single Holding Register by Modbus Slave Communication

To enable writing to a single holding register in SCS, which is a Modbus slave, from a Modbus
master, you need to perform "Procedure D" on an SENG of R3.02.00 or later.

IOM Reset Function

To use the IOM reset function, you need to perform "Procedure B" on an SENG of R3.02.00
or later.

B Cautionary Note on Upgrading the OS from Windows XP/Windows
Server 2003

Note the following point if your upgrading of the ProSafe-RS software involves upgrading the
OS from Windows XP/Windows Server 2003 to a later version OS:

If any of the values comprising an IP address of SCS is set to a value where 0 is in the upper
digit and 8 or 9 is contained in the lower digits, for example, 08 and 09, on the Connection
Properties dialog box in Workbench of the SENG software, the SENG can communicate with
the SCS properly as long as the SENG is running on Windows XP/Windows Server 2003.
With a later version OS, an error will occur in the following operations:

*  Online change download

« Starting the 1/O lock window

«  Starting the debug mode

* Checking by the Database Validity Check Tool

To enable proper operation, delete 0 in the upper digit and perform an offline download.

B Cautionary Notes on Upgrading the SCS SOE OPC Server

When the Standard model of IT security settings are applied, the authentication level of COM
is set to "Connect" during upgrading to R3.02. Because of this, some client programs may be-
come unable to connect to the SCS SOE OPC server.
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If any client program has become unable to establish connection after the upgrading, set the
authentication level of COM to "None" on the SCS SOE OPC server to enable connection.

TIP If any other YOKOGAWA product coexists on the same computer, the authentication level of COM may be
set to "None" according to the operational specifications of the other product.

SEE

ALso For more information about how to set the authentication level of COM on the SCS SOE OPC server, refer to:

“m DCOM settings” in A2.2, “Overview of product security settings” in Open Interfaces (IM
32Q05B10-31E)
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Appendix 4.10 Upgrading to R3.02.10

This section provides cautionary notes for upgrading from R3.02.00 to R3.02.10. Before you
upgrade, also read the cautionary notes for upgrading to the previous versions that were is-
sued after the software version currently installed on your computer and perform the required
tasks for each upgrade.

ﬂ IMPORTANT

When integrating ProSafe-RS with CENTUM VP, the recommended version of CENTUM VP
is R5.03.00 or later.

B Software Revisions

The respective software release number of R3.02 is as follows:

Software Release R3.02.10 (*1)
+ SENG software release number: R3.02.10 (*1)

« SCS system program release number: R3.02.10 (*1)

*1:  The last two digits of the release number will be changed in accordance with the software revisions after the release of
R3.02.10.

® Inter-SCS Safety Communication

The release number of the SCS system program of an SCS that performs Inter-SCS safety
communication with SCS with system program version R3.02.10 must be R1.01.30 or later.

If Vnet/IP is used for route of the Inter-SCS safety communication, the system programs on
the SCSs must be of R1.02 or later.

® Control Bus Driver

The control bus drivers installed on the computer should be upgraded to the version supplied
in R3.02.10. In particular, the control bus driver must be upgraded when ProSafe-RS is inte-
grated with FAST/TOOLS and used in the Narrowband mode of Vnet/IP-Upstream.

B Basic Procedure for Upgrading

In order to use the features added or modified, install the ProSafe-RS software R3.02.10 or
later and open the existing SCS project. For the features that require further procedures, the
procedures are described in the following section.
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Appendix 4.10.1 Cautionary Notes for Upgrading

B Procedure for Using New and Modified Features

After the SENG software has been upgraded to R3.02.10, some of the features added or
modified in R3.02.10 require further steps, such as offline downloading to SCS, before they
can be used. In the following, the steps are explained for each feature.

® New Station (SSC57)

To use the SSC57 station, which is newly added in R3.02.10, you need to perform "Procedure
C" on an SENG of R3.02.10 or later. With SSC57, the Narrowband mode of Vnet/IP-Up-
stream, gas flow rate calculation, data buffering, etc. are available.

® Calculation Functions and Time Synchronization Function Block

To use the calculation functions (LOGE and POWE) and time synchronization function block
(SYS_SETTIME) newly added in R3.02.10, you need to perform "Procedure C" on an SENG
of R3.02.10 or later.

® Change in the Specification of SCS Behavior at Both Bus Failure of Vnet/IP

To enable the revised SCS behavior at both bus failure of Vnet/IP, you need to perform "Pro-
cedure D" on an SENG of R3.02.10 or later.

® 16-bit Modbus Master Support Mode

To read and write data in 16-bit units in Modbus slave communication, you need to perform
"Procedure D" on an SENG of R3.02.10 or later.
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Appendix 4.10.2 Compatibility with Earlier Revisions

This section describes the specifications and precautions of SCS with a system program be-
fore R3.02.10 that are critical to safety as the information on compatibility. Please read this
section if you use SCS with a system program before R3.02.10.

B Specification of SCS Constant "Writing to a Single Holding
Register” has been Changed in R3.02.10

"Writing to a Single Holding Register" is a setting item of SCS Constants Builder that was
added in R3.02.00. In R3.02.10, the specification of this setting item has been changed as fol-
lows:

» The item name has been changed from "Writing to a Single Holding Register" to "16-bit
Modbus master support mode".

*  When "16-bit Modbus master support mode" is set to Disable, there is no difference in the
behavior between R3.02.00 and R3.02.10.

* The following table describes the behaviors when the SCS system program release num-
ber is R3.02.00 and when the SCS system program release number is R3.02.10 with "16-
bit Modbus master support mode" set to Enable. There is no difference in writing to a Pre-
set Single Register between R3.02.00 and R3.02.10.

Table Appendix 4.10.2-1 SCS System Program Release Number and the Behavior when "16-bit Mod-
bus master support mode" is Set to "Enable"

SCS system program release number Behavior when "16-bit Modbus master support
mode" is set to "Enable"

R3.02.00 (*1) » Preset Single Register (function code 06) is avail-
able.

 If a multiple-register read/write command (function
code 03, 04, or 16) is used specifying an even
number for the beginning reference number or an
odd number for the size of data, the error code 10
or 11 (hex.) is returned.

R3.02.10 » Preset Single Register (function code 06) is avail-
able.

» Data access is possible by using multiple-register
read/write commands (function codes 03, 04, and
16) specifying an even number for the beginning
reference number and/or an odd number for the
size of data. Error code 10 or 11 (hex.) is not re-
turned even if an even number is specified for the
beginning reference number or an odd number is
specified for the size of data.

*1:  This means the case when the version of SENG is R3.02.00 and the case when SENG is upgraded to R3.02.10 but offline
downloading to SCS is not yet performed.
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